All rights reserved. No part of this publication may be reproduced in any form or by any electronic or mechanical means, including photocopying and recording, without permission in writing from GE Intelligent Platforms, Inc.

Disclaimer of Warranties and Liability

The information contained in this manual is believed to be accurate and reliable. However, GE Intelligent Platforms, Inc. assumes no responsibilities for any errors, omissions or inaccuracies whatsoever. Without limiting the foregoing, GE Intelligent Platforms, Inc. disclaims any and all warranties, expressed or implied, including the warranty of merchantability and fitness for a particular purpose, with respect to the information contained in this manual and the equipment or software described herein. The entire risk as to the quality and performance of such information, equipment and software, is upon the buyer or user. GE Intelligent Platforms, Inc. shall not be liable for any damages, including special or consequential damages, arising out of the user of such information, equipment and software, even if GE Intelligent Platforms, Inc. has been advised in advance of the possibility of such damages. The user of the information contained in the manual and the software described herein is subject to the GE Intelligent Platforms, Inc. standard license agreement, which must be executed by the buyer or user before the use of such information, equipment or software.
Notice

©2010 GE Intelligent Platforms, Inc. All rights reserved.
*Trademark of GE Intelligent Platforms, Inc.

Microsoft® is a registered trademark of Microsoft Corporation, in the United States and/or other countries.

All other brands or names are property of their respective holders.

We want to hear from you. If you have comments, questions, or suggestions about our documentation, send them to the following email address:

doc@ge.com
# Table of Contents

About this Guide ........................................... 1
Reference Documents ..................................... 1
Scheduler ..................................................... 2
Overview ...................................................... 3
Using the Scheduler with iFIX ......................... 6
Getting Started with the Scheduler ................. 8
  Using the Scheduler ....................................... 11
  Securing Schedules ...................................... 11
  Resolving Schedules .................................... 12
  Running Foreground and Background Schedules ........................................ 13
  Opening Pictures From Background Schedules ........................................ 16
  Debugging VBA Scripts .................................. 19
Starting the FixBackgroundServer Task ..................................................... 20

Adding Schedules to the Background Task Startup List .......................... 21

Foreground Schedule Checklist ......... 21

Background Schedule Checklist ....... 22

Designing Schedules ............................ 23

Event-Based Entries ......................... 23

Time-Based Entries ......................... 25

Multiple Command Script Wizard and Scheduling ................................. 30

Writing VBA Scripts that Access the Proficy iFIX WorkSpace .................. 32

Creating and Editing Schedules and Entries ........................................................ 34

Sorting the Spreadsheet ...................... 36

Viewing and Controlling Entry Diagnostics . 37
Specifying Search Settings ....................... 151
Specifying Picture Files for the Report .. 152
Specifying Schedule Files for the Report .................................................. 153
Specifying Dynamo Sets for the Report .................................................. 154
Specifying Report Settings Options ...... 155
Reviewing the Report Settings ............. 157
Viewing the Report Results ...................... 158
Viewing the Status Trail......................... 161
Viewing a Search that Resolves Tags Using All Tag Group Files..................... 162
Viewing a Search that Includes VBA Scripts .................................................. 164
Selecting Print Options and Printing a Report .................................................. 165
Selecting Page Options for Printing ...... 168
Including Additional iFIX Project Files in the Install.................................................... 389

The Runtask.bat File ............................ 390

Installing Software Improvement Modules (SIMs) with iFIX................................................. 393

Including Additional Third-Party Software in the Install ................................................ 398

Customizing the Install Splash Screen ...... 404

Rebranding Install Graphics ...................... 407

Rebranding Install Text ............................. 409

Rebranding the License Agreement ............. 414

Recompressing the iFIX Install with Rebranded Material.................................................. 417

Rebranding the iFIX DVD Booklet and Tray Card .............................................................. 419

Rebranding Other Parts of the iFIX Product................................................................. 419

Deploying the iFIX Install Setup.exe
Command Line Options

Example 1

Example 2

Example 3

INI Files Used by the iFIX Install

Installation.ini

InstallConfig.ini

Subinstall.ini

Setup.ini

Language Codes Used by the iFIX Install

Program
About this Guide

The Mastering iFIX manual is intended for system integrators, OEMs, and process control engineers responsible for implementing a software automation solution using iFIX®. This manual assumes that you are familiar with Microsoft Windows, Microsoft Visual Basic, the Proficy iFIX WorkSpace, and your plant's network.

Reference Documents

For related information about iFIX, refer to the following manuals:

- Understanding iFIX
- Writing Scripts
- Creating Pictures
- Setting Up the Environment
- Implementing Alarms and Messages
Scheduler

There are certain tasks that you may want to perform at a specified time or interval, or when a change occurs in a database value or in any OPC data server value. For example, you may want to run a Visual Basic® for Applications (VBA) script that generates a report at the end of every shift or replaces the currently-displayed picture when a database point exceeds a certain value. The Scheduler allows you to create, edit, monitor, and run both types of actions as scheduled entries. In the Scheduler, you define the time or event that triggers a scheduled entry, and the action, referred to as an *operation*, that you want to occur.
iFIX® supplies Experts for common tasks such as replacing a picture. These Experts generate scripts based on the information that you supply. The Multiple Command Script Wizard enables you to use one or more Experts to assemble a scripted sequence of commands. You can also write custom scripts for tasks that do not have Experts. Refer to the Writing Scripts manual for detailed information on writing VBA scripts.

Overview

In the configuration environment, iFIX displays schedules in the Proficy iFIX WorkSpace, allowing you to easily create, edit, and start monitoring entries while you work on your project.
Scheduler in the Configuration Environment

In the run-time environment, you can view the status and statistics of the entries in your schedule. You can also control your entries using the Start/Stop, Reset, and Fire Now buttons.
The Scheduler provides the following features:

- Spreadsheet design that allows you to easily view and edit entries.
- Ability to schedule as many entries as necessary and to trigger them as often as necessary.
• Ability to run as a service under Microsoft Windows.

• Experts, via the Multiple Command Script Wizard, for common events.

• Ability to easily monitor entries and view diagnostic statistics.

• Ability to trigger scheduled scripts on demand.

• Ability to run schedules as a foreground or background task.

Using the Scheduler with iFIX

Individual schedules can be run as a foreground or the background task. When you run a schedule in the foreground, you can easily test and debug scripts in the run-time environment. When an error occurs, VBA launches the Visual Basic Editor (VBE) debugger, where you can edit and save changes to a script. You cannot run scripts in the configuration environment.
When you run schedules as background tasks, they run regardless of whether the Proficy iFIX WorkSpace is in the run-time or configuration environment, and regardless of whether the Proficy iFIX WorkSpace is running. If you modify a scheduled entry, it automatically restarts. When the Proficy iFIX WorkSpace is in the run-time environment, you can view Scheduler statistics and diagnostic information about each entry in the schedule, including the number of times each entry has been fired and the last time it was fired.

You can also run the Scheduler in the background as a service under Windows. Because the Scheduler runs as a service, operators can log in and out of an Windows node without affecting scheduled entries, and entries are triggered regardless of whether or not the Proficy iFIX WorkSpace is running.
You can create multiple schedules, which allows you to organize and easily maintain entries. Each schedule can be configured individually to run as a background or foreground task. Also, as you add events to a schedule, you can choose whether or not to start monitoring them immediately, or to wait until the next time the Proficy iFIX WorkSpace starts.

The Scheduler supports a powerful Find and Replace feature that allows you to quickly and easily modify information in a schedule. For additional information on using the Find and Replace feature, refer to the Finding and Replacing Data section of the Understanding iFIX manual.

---

**Getting Started with the Scheduler**

Before you start scheduling entries, you should understand how the Scheduler executes scripts. The Scheduler can run as a foreground or background task.
When you run a schedule in the foreground, it runs on the same thread as the scripts in the Proficy iFIX WorkSpace, allowing you to quickly test and debug scripts in the run-time environment. When you run a schedule in the background, it runs on a separate thread from the scripts in the Proficy iFIX WorkSpace, monitoring the system and triggering scheduled events.

The Scheduler does not loop; it waits for events to occur. When a selected event occurs, the script is triggered from a schedule running in the background, it is added to the queue, and it executes after the scripts in front of it have finished executing. For this reason, when a schedule is run as a background task it is ideal for monitoring tasks. This is exactly the same as scripts triggered from schedules running as foreground tasks in the Proficy iFIX WorkSpace.

Generally, schedules created to run in the foreground are used for testing and debugging. Once a schedule created to run in the foreground has been tested and debugged, we suggest that you set it to run in the background.
This section includes the following topics on how to get started with the Scheduler:

- Using the Scheduler
- Securing Schedules
- Resolving Schedules
- Running Foreground and Background Schedules
- Opening Pictures From Background Schedules
- Debugging VBA Scripts
- Starting the FixBackgroundServer Task
- Adding Schedules to the Background Task Startup List
- Foreground Schedule Checklist
- Background Schedule Checklist

Refer to the Writing Scripts manual for an explanation of how scripts are implemented in the Proficy iFIX WorkSpace.
Using the Scheduler

Schedules are spreadsheets with separate tabs for event-based entries and time-based entries. Double-clicking an empty row in a schedule displays a dialog box for adding an entry. Once you have created an entry, you can edit individual cells in the spreadsheet without using the dialog box.

Time-based entries create a timer object while event-based entries create an event object. These iFIX objects have associated properties, methods, and events that you can use in VBA scripts. They are displayed in the system tree and are the objects to which scheduled scripts are tied.

Securing Schedules

iFIX's schedule protection prevents unauthorized users from accessing or modifying schedules. To configure security for your schedules, enter a security area in the Properties window. For more information on configuring security, refer to the Implementing Security manual.
Resolving Schedules

Database information for each data source in a schedule is saved as part of the file on disk. When a schedule executes in the run-time environment, and the database information is not up-to-date, iFIX queries the database and resolves the tag definitions. This can be a time-consuming process, which slows the execution of the schedule.

Resolving schedules removes the need for iFIX to query the database. Therefore, resolved schedules execute faster in the run-time environment. We recommend resolving your schedules as a final step in the configuration process. The Resolve feature is available for both schedules and pictures.

If the process database is modified after you resolve a schedule, you need to run Resolve again. These modifications include:

- Loading a different database.
- Deleting database tags.
Running Foreground and Background Schedules

You can select whether you want your schedules to run as foreground or background tasks. When you create a new schedule, the default is for it to run in the foreground. To run a schedule in the foreground, the Proficy iFIX WorkSpace must be running in the run-time environment. Running a schedule in the foreground is useful for testing and debugging VBA scripts.

To run a schedule in the background, the FixBackgroundServer task must be running. If the FixBackgroundServer task is not running, it is automatically started when a schedule is added to the background task. To create a schedule that runs in the background you must change the default setting in the Scheduler Properties dialog box, which is available by right-clicking a schedule and selecting Scheduler Properties from the pop-up menu. You can use this dialog box to change the default setting for a new schedule or for an existing schedule that is set to run in the foreground.
Also, you can select whether you want a schedule to run in the foreground or the background, set the window properties, and set the statistics refresh rates.

**NOTE:** An unsigned write occurs when a database tag is configured for electronic signature, but you write a value directly to that tag without capturing a signature. If you are working in a secure environment with the Electronic Signature option enabled, you must be aware of the impact of unsigned writes to the process database. Unsigned writes can originate from schedules. Refer to the Implications of Database Writes With Electronic Signature section of the Using Electronic Signatures manual for detailed information.
When running a schedule in the background while iFIX is running as a service, you may see a prompt such as "datasource undefined -2147220484". This message, which can occur in all versions of Windows but is most commonly encountered in Vista, is seen during iFIX startup or shutdown, or if a datasource is not found. If the message occurs at startup, the schedule will halt until the prompt is acknowledged and cleared.

To avoid the possibility of these messages occurring, append the intErrorMode parameter, set to "2", to the schedule's script command. This will send an error message without a prompt to configured iFIX alarm destinations, and the schedule will continue without the need for user intervention.
For example, if the schedule script is as follows:

```plaintext
WriteValue "33",
"Fix32.ROXIE.AI_TAG.F.CV"
```

modify it to:

```plaintext
WriteValue "33",
"Fix32.ROXIE.AI_TAG.F.CV", 2
```

**Opening Pictures From Background Schedules**

If a schedule running as a background task opens a picture while you are editing another picture or schedule in configure mode, you may experience unexpected behavior. In some instances, the picture may open over a modal dialog box and you will not be able to return to the original dialog box.
To avoid this problem, it is recommended that when adding an entry to a background schedule that references a picture, you write a custom script that configures the schedule to check whether the object is in the run mode or configure mode before opening a picture.

**NOTE:** It is recommended that schedules configured to run in the background do not reference pictures. If you do not check whether the WorkSpace is in run mode before opening the picture, and the WorkSpace is in configure mode when the open attempt occurs, the attempt fails since FixBackgroundServer cannot open pictures in configure mode.

The following VBA code shows an example on how a timer object checks whether the WorkSpace is in run mode before opening a picture named MyPicture.grf. If the WorkSpace is in configure mode, the picture does not open and a program called Task.exe runs instead. The timer object in this example runs from a background schedule:
Private Sub FixTimer3_OnTimeOut(ByVal lTimerId As Long)

Dim WrkSpcApp As Object

Set WrkSpcApp = GetObject("", "Workspace.Application")

'If the object is in run mode open the picture
    If WrkSpcApp.Mode = 4 Then
        OpenPicture "MyPicture"
    End If

'Otherwise, just run this program called Task.exe
    Else
        Task.exe
    End If

Set WrkSpcApp = Nothing

End Sub
For more information on creating new schedules and using the Scheduler Properties dialog box, refer to the Creating and Editing Schedules and Entries section.

**Debugging VBA Scripts**

If a scripting error occurs while a schedule is running, the VBE debugger automatically launches to allow you to quickly edit and save the changes made to the script. If the schedule is running in the foreground when the VBE launches, any changes made to the script are automatically saved in the schedule. If the schedule is running in the background when the VBE launches, close the VBE editor, re-open it in Proficy iFIX WorkSpace, and make the necessary changes to the script. Any changes made to the script are automatically saved in the schedule.

**NOTE:** *In order for scripting changes to be saved in a schedule, the VBE must be started in the Proficy iFIX WorkSpace. Any scripting changes made in the VBE launched from the FixBackgroundServer task will not be saved in a schedule.*
Starting the FixBackgroundServer Task

The FixBackgroundServer task can run on its own, or as a Windows service. If you configure iFIX to start as a service, the FixBackgroundServer task runs as a service, provided you have added it to the task list.

To start iFIX as a service, shut down iFIX and in the SCU's Local Startup Definition dialog box enable the Continue Running After Log Off option. If iFIX is running, this option is unavailable. In the Task Configuration dialog box, add the FixBackgroundServer task to the task list.

Refer to the Configuring Startup Tasks section in the Setting Up the Environment manual for more information on configuring startup tasks.
Adding Schedules to the Background Task Startup List

Normally, you want your schedules to start automatically when iFIX is started. To do this, you must add the schedules to the background task startup list. If you are adding entries to a schedule that is already running in the background, you can choose whether or not to start monitoring the entry immediately.

Foreground Schedule Checklist

The following is an overview of the steps necessary to successfully implement a foreground schedule:

1. Create a foreground schedule in the configuration environment of the Proficy iFIX WorkSpace.

2. Monitor entries as necessary from the run-time environment of the Proficy iFIX WorkSpace.
Background Schedule Checklist

When creating a schedule that runs in the background, you can create it directly as a background schedule or create a foreground schedule and convert it to a background schedule. The following is an overview of the steps necessary to successfully implement a background schedule:

1. Create a background schedule in the configuration environment of the Proficy iFIX WorkSpace.

2. Add the schedule to the background task startup list, using the Background Startup tab in the User Preferences dialog box.

3. Monitor entries as necessary from the run-time environment in the Proficy iFIX WorkSpace.
Designing Schedules

This chapter explains the issues you need to consider while you are designing schedules. When creating schedules, there are two types of entries that you can select: event-based entries and time-based entries. This section describes both types of entries and the triggers that can be used by each. Refer to the following sections for more information on:

- Event-Based Entries
- Time-Based Entries
- Script Authoring Experts
- Writing VBA Scripts that Access the Proficy iFIX WorkSpace

Event-Based Entries

Event-based entries are created using the Add Event Entry dialog box. Event-based entries can use any data source available to the system to trigger an action. To select a data source, you can either enter the data source in the Data Source field or click the Browse button to access the Expression Builder.
Five event types are available to trigger an action based on the value of a data source. For example, you may want to have a certain action occur when an alarm equals HIHI. By tying the value of the alarm field to the OnTrue event type, you can trigger an action when the value of this field becomes equal to HIHI.

The following table lists the event types that are available and when they trigger:

<table>
<thead>
<tr>
<th>The event type...</th>
<th>Triggers...</th>
</tr>
</thead>
<tbody>
<tr>
<td>OnDataChange</td>
<td>When the expression changes.</td>
</tr>
<tr>
<td>OnTrue</td>
<td>When the expression resolves to a non-zero value.</td>
</tr>
<tr>
<td>OnFalse</td>
<td>When the expression resolves to zero.</td>
</tr>
<tr>
<td>WhileTrue</td>
<td>At the specified interval as long as the expression evaluates to a non-zero value.</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>WhileFalse</td>
<td>At the specified interval as long as the expression evaluates to zero.</td>
</tr>
</tbody>
</table>

**Time-Based Entries**

Time-based entries are created using the Add Timer Entry dialog box. Time-based entries trigger at a scheduled time and are not tied to a data source. The following table lists the time triggers that are available and when they trigger:
<table>
<thead>
<tr>
<th>The time type...</th>
<th>Triggers...</th>
</tr>
</thead>
<tbody>
<tr>
<td>One Shot</td>
<td>Once at the specified date and time. For example, you can schedule an entry to trigger at 5:00 p.m. on 7/4/98.</td>
</tr>
</tbody>
</table>
| Continuous      | Continuously at the specified interval, starting at the specified time. For example, you can schedule an entry to trigger every eight hours.  

*NOTE:* You may notice in the log file that the timers occasionally fire +/- 1 or 2 milliseconds off. This may happen on the first fire and will return to the specified interval in a subsequent firing.
<table>
<thead>
<tr>
<th>The time type...</th>
<th>Triggers...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Daily</td>
<td>On the scheduled days of the week at a particular time. Optionally, you can specify an end time and interval. For example, you can schedule an entry to trigger Monday through Friday, at noon, or every hour from noon until 6:00 p.m.</td>
</tr>
<tr>
<td>The time type...</td>
<td>Triggers...</td>
</tr>
<tr>
<td>-----------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Monthly</td>
<td>On the scheduled days of the month at a particular time. Optionally, you can specify an end time and interval. For example, you can schedule an event for the 15\textsuperscript{th} of the month, at 9:00 a.m., or every hour from 9:00 a.m. until 5:00 p.m. You can also schedule an event for the end of the month at a particular time. This setting determines the last day of the month for you.</td>
</tr>
</tbody>
</table>

**NOTE:** If you have Daylight Saving Time enabled and you create a timed-based entry to have a 2:30 AM Start Time, be aware that during the transition from Standard Time to Daylight Saving Time, the schedule will actually fire at 1:30 AM. All other days of the year, it will fire at 2:30 AM.
All time-based entries run the script tied to the OnTimeOut event procedure.

**Adjusting for Daylight Saving Time**

The Scheduler supports daylight saving time for time-based events. Before allowing automatic Daylight Saving Time to be used in a production environment, you should test your application under each of the following scenarios for proper behavior:

- While in Standard Time.
- While in Daylight Time.
- During the transition from Standard Time to Daylight Time.
- During the transition from Daylight Time to Standard Time.
Multiple Command Script Wizard and Scheduling

When selecting an action in the Operation field of either the Add Timer Entry or Add Event Entry dialog box, you can click the Run Wizard button to open the Multiple Command Script Wizard. You can also open the Multiple Command Script Wizard by double-clicking the Operation field of an existing timer or event entry and then clicking the Run Wizard button in the dialog box that appears.

The wizard enables you to select one or more commands for the desired operation, each of which is configured using an Expert. After you have provided each Expert with its required information, a VBA script tied to the appropriate event is generated. You can later edit the script by rearranging or deleting commands in the wizard, or you can customize the script in the VB Editor.
NOTES:

• Although the Multiple Command Script Wizard's purpose is to fully automate the VBA command scripting process, you can manually edit scripts generated by the wizard with the VB Editor. You may add or edit VBA scripts anywhere before the Scripts Authoring Tool header line (***** Scripts Authoring Tool *****), or directly between a "WizardEnd" and a “Wizard[x] =” statement. Do not edit any of the commented areas in the wizard-generated script. If the Multiple Command Script Wizard detects an improperly customized VBA script, you may encounter an error.

• The Multiple Command Script Wizard does not check the command sequence to make sure commands occur in a logical order.
If you do not want to use the Multiple Command Script Wizard, you can also use the VB Editor to write your own custom scripts for frequently performed tasks. Refer to the Writing Custom Scripts for the Scheduler section for information on how to create your own custom scripts for the Scheduler.

**Writing VBA Scripts that Access the Proficy iFIX WorkSpace**

When you write a scheduled script that opens, closes, replaces, or accesses a property of an object in a picture, you must ensure that the Proficy iFIX WorkSpace is running and that the picture you need to access is open and active. This differs from writing scripts that run from pictures.
Before you can access any information about the active picture in the Proficy iFIX WorkSpace, you must activate the Proficy iFIX WorkSpace using the GetObject method as shown in the following example.

```
Dim AppObj As Object

Set AppObj = GetObject("","Workspace.Application")
```

You can now check to see if the picture is open:

```
If UCase(AppObj.ActiveDocument.Name) = UCase("MyPicture") Then

<perform a task or open the picture>
```

You can then check to see which document or picture is open, and replace it if it is not the one you need. Once the proper picture is open, you can access its objects.

Refer to the Writing Scripts manual for more information on using VBA with iFIX.
Creating and Editing Schedules and Entries

The Scheduler allows you to create multiple schedules which help you to easily organize and maintain events. When you create a new schedule, you can control its properties from the Scheduler Properties dialog box.

The following table lists the tabs on the Scheduler Properties dialog box and the properties that can be controlled from each:

<table>
<thead>
<tr>
<th>Tabs</th>
<th>Properties</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run Time State</td>
<td>Run in Foreground</td>
</tr>
<tr>
<td></td>
<td>Run in Background</td>
</tr>
<tr>
<td>Window Properties</td>
<td>Window Height</td>
</tr>
<tr>
<td></td>
<td>Window Width</td>
</tr>
<tr>
<td></td>
<td>Window Styles</td>
</tr>
<tr>
<td>Tabs</td>
<td>Properties</td>
</tr>
<tr>
<td>------------------</td>
<td>----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Stats Refresh</td>
<td>Timer Statistics Refresh Rate (in seconds)</td>
</tr>
<tr>
<td></td>
<td>Event Statistics Refresh Rate (in seconds)</td>
</tr>
<tr>
<td>Background Files</td>
<td>Lists all schedules running in the background. No changes can be made from this tab.</td>
</tr>
</tbody>
</table>

You can create new schedules when the Proficy iFIX WorkSpace is in the configuration environment.

**NOTE:** iFIX does not support schedules that use the same name as the local node. Therefore, do not use your local node's name for any schedules you create.
Once you have created a schedule, the schedule and all its entries appear in the Schedules folder of the system tree. You can open a schedule and view or edit its properties at any time by double-clicking the schedule name in the system tree.

Once you have created a schedule, you can add new entries to it using the Multiple Command Script Wizard or by writing your own custom scripts in the VB Editor. You can edit an existing entry by selecting the entire entry or a specific cell within the entry. Once created, entries can be easily copied or moved from one schedule to another.

---

**Sorting the Spreadsheet**

You can sort Scheduler entries in ascending or descending order by clicking the heading of the column you want to sort. For example, if you want to sort entries alphabetically by name, click the Name column's heading. The entries will appear in ascending order. To sort them in descending order, click the Name column's heading again.
NOTE: Sorting is only available in the configuration environment. In the run-time environment, entries appear in the order they were added to the schedule.

Viewing and Controlling Entry Diagnostics

The Scheduler allows you to view and control entry diagnostics in the run-time environment. If you open a schedule in the run-time environment, you can view the status of entries, the number of times they have been fired, and the time when they were last fired. You can also:

- Start or stop an entry from executing.
- Reset the statistics (number of times it has been fired and time when it was last fired) of the entry.
- Trigger an entry to fire on demand.

If you have loaded a schedule, but the scripts are not firing, you need to determine whether the problem is caused by the firing mechanism or by the script itself.
Writing Custom Scripts for the Scheduler

The Scheduler provides Experts that generate a script that is executed when an entry triggers. These Experts, which are available for common tasks such as toggling a digital point or generating a report, are accessed using the Multiple Command Script Wizard.

You can also create custom scripts for tasks that you need to perform using the Visual Basic Editor. This section shows sample code that may be helpful when writing custom scripts for use with the Scheduler. It includes the following sections:

- Form Script Sample Code
- Button Script Sample Code
- Generated Script Sample Code

For additional examples, use the VBE to view the code for the Experts, buttons, and forms supplied with iFIX. Refer to the Writing Scripts manual for detailed information on writing VBA scripts.
Form Script Sample Code

The following example shows code that collects the name of the picture the user wants to display when the event is triggered, generates the script, and creates the event. The Procedures object is a collection of scripts. Before you generate the script, you need to get the index number for the next script using the GetEventHandlerIndex method. Once you generate the string that will become the script, use the AddEventHandler method to add the event.

Private CurrentObject As Object
Private EventName As String

Public Sub GetCurrentObjectValues(obj, Str)
    Set CurrentObject = obj
    EventName = Str
End Sub

Private Sub CommandButton1_Click()

    'get file name entered by user
    Dim FileName As String
    FileName = TextBox1.Value

    Dim WorkingObj As Object
Set WorkingObj = CurrentObject.Procedures

'Get the index for the procedure
Dim Index As Long
Dim Found As Long
WorkingObj.GetEventHandlerIndex EventName, Index, Found

'Generate code
Dim StringCode As String
StringCode = "Dim doc As Object" & Chr(13) _
    & "Dim PicturePath As String" & Chr(13) _
    & "PicturePath = ""c:\fix32\pic\"" & FileName" & _
    & Chr(13) & "Set doc = _
                     Application.Documents.Open(PicturePath)" & Chr(13)

'Add the event
WorkingObj.AddEventHandler EventName, StringCode, Index

'Close the form
End

End Sub
Button Script Sample Code

The following example shows code for a button object called MyExpert that gets the timer or event object, the event trigger name, and picture name, if any, from the Add Event dialog box. It passes this information in to the form using the GetCurrentObjectValues procedure, and then displays the form.

```vbs
Private Sub MyExpert_Click()
    Dim CurrentObj As Object
    Dim EventName As String

    'Set procedure object, event name, and file name
    Set CurrentObj = MyExpert.ProcedureObject
    EventName = MyExpert.EventProcedure
    MyExpert.Property1 = frmOpenPicture.TextBox1.Value

    'Pass the object and event name into the form
    Call frmOpenPicture.GetCurrentObjectValues(CurrentObj, _
    EventName)
    frmOpenPicture.Show
```
frmOpenPicture.Hide
End Sub

Generated Script Sample Code

The following example shows the script that would be generated if you ran this Expert on the Timer7 object, using the OnTimeOut event.

Private Sub Timer7_OnTimeOut(ByVal lTimerId As Long)
Dim doc As Object
Dim PicturePath As String
PicturePath = "c:\fix32\pic" & FileName
Set doc = Application.Documents.Open(PicturePath)
End Sub
Scheduler Dialog Boxes

The Scheduler includes the following dialog boxes (listed in alphabetical order):

- Add Event Entry Dialog Box
- Add Timer Entry Dialog Box
- Scheduler Properties Dialog Box
- Script Authoring Wizard Dialog Box

Add Event Entry Dialog Box

*NOTE: If you are modifying an existing Scheduler event-based entry, the title of this dialog box changes to "Modify Event Entry."

The Add Event Entry dialog box displays the following items:
## Schedule Info

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Allows you to specify a name for an event-based Scheduler entry. The name can be any alphanumeric name up to 64 characters and must begin with a letter. Do not use names that contain VBA reserved words. See the Microsoft VBA help system for more information on VBA reserved words.</td>
</tr>
<tr>
<td>Description</td>
<td>Allows you to provide a description of up to 80 characters for an event-based Scheduler entry.</td>
</tr>
</tbody>
</table>
Event Data Source

Allows you to enter a data source or expression for this Data link. The term data source refers to a reference to a source of information, such as iFIX tagnames and historical files, or other OPC-compliant data servers. A data source may also consist of iFIX objects (such as shapes, charts, and variables) or 3rd party OLE controls. The term expression refers to constants, data sources, or a combination of constants and data sources that are connected with one or more operators. Use the Browse (...) button to open the Expression Builder dialog box. Use the Quick Modify button to modify a database block directly without launching the Database Manager.

Event Properties Tab

Event Type

Allows you to select the condition that must be met for the event-based script to fire. The options are:
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>On True</td>
<td>Evaluates a Boolean expression in the Data Source field and fires the entry if the expression evaluates to a non-zero value.</td>
</tr>
<tr>
<td>On False</td>
<td>Evaluates a Boolean expression in the Data Source field and fires the entry if the expression evaluates to zero.</td>
</tr>
<tr>
<td>On Data Change</td>
<td>Fires the entry every time the value in the Data Source field changes.</td>
</tr>
<tr>
<td>While True</td>
<td>Evaluates a Boolean expression in the Data Source field and fires the entry at the specified interval for as long as the expression evaluates to a non-zero value.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>While False</td>
<td>Evaluates a Boolean expression in the Data Source field and fires the entry at the specified interval for as long as the expression evaluates to zero.</td>
</tr>
</tbody>
</table>

**Interval**

Allows you to specify the duration of time between each triggering of a While True or While False event-based entry. The entry will fire for as long as the expression in the Data Source field evaluates to one or zero, respectively.

**Historical Properties Tab**

The Historical Properties tab allows you to set the parameters for a query that fetches historical data from Proficy Historian. The tab contains the following items:
**NOTE:** The following fields, with the exception of the Update Rate fields, are only available if you select a Historical Mode other than Current Value.

## Start Date

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fixed Date</td>
<td>Specifies whether to enter a specific start date for the query of the data source.</td>
</tr>
<tr>
<td>Days Before Now</td>
<td>Specifies whether to enter the number of days prior to today to fetch data from Proficy Historian. For example, if you want to display data collected for the data source two days ago, enter 2.</td>
</tr>
</tbody>
</table>
## Start Time

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fixed Time</td>
<td>Specifies whether to designate a specific time to start, based on a 24-hour clock.</td>
</tr>
<tr>
<td>Lock Time</td>
<td>Locks the fixed time, even if you change the time zone in the Date and Time Properties dialog box in the Control Panel. This field is available only when you designate a specific time to start using the Fixed Time field.</td>
</tr>
<tr>
<td>Duration Before</td>
<td>Specifies whether to enter the duration prior to the current time to start. The minimum duration is 0 seconds; the maximum is 23 hours, 59 minutes, and 59 seconds.</td>
</tr>
<tr>
<td>Now</td>
<td></td>
</tr>
</tbody>
</table>
## Time Zone

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time Zone</td>
<td>Allows you to select the time zone to associate with the start time. You can select the client time (time zone for your computer), the server time (time zone used by the Historian server), or the tag time (uses the time zone bias of the tag, which is set in Historian). The default time zone is that of the client machine. This field is available only when Historian is used.</td>
</tr>
</tbody>
</table>
### Adjust for Daylight Savings Time

Adjusts the time if the zone you selected is experiencing daylight saving. This field works only if you selected the Automatically adjust clock for daylight saving changes check box located on the Time Zone tab of the Date/Time Properties dialog box in the Control Panel.

---

### Historical Mode

Allows you to determine how Proficy Analytic Client selects and fetches data from a historical data source and, determines what each displayed value represents. The options are:

- **Sample** – The last valid value found, up to and including the start of the specified interval.
- **Avg** – The average of all valid data found during the specified interval.
• High – The highest valid data point value found during the specified interval.

• Low – The lowest valid data point value found during the specified interval.

• Interpolated – The data is interpreted by assuming that the line between two values is a straight line. All points along that line are estimated except the starting point and the ending point.

• Current Value – The current value of the data point.
**IMPORTANT:** The Current Value may update at a rate different from the rate set in the Update Rate field. The update rate is not set solely by the rate entered in the Update Rate field. It also depends on the collection rate, the rate for querying Historian, and the time required to request an update from the Historian server and send it back to the client. As a result, the time it takes to display the updates may be longer than anticipated. Additionally, please be aware that the timestamp for this mode represents the timestamp from the Historian server, not the client.

- Standard Deviation – The standard deviation of all valid data found during the specified interval.
- Total – The total of all valid data found during the specified interval.

**Duration**

The duration determines the time range for the historical data source. The minimum duration for a fetch is one second; the maximum is 365 days, 23 hours, 59 minutes, and 59 seconds.
<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Days</td>
<td>Allows you to enter the number of days. This field can be used in conjunction with the other fields in this area.</td>
</tr>
<tr>
<td>Hours</td>
<td>Allows you to enter the number of hours for the duration for the data fetch query. This field can be used in conjunction with the other fields in this area.</td>
</tr>
<tr>
<td>Mins</td>
<td>Allows you to enter the number of minutes for the duration for the data fetch query. This field can be used in conjunction with the other fields in this area.</td>
</tr>
</tbody>
</table>
Secs

Allows you to enter the number of seconds for the duration for the data fetch query. This field can be used in conjunction with the other fields in this area.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hours</td>
<td>Allows you to enter the number of hours for the rate of data update. This field can be used in conjunction with the other fields in this area.</td>
</tr>
</tbody>
</table>

**Update Rate**

Allows you to specify the rate at which the data is updated. The default rate is five seconds. Zero is permitted for a one-time fetch. The fastest update rate is five seconds, the slowest, 1:59:59.
<table>
<thead>
<tr>
<th>Mins</th>
<th>Allows you to enter the number of minutes for the rate of data update. This field can be used in conjunction with the other fields in this area.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Secs</td>
<td>Allows you to enter the number of seconds for the rate of data update. This field can be used in conjunction with the other fields in this area.</td>
</tr>
</tbody>
</table>
### Action Info

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operation</td>
<td>Displays the command(s) currently scheduled to trigger when the defined event occurs. If the field is blank, you can specify one or more commands by clicking the Run Wizard button to open the Multiple Command Script Wizard, or the VB Editor button to open the VB Editor. If more than one command is specified, the Operation field will display &quot;Multiple Commands&quot;. If you specify a command using the VB Editor, the Operation field will display &quot;Custom Script&quot;.</td>
</tr>
<tr>
<td>Run Wizard</td>
<td>Opens the Multiple Command Script Wizard to automatically create a VBA script for the current event-based entry.</td>
</tr>
<tr>
<td>------------</td>
<td>---------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>VB Editor</td>
<td>Launches the Visual Basic Editor to display the script, if any exists, for the current event-based entry. If no script exists, you can use the VB Editor to create one.</td>
</tr>
</tbody>
</table>

### Add Timer Entry Dialog Box

*NOTE: If you are modifying an existing Scheduler time-based entry, the title of this dialog box changes to "Modify Timer Entry."

The Add Timer Entry dialog box displays the following items:
Name

Allows you to specify a name for the time-based Scheduler entry. The name can be any alphanumeric name up to 64 characters and must begin with a letter. Do not use names that contain VBA reserved words. See the Microsoft VBA help system for more information on VBA reserved words.

Description

Allows you to provide a description of up to 80 characters for the time-based Scheduler entry.

Trigger Info

One Shot

Allows you to schedule a time-based entry to trigger once on a specific date and time.
<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date</td>
<td>Allows you to specify the date on which a one shot time-based entry will trigger.</td>
</tr>
<tr>
<td>Time</td>
<td>Allows you to specify the time at which a one shot time-based entry will trigger.</td>
</tr>
</tbody>
</table>
Continuous

Allows you to schedule a time-based entry to trigger continuously at a specific interval.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start Time</td>
<td>Allows you to specify the time at which a continuous time-based entry will begin triggering. Once triggered, the entry will trigger at a regular period of time specified by the Interval field.</td>
</tr>
<tr>
<td>Interval</td>
<td>Allows you to specify the duration of time between each triggering of a continuous time-based entry. The entry will begin running at the time specified in the Start Time field.</td>
</tr>
</tbody>
</table>
Daily

Allows you to schedule a time-based entry to trigger at a particular time on the days of the week you specify.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Day of the Week</td>
<td>Allows you to select this day as one of the days of the week that you want a daily time-based entry to trigger.</td>
</tr>
<tr>
<td>Start Time</td>
<td>Allows you to specify the time at which a time-based entry will begin triggering.</td>
</tr>
<tr>
<td>Item</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Enable End Time/Interval</td>
<td>Allows you to configure a time-based entry to trigger continuously from the time specified in the Start Time field to the time specified in the End Time field. The entry will continuously trigger between these times at the regular time intervals specified by the Interval field.</td>
</tr>
<tr>
<td>End Time</td>
<td>Allows you to specify the time at which a time-based entry stops triggering. This field is only available if the Enable End Time/Interval check box is selected.</td>
</tr>
<tr>
<td>Item</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Interval</td>
<td>Allows you to specify the duration of time between each triggering of a time-based entry. The entry will begin triggering on the selected days at the time specified in the Start Time field and end at the time specified in the End Time field. This field is only available if the Enable End Time/Interval check box is selected.</td>
</tr>
</tbody>
</table>

**Monthly**

Allows you to schedule a time-based entry to trigger at a particular time on the days of the month you specify.
<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Day of the Month</td>
<td>Allows you to select this day as one of the days of the month that you want a monthly time-based entry to trigger.</td>
</tr>
<tr>
<td>End of Month</td>
<td>Allows you to automatically schedule a monthly time-based entry to trigger on the last day of each month.</td>
</tr>
<tr>
<td>Start Time</td>
<td>Allows you to specify the time at which a time-based entry will begin triggering.</td>
</tr>
<tr>
<td><strong>Enable End Time/Interval</strong></td>
<td>Allows you to configure a time-based entry to trigger continuously from the time specified in the Start Time field to the time specified in the End Time field. The entry will continuously trigger between these times at the regular time intervals specified by the Interval field.</td>
</tr>
<tr>
<td>----------------------------</td>
<td>--------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>End Time</strong></td>
<td>Allows you to specify the time at which a time-based entry stops triggering. This field is only available if the Enable End Time/Interval check box is selected.</td>
</tr>
<tr>
<td>Interval</td>
<td>Allows you to specify the duration of time between each triggering of a time-based entry. The entry will begin triggering on the selected days at the time specified in the Start Time field and end at the time specified in the End Time field. This field is only available if the Enable End Time/Interval check box is selected.</td>
</tr>
</tbody>
</table>

**Operation**

Displays the command(s) currently scheduled to trigger at the specified date and time. If the field is blank, you can specify one or more commands by clicking the Run Wizard button to open the Multiple Command Script Wizard, or the VB Editor button to open the VB Editor. If more than one command is specified, the Operation field will display "Multiple Commands".
If you specify a command using the VB Editor, the Operation field will display "Custom Script".

**Run Wizard**

Opens the Multiple Command Script Wizard to automatically create a VBA script for the current time-based entry.

**VB Editor**

Launches the Visual Basic Editor to display the script, if any exists, for the current time-based entry. If no script exists, you can use the VB Editor to create one.

**Scheduler Properties Dialog Box**

The Scheduler Properties dialog box displays the following items:
## Run Time State

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run in Foreground</td>
<td>Allows a schedule to run as a foreground task in the run-time environment of the Proficy iFIX WorkSpace.</td>
</tr>
<tr>
<td>Run in Background</td>
<td>Allows a schedule to run as a background task, separately from the Proficy iFIX WorkSpace. Time-based and event-based scripts will still run as scheduled, even if the Proficy iFIX WorkSpace is not running - provided that the scripts have been added to the FixBackgroundServer task and the FixBackgroundServer task is running.</td>
</tr>
</tbody>
</table>
## Window Properties

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Window Height</td>
<td>Allows you to configure the height of the iFIX schedule that is currently open. Window height is measured in logical units. See the Creating Pictures electronic book for more information on logical units.</td>
</tr>
<tr>
<td>Window Width</td>
<td>Allows you to configure the width of the iFIX schedule that is currently open. Window width is measured in logical units. See the Creating Pictures electronic book for more information on logical units.</td>
</tr>
<tr>
<td>Title Bar</td>
<td>Enables or disables the Scheduler's title bar at runtime.</td>
</tr>
<tr>
<td>Item</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>System Menu</td>
<td>Enables or disables the Scheduler's system menu.</td>
</tr>
<tr>
<td>Resizable</td>
<td>Specifies whether or not the Scheduler window is resizable at run-time.</td>
</tr>
<tr>
<td>Always On Top</td>
<td>Specifies whether or not the Scheduler window stays in front of other windows within the Proficy iFIX WorkSpace at run-time.</td>
</tr>
</tbody>
</table>
## Stats Refresh

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Timer Statistics Refresh Rate</td>
<td>Allows you to set the rate, in seconds, at which time-based entry statistics are refreshed at run-time. Setting the refresh rate to a higher value will improve CPU time.</td>
</tr>
<tr>
<td>Event Statistics Refresh Rate</td>
<td>Allows you to set the rate, in seconds, at which event-based entry statistics are refreshed at run-time. Setting the refresh rate to a higher value will improve CPU time.</td>
</tr>
</tbody>
</table>

## Background Files

Displays all the schedules that are currently loaded in the FixBackgroundServer task.
Script Authoring Wizard Dialog Box

The Script Authoring Wizard dialog box displays the following items:

**Operation**

Displays the command(s) currently scheduled to trigger for the specified event or date and time. If the field is blank, you can specify one or more commands by clicking the Run Wizard button to open the Multiple Command Script Wizard, or the VB Editor button to open the VB Editor. If more than one command is specified, the Operation field will display "Multiple Commands". If you specify a command using the VB Editor, the Operation field will display "Custom Script".

**Run Wizard**

Opens the Multiple Command Script Wizard to automatically create a VBA script for the current time-based or event-based entry.
VB Editor

Launches the Visual Basic Editor to display the script, if any exists, for the current time-based or event-based entry. If no script exists, you can use the VB Editor to create one.

How Do I...

Click on any of the following links for more information on working with the Scheduler application:

- Working with Scheduler
- Working with Entries
- Working with Scheduler at Run-time
- Advanced Topics
Working with the Scheduler

You can perform the following tasks when working with the Scheduler:

- Creating and Running a Scheduled Event
- Creating New Schedules
- Running Schedules as Background Tasks
- Starting FixBackgroundServer
- Starting FixBackgroundServer as a Windows Service
- Resolving Schedules
- Assigning Schedules to a Security Area
Overview: Creating and Running a Scheduled Event

To create and run a schedule:

1. In the Proficy iFIX WorkSpace's configuration environment, create the schedule.
2. Add a new time-based or event-based entry to the schedule.
3. Configure the schedule to run as a foreground or background task.
4. View or edit the properties of the schedule as necessary.

Creating New Schedules

To create a new schedule:

1. In Classic view, in WorkSpace, click the New Schedule button on the Standard Toolbar.
   -Or-
In Ribbon view, click the WorkSpace button, select New, and then click Schedule.

2. Right-click anywhere in the schedule window and choose Add New Timer Entry.
   -Or-
   Right-click anywhere in the schedule window and choose Add New Event Entry.

3. Select the desired timer or event options.

4. In Classic view, on the WorkSpace menu, click Save As.
   -Or-
   In Ribbon view, click the WorkSpace button, and then Save As.

5. In the File Name field, enter a name for the schedule. iFIX schedules are saved to the Database (PDB) path with an .EVS file extension.

6. Click Save.
Running Schedules as Background Tasks

To run a schedule as a background task:

1. In Classic view, on the WorkSpace menu, click User Preferences.
   -Or-
   In Ribbon view, on the Home tab, in the WorkSpace group, click Settings, and then click User Preferences.

2. Select the Background StartUp tab.

3. Select the first empty row and click the Browse (…) button.

4. Select the schedule that you want to add to the Background Task Startup list and click Open.

5. Click OK to save the changes that you have made and close the User Preferences dialog box.
Starting FixBackgroundServer

To start FixBackgroundServer:

1. Click the Start button, and point to Run.

2. Enter the path and file name of the FixBackgroundServer application. By default:
   
   C:\Program Files\Proficy\Proficy iFIX\FIXBACKGROUNDSERVER.EXE

3. Click OK.

Starting FixBackgroundServer as a Windows Service

To start FixBackgroundServer as a Windows Service:

1. Shut down iFIX.

2. Ensure that you are logged in as an Administrator.
3. On the Start menu, point to Programs, Proficy HMI SCADA - iFIX, and then System Configuration. The System Configuration Utility (SCU) window appears.

4. From the Configure menu, click Local Startup. The SCU's Local Startup Definition dialog box appears.

5. Select the Continue Running After Log Off check box, and click OK. This configures iFIX to run as a service.

6. Click the Task Configuration button on the SCU toolbox. The SCU's Task Configuration dialog box appears.

7. In the Filename field, enter the path and file name of the FixBackgroundServer application. By default:

   C:\Program Files\Proficy\Proficy iFIX\FIXBACKGROUNDSERVER.EXE

8. Select the Background Option button.

9. Click Add to add FixBackgroundServer to the Configured Tasks list.
10. Click OK.
11. On the File menu, click Save to save the SCU file.
12. Exit the SCU.
13. Restart iFIX.

**Resolving Schedules**

To resolve a schedule:

1. In Classic view, from the WorkSpace toolbar, click the Resolve Files Tool button.

-Or-

In Ribbon view, on the Applications tab, in the Utilities group, click Utilities, and then click Resolve Files.

2. In the File Types area, select the Schedule check box.

3. In the Directories area, verify that your schedule directory is correct. If it is not, enter the correct path in the Schedules field.
4. In the Resolve Files area, select the schedule file you want to resolve. To select every file in the list, click Select All.

5. Click the Update Schedule Files button and then click OK.

Assigning Schedules to a Security Area

To assign a schedule to a security area:

1. Open the schedule that you want to assign by:
   - Double-clicking it in the Schedules folder of the Proficy iFIX WorkSpace system tree,
   - Or-
   Creating a new schedule:
     In Classic view, click the New Schedule button on the Standard Toolbar.
   - Or-
In Ribbon view, click the WorkSpace button, select New, and then click Schedule.

2. In Classic view, on the View menu, click Property Window.
   - Or -
   In Ribbon view, on the View tab, in the Window group, click Property Window.

3. In the Security Area field, enter the security area you want to use.

**Working with Entries**

You can perform the following tasks when working with the Scheduler entries:

- Creating Event-Based Entries
- Creating Time-Based Entries
- Editing, Copying, and Sorting Entries
Creating Event-Based Entries

To create an event-based entry:

1. Open the schedule that you want to add the event-based entry to by double-clicking it in the Schedules folder of the Proficy iFIX WorkSpace system tree, or create a new schedule by clicking the New Schedule button on the Standard Toolbar.

2. Right-click a row in the schedule. From the pop-up menu, select Add New Event Entry. The Add Event Entry dialog box appears.

3. Enter the data source that will trigger the event-based script for the entry, or click Browse to launch the Expression Builder dialog box. If you are using a tagname expression as a data source, click Quick Modify to modify the properties of a block directly without launching the Database Manager.

**NOTE:** The data source can be a process value, object property, VBA script, or mathematical expression.
4. From the Event Type menu, select the condition for triggering action.

5. If you selected While True or While False for the Event Type, enter an interval in the Interval field.

6. If you selected a historical data source, complete the Historical Properties tab. To do so:
   
   a. From the Historical Mode list, select a mode.
   
   b. In the Update Rate area, select the hours, minutes, and seconds for the update rate. If you chose a historical mode other than Current Value, go to Step C. Otherwise, go to Step 7.
   
   c. In the Start Date area, choose whether to use a fixed date or a relative date, (Days Before Now). Depending on your selection, select either the date or the Days Before Now.
d. In the Start Time area, choose whether to use a fixed time or a relative time, (Duration Before Now). Depending on your selection, select either the time, and optionally, Lock Time, or the hours, minutes, and seconds for the Duration Before Now.

e. From the Time Zone list, choose a time zone.

f. In the Duration Area, select the days, hours, minutes, and seconds for the duration.

7. Click either Run Wizard or VB Editor to create a script for the event. Complete the actions as necessary.

8. Click OK.
Creating Time-Based Entries

You can perform the following tasks when working with time-based entries:

- Creating One Shot Time-Based Entries
- Creating Continuous Time-Based Entries
- Creating Daily Time-Based Entries
- Creating Monthly Time-Based Entries

Creating One Shot Time-Based Entries

To create a one shot time-based entry:

1. Open the schedule that you want to add the one shot time-based entry to by double-clicking it in the Schedules folder of the Proficy iFIX WorkSpace system tree, or create a new schedule by clicking the New Schedule button on the Standard Toolbar.
2. Right-click a row in the schedule. From the pop-up menu, select Add New Timer Entry. The Add Timer Entry dialog box appears.

3. Select the One Shot option button and enter the date and time at which you want the entry to occur.

4. Enter the necessary information in the Schedule and Action areas. For help on individual fields within the Add Timer Entry dialog box, click the What's This? (question mark) help button and select the field for which you want more information.

5. Click OK. To save your changes, click the Save button on the Standard Toolbar.
Creating Continuous Time-Based Entries

To create a continuous time-based entry:

1. Open the schedule that you want to add the continuous time-based entry to by double-clicking it in the Schedules folder of the Proficy iFIX WorkSpace system tree, or create a new schedule by clicking the New Schedule button on the Standard Toolbar.

2. Right-click a row in the schedule. From the pop-up menu, select Add New Timer Entry. The Add Timer Entry dialog box appears.

3. Select the Continuous option button and enter the date and time at which you want the entry to occur.

4. Enter the necessary information in the Schedule and Action areas. For help on individual fields within the Add Timer Entry dialog box, click the What's This? (question mark) help button and select the field for which you want more information.
5. Click OK. To save your changes, click the Save button on the Standard Toolbar.

Creating Daily Time-Based Entries

To create a daily time-based entry:

1. Open the schedule that you want to add the daily time-based entry to by double-clicking it in the Schedules folder of the Proficy iFIX WorkSpace system tree, or create a new schedule by clicking the New Schedule button on the Standard Toolbar.

2. Right-click a row in the schedule. From the pop-up menu, select Add New Timer Entry. The Add Timer Entry dialog box appears.

3. Select the Daily option button.

4. Select the check box for all of the days of the week that you want the entry to trigger.

5. In the Start Time field, enter the time that you want the event to trigger.
6. Optionally, select the Enable End Time/Interval check box to configure the entry to trigger repeatedly at a specific rate and for a specific duration of time. Enter the time that you want to stop the entry from firing in the End Time field. Enter the duration of time between occurrences of the entry in the Interval field.

7. Enter the necessary information in the Schedule and Action areas. For help on individual fields within the Add Timer Entry dialog box, click the What's This? (question mark) help button and select the field for which you want more information.

8. Click OK. To save your changes, click the Save button on the Standard Toolbar.
Creating Monthly Time-Based Entries

To create a monthly time-based entry:

1. Open the schedule that you want to add the monthly time-based entry to by double-clicking it in the Schedules folder of the Proficy iFIX WorkSpace system tree, or create a new schedule by clicking the New Schedule button on the Standard Toolbar.

2. Right-click a row in the schedule. From the pop-up menu, select Add New Timer Entry. The Add Timer Entry dialog box appears.

3. Select the Monthly option button.

4. Select the buttons for all of the days of the month that you want the entry to trigger. Select the End of Month check box to have iFIX automatically trigger the entry on the last day of the month.

5. In the Start Time field, enter the time that you want the event to trigger.
6. Optionally, select the Enable End Time/Interval check box to configure the entry to trigger repeatedly at a specific rate and for a specific duration of time. Enter the time that you want to stop the entry from firing in the End Time field. Enter the duration of time between occurrences of the entry in the Interval field.

7. Enter the necessary information in the Schedule and Action areas. For help on individual fields within the Add Timer Entry dialog box, click the What's This? (question mark) help button and select the field for which you want more information.

8. Click OK. To save your changes, click the Save button on the Standard Toolbar.
Editing, Copying, and Sorting Entries

The following sections provide information on editing, copying, and sorting entries in the Scheduler:

- Modifying Existing Entries
- Copying Entries to Other Schedules
- Moving Entries to Other Schedules
- Sorting Entries in the Scheduler's Spreadsheet

Modifying Existing Entries

To modify an existing entry:

1. Open the schedule that contains the entry you want to modify by double-clicking it in the Schedules folder of the Proficy iFIX WorkSpace system tree.

2. Double-click the row number of the entry to display the Modify Timer Entry or Modify Event Entry dialog box.
3. Modify the fields in the Schedule, Trigger, and Action areas as desired. For help on individual fields, click the What's This? (question mark) help button and select the field for which you want more information.

4. Click OK. To save your changes, click the Save button on the Standard Toolbar.

_TIP: You can also select an individual cell in the schedule's spreadsheet and change its value directly rather than accessing the Modify Timer Entry or Modify Event Entry dialog boxes. Your modifications are automatically put into effect when you exit the cell._

**Copying Entries to Other Schedules**

_➤ To copy an entry to another schedule:_

1. Right-click the entry you want to copy from the Schedules folder of the Proficy iFIX WorkSpace system tree and select Copy from the pop-up menu.
2. From the Schedules folder of the Proficy iFIX WorkSpace system tree, right-click the schedule to which you want to copy the entry and select Paste from the pop-up menu. The entry is added to the schedule.

3. Open the schedule to which you copied the entry and click the Save button on the Standard Toolbar.

Moving Entries To Other Schedules

To move an entry to another schedule:

1. Drag and drop the entry from the one schedule to another in the Schedules folder of the Proficy iFIX WorkSpace system tree. The entry is deleted from the schedule from which it was moved and is added to the schedule to which it was moved.

2. Open each schedule and click Save on the Standard Toolbar.
Sorting Entries in the Scheduler's Spreadsheet

To sort entries in the Scheduler's spreadsheet:

- Click the heading of a spreadsheet column to toggle between sorting entries by ascending or descending order according to the information in that column.

NOTE: Sorting is only available in the configuration environment. In the run-time environment, entries display in the order that they were added to the schedule.

Working with the Scheduler at Run-time

You can perform the following tasks when working with the Scheduler at run-time:

- Viewing the Status of Entries in the Run-Time Environment
• Starting and Stopping Entries from Executing
• Resetting the Statistics of Entries
• Firing Entries Manually

Viewing the Status of Entries in the Run-time Environment

To view an entry's status in the run-time environment:

1. From the run-time environment, open the schedule you want to view.
2. Observe the following fields:
   • **Status** – displays the current status of the entry. Based on the current condition of the entry, this cell may display Active or Stopped.
   • **Name** – displays the name that you provided for the entry.
• **Number of Times Fired** – displays the number of times that the entry has fired since it was created, or since it was last reset.

• **Last Fired At** – displays the most recent time that the event has fired.

• **Next Time to Fire** – displays the next time that the entry is scheduled to fire.

  **NOTE:** The Next Time to Fire field only appears in time-based entries.

• **Description** – displays the description you provided for the entry.

### Starting and Stopping Entries from Executing

To start or stop an entry from executing:

1. From the run-time environment, on the File menu, click Open.
2. Select the schedule with the entry you want to control and click Open.

3. Click the Start/Stop button in the row of the entry. The Status cell changes to indicate whether the entry is Active or Stopped.

**Resetting the Statistics of Entries**

![To reset the statistics of an entry:]

1. From the run-time environment, on the File menu, click Open.

2. Select the schedule with the entry you want to control and click Open.

3. Click the Reset button in the row of the entry. The Number of Times Fired cell resets to zero and the Last Fired At cell resets to Undefined.
Firing Entries Manually

To fire an entry manually:

1. From the run-time environment, on the File menu, click Open.

2. Select the schedule with the entry you want to control and click Open.

3. Click the Fire Now button in the entry's row. The entry fires and the Number of Times Fired and Last Fired At cells update to show the new information.

Using Advanced Features

Advanced features of the Scheduler include the following:

- Viewing or Editing Scheduler Properties
- Using Script Authoring Experts
- Creating Entries Using Custom Scripts
- Troubleshooting Scripts That are not Firing Properly
To view or edit Scheduler properties:

1. Open a schedule by double-clicking it in the Schedules folder of the Proficy iFIX WorkSpace system tree, or create a new schedule by clicking the New Schedule button on the Standard Toolbar.

2. Right-click any row in the schedule and select Scheduler Properties from the pop-up menu. The Scheduler Properties dialog box appears.

3. Click the Run Time State, Window Properties, Statistics Refresh, and Background Files tabs to view the current settings and make changes as necessary. Use the What's This? (question mark) help button to get field-specific help for each tab.

4. Click OK.
Using the Multiple Command Script Wizard in Scheduler

To use the Multiple Command Script Wizard in Scheduler:

1. In the Add Timer Entry, Add Event Entry, or Script Authoring Wizard dialog box, click the Run Wizard button. The Multiple Command Script Wizard appears.

   **NOTE:** If you do not want to create a script automatically using the wizard, you can click the VB Editor button to launch the Visual Basic Editor, which allows you to enter your own custom script to fire at a specific date and time, or based on a particular event. Refer to the Writing Scripts manual for more information.

2. Choose a command from the Select Action to Append list. The Expert associated with the command you chose appears.

3. Complete the Expert with your desired settings and information.
4. Optionally, repeat steps 2 and 3 if you want to add additional commands to your scripted command sequence.

5. When you have finished choosing your command sequence, click OK.

Creating Entries Using Custom Scripts

▶ To create an entry using a custom script:

1. Double-click the schedule you want to add the entry to in the system tree. The schedule appears in the Proficy iFIX WorkSpace.

2. Right-click a row in the schedule and select Add New Event Entry from the pop-up menu. The Add Event Entry dialog box appears.

- Or -

Right-click a row in the schedule and select Add New Timer Entry from the pop-up menu. The Add Timer Entry dialog box appears.
3. Enter the Schedule and Trigger information and click the VB Editor button. The Visual Basic Editor (VBE) appears.

4. Write your custom script in the VBE and click the Save Project button on the toolbar.

5. Exit the VBE and click OK.

NOTES:

- Although the Multiple Command Script Wizard's purpose is to fully automate the VBA command scripting process, you can manually edit scripts generated by the wizard with the VB Editor. You may add or edit VBA scripts anywhere before the Scripts Authoring Tool header line (***** Scripts Authoring Tool *****) or directly between a "WizardEnd" and a "Wizard[x]=" statement. Do not edit any of the commented areas in the wizard-generated script. If the Multiple Command Script Wizard detects an improperly customized VBA script, you may encounter an error.
• The Multiple Command Script Wizard does not check the command sequence to make sure commands occur in a logical order.

Troubleshooting Scripts That Are Not Firing Properly

To troubleshoot scripts that are not firing properly in a schedule:

• In the run-time environment, click the Fire Now button for the entry that is not working properly. This button executes the script independently from when the script is scheduled to fire. Ensure that the script fires and runs properly.

• Check the entry's configuration by returning to the configuration environment and double-clicking the entry number to display the Modify Event Entry or Modify Timer Entry dialog box. Ensure that the parameters are set correctly.
• Check the SCU and ensure that SAC is running. Refer to the Setting Up the Environment e-book.

• Check the Database Manager and ensure that the block is on scan. Refer to the Building a SCADA System e-book.

• Use the Visual Basic Editor to debug the script.

---

**Local Node Alias**

The local node alias feature allows iFIX local SCADA nodes to share pictures, recipes, and historical collection groups across nodes without changing the node name. When you use this feature, you can create generic pictures and recipes and save development and maintenance time.
Fore more information, refer to the following sections:

- Enabling Local Node Alias
- Using Local Node Alias
- Local Node Alias Examples

---

**Enabling Local Node Alias**

Before you can use the local node alias features you must enable the local node alias feature in the SCU.

---

**Using Local Node Alias**

Once you have enabled the local node alias feature, you can use the THISNODE placeholder in the node portion of the tagname (NODE.TAG.FIELD). iFIX substitutes the local physical node name for the THISNODE placeholder, increasing the portability of pictures and recipes and eliminating the need to change tagname references for different nodes.
The system tree in the Proficy iFIX WorkSpace always shows the actual node represented by the THISNODE placeholder.

If, for example, you have ten production lines that produce similar products, you can create one generic display that can access real-time data from any of the ten lines. By using the THISNODE placeholder, if you need to change the display, you only need to make the change once. Refer to the Setting Up the Environment manual for more information.

Local Node Alias Examples

The local node alias feature can be used for pictures, recipes, and historical collection groups, as illustrated in the following examples:

- Picture Example
- Recipe Example
- Historical Collection Group Example
Picture Example

Assume that you have a Data link in a picture that is configured with the tagname FIX32.THISNODE.AI-1.F_CV, and your local SCADA node name is CANLINE1. When you open the picture, the Data link behaves as if it were configured as FIX32.CANLINE1.AI-1.F_CV.

If you open the same picture on a different computer whose local SCADA node name is CANLINE2, the Data link's tagname resolves to FIX32.CANLINE2.AI-1.F_CV.

Recipe Example

Assume that you have two SCADA nodes: FERMENTER1 and FERMENTER2. The recipes Beer1 and Beer2 are used to make beer and download to FERMENTER1 and FERMENTER2, respectively. The Beer1 recipe defines the following items:
The Beer2 recipe is identical except for the node name:

<table>
<thead>
<tr>
<th>Identifier</th>
<th>Formula</th>
</tr>
</thead>
<tbody>
<tr>
<td>FERMENTER2:ILK1.F_CV</td>
<td>0</td>
</tr>
<tr>
<td>FERMENTER2:XCV1F1.F_CV</td>
<td>0</td>
</tr>
<tr>
<td>FERMENTER2:W16S1.F_CV</td>
<td>150</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Identifier</th>
<th>Formula</th>
</tr>
</thead>
<tbody>
<tr>
<td>FERMENTER2:ILK1.F_CV</td>
<td>0</td>
</tr>
<tr>
<td>FERMENTER2:XCV1F1.F_CV</td>
<td>0</td>
</tr>
<tr>
<td>FERMENTER2:W16S1.F_CV</td>
<td>150</td>
</tr>
</tbody>
</table>
In this implementation, both recipes are required because each recipe has hard-coded node name references. The local node alias feature eliminates the need for two recipes. Instead, you can create one recipe for both SCADA nodes, as shown in the following example:
<table>
<thead>
<tr>
<th>Identifier</th>
<th>Formula</th>
</tr>
</thead>
<tbody>
<tr>
<td>THISNODE:ILK1.F_CV</td>
<td>0</td>
</tr>
<tr>
<td>THISNODE:XCV1F1.F_CV</td>
<td>0</td>
</tr>
<tr>
<td>THISNODE:W16S1.F_CV</td>
<td>150</td>
</tr>
<tr>
<td>THISNODE:T16F.F_CV</td>
<td>55</td>
</tr>
<tr>
<td>THISNODE:K16F1.F_CV</td>
<td>132</td>
</tr>
</tbody>
</table>

After you create this recipe, share the directory that it resides in and map the recipe paths of both SCADA servers to the shared directory. For information on changing the recipe paths, refer to the Creating Recipes manual.

**Historical Collection Group Example**

Assume that you want to create a chart using the tank level and tank temperature from the two SCADA nodes in the Recipe example. On FERMENTER1 these tagnames are:
<table>
<thead>
<tr>
<th>Identifier</th>
<th>Formula</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tank Level</td>
<td>FIX32.FERMENTER1.AI_LEVEL.F_CV</td>
</tr>
<tr>
<td>Tank Temperature</td>
<td>FIX32.FERMENTER1.AI_TEMP.F_CV</td>
</tr>
</tbody>
</table>

On FERMENTER2 these tags names are:

<table>
<thead>
<tr>
<th>Identifier</th>
<th>Formula</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tank Level</td>
<td>FIX32.FERMENTER2.AI_LEVEL.F_CV</td>
</tr>
<tr>
<td>Tank Temperature</td>
<td>FIX32.FERMENTER2.AI_TEMP.F_CV</td>
</tr>
</tbody>
</table>
When you define the pens for the chart, use the following data sources: FIX32.THISNODE.AI_LEVEL.F.CV and FIX32.THISNODE.AI_TEMP.F.CV.

If you open the chart on FERMENTER1, the tagnames resolve to FIX32.FERMENTER1.AI_LEVEL.F.CV and FIX32.FERMENTER1.AI_TEMP.F.CV.

If you open it on FERMENTER2, the tagnames resolve to FIX32.FERMENTER2.AI_LEVEL.F.CV and FIX32.FERMENTER2.AI_TEMP.F.CV.

---

**Reporting**

Detailed reports are important tools for reviewing the performance of a process. They allow you to quickly grasp the relationships between specific pieces of manufacturing process data so that you can make effective decisions. Using any third-party reporting application that supports ODBC queries, you can create customized reports based on iFIX real-time and historical data.
When you use iFIX real-time data, you generate the report with current data extracted from an iFIX database. When you create a report using iFIX historical data, you generate the report based on data gathered over a period of time.

Once generated, reports can be printed or displayed in the Proficy iFIX WorkSpace. The ability to display reports directly in the Proficy iFIX WorkSpace allows you to quickly view a report from any number of nodes in your system, greatly reducing the time it takes for you to make informed decisions about your process.

For your reporting solution, we recommend using Crystal Reports® XI. This reporting application uses ODBC to access iFIX data sources, allowing you to create professional, customized reports. The Crystal Report wizards make the process of defining your query and designing the layout of your report quick and easy. Crystal Reports also provides superior sorting capabilities and lets you insert informative graphs that help you to effectively analyze your process data.
Once created, your queries can be saved so you can quickly generate future reports based on these predefined queries.

For complete information on using Crystal Reports, refer to the Crystal Reports help. If you plan to create Crystal Reports run-time files so that you can run reports on a target node without a full development copy of the product, refer to the Crystal online help. Licensing restrictions apply. The Business Objects™ web page provides more information on licensing: http://www.businessobjects.com/products/reporting/crystalreports/licensing/default.asp.

**Using the Report Experts**

To use the Crystal Report Experts in iFIX, make sure you have Crystal Reports XI installed on your computer. Once you have created a report and selected the data sources you want to use in Crystal Reports, you can use the Report Experts in iFIX to generate or print the report.
**NOTE:** The Crystal Reports run-time file must be installed in order to print a report. The Crystal Reports Professional edition does not provide VBA scripting support, such as the .DLL file needed to print a report. For more information on how to create Crystal Report run-time files, refer to the Crystal Reports help.

The fixodbc.ini file, located in the Local path, can be edited to work with Crystal Reports. You can add or delete fields that are to be included in Crystal Reports real-time queries, such as A_TAG, A_NAME, or A_NODE. Historical queries are not affected by the fixodbc.ini file.

**Print Crystal Report – Report Task**

The Print Crystal Report button, from the report tasks, lets you preview a printed Crystal Report or print a Crystal Report in the configuration environment.
To print or preview a printed report using the Print Crystal Report button:

1. In Classic view, click the Print Crystal Report button on the toolbox.

   **NOTE:** If this button is not present, you can display it by following the steps outlined in the Displaying the Print Crystal Report Button If It Appears Missing section.

   -Or-

   In Ribbon view, on the Tools tab in the Tasks/Experts group, click Commands, and then click Print Crystal Report.

2. Click the Select Report button and select the Crystal Report you want to print.

3. Click the Preview Report button to view the report on your monitor and then click OK.

4. Click Print.

5. Click OK.
Displaying the Print Crystal Report Button If It Appears Missing

If you want to display the Print Crystal Report button in the toolbar, if it is not already displayed, use the Customize Toolbars dialog box.

To display the Print Crystal Report button:

1. In Classic view, on the WorkSpace menu, click Toolbars.
   - Or -
   In Ribbon view, on the Home tab, in the WorkSpace group, click Settings, and then click Toolbars.

2. From the Owners list, select WorkSpace.

3. Click the Customize button. The Customize Toolbars dialog box appears.

4. Click the Buttons tab.

5. From the list of Categories, select Report Tasks.
6. Drag and drop the button with the printer icon from the Buttons area of this dialog box to the iFIX toolbox.

7. Click Close.

Print Crystal Report – Command Task

The Print Crystal Report Expert, from the command tasks, lets you write the PrintReport script found in Factory-Globals to an object's click event. Once this is done, you can print the selected Crystal Report in the run-time environment by clicking on the object.

To tie the PrintReport script to an object's click event using the Print Crystal Report Expert:

1. Click on an object in the Proficy iFIX WorkSpace.
   -Or-
   In Ribbon view, on the Tools tab in the Tasks/Experts group, click Commands, and then click Print Crystal Report.

3. Click the Select Report button and select the Crystal Report you want to tie to the object's click event.

4. Click OK.

You can also use the Print Crystal Report Expert to write the PrintReport script to an entry in a schedule. Refer to the Script Authoring Experts section for more information on using Script Authoring Experts in a schedule.
To use the `PrintReport` subroutine in VBA:

- Use the following code example:

  ```vba
  Private Sub CommandButton1_Click()
  PrintReport "C:\Program Files\Proficy\Proficy iFix\APP\CrystalXIReportName.rpt"
  End Sub
  ```

**NOTE:** The Crystal Reports run-time file must be installed if you want to print a report from a schedule, since the Crystal Reports Professional edition does not provide VBA scripting support. For more information on how to create Crystal Report run-time files, refer to the Crystal Reports help.

**Displaying the Print Crystal Report Expert Button If It Appears Missing**

If you want to display the Print Crystal Report Expert button in the toolbar, if it is not already displayed, use the Customize Toolbars dialog box.
To display the Print Crystal Report Expert button:

1. In Classic view, on the WorkSpace menu, click Toolbars.
   -Or-
   In Ribbon view, on the Home tab, in the WorkSpace group, click Settings, and then click Toolbars.

2. From the Owners list, select WorkSpace.

3. Click the Customize button. The Customize Toolbars dialog box appears.

4. Click the Buttons tab.

5. From the list of Categories, select Command Tasks.

6. Drag and drop the button with the printer icon from the Buttons area of this dialog box to the iFIX toolbox.

7. Click Close.
Sample Report

The following is an example of a Crystal Report that was created using iFIX historical data. This report could be either printed or viewed directly in the Proficy iFIX WorkSpace.
## Thursday 3/19/2003

<table>
<thead>
<tr>
<th>Color: Blue</th>
<th>Finish Time</th>
<th>Mixer</th>
<th>Quantity</th>
<th>Batch ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>Blue Total:</td>
<td></td>
<td></td>
<td>1,949</td>
<td>3</td>
</tr>
<tr>
<td>11:00:23AM</td>
<td>MIXER1</td>
<td>649</td>
<td>6</td>
<td></td>
</tr>
<tr>
<td>10:59:32AM</td>
<td>MIXER1</td>
<td>300</td>
<td>5</td>
<td></td>
</tr>
<tr>
<td>10:50:40AM</td>
<td>MIXER1</td>
<td>1,000</td>
<td>2</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Color: Green</th>
<th>Finish Time</th>
<th>Mixer</th>
<th>Quantity</th>
<th>Batch ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green Total:</td>
<td></td>
<td></td>
<td>1,873</td>
<td>2</td>
</tr>
<tr>
<td>10:57:42AM</td>
<td>MIXER1</td>
<td>1,000</td>
<td>4</td>
<td></td>
</tr>
<tr>
<td>10:49:14AM</td>
<td>MIXER1</td>
<td>873</td>
<td>1</td>
<td></td>
</tr>
</tbody>
</table>
The Cross Reference Tool

The Cross Reference Tool is an iFIX utility that allows you to create a report identifying every data source or occurrence of a data source in pictures, scripts, schedules, or a User Global. Using the Cross Reference Tool, you can also locate a text string in object names, property names, and property values.
The Cross Reference Tool also enables you to find pictures containing selected Dynamo objects, or Dynamo objects that are in selected pictures.

By default, the report results display in the Cross Reference Tool interface. Additionally, the Cross Reference Tool provides options that allow you to configure the report to automatically print or save upon report completion.

This chapter describes the Cross Reference Tool interface and its functionality including:

- Understanding the Cross Reference Tool
- Using the Report Wizard or the Quick Report
- Exploring the Cross Reference Tool Interface
- Creating Quick Reports
- Creating Reports Using the Cross Reference Report Wizard
Understanding the Cross Reference Tool

The Cross Reference Tool allows you to identify where tags are used within iFIX pictures, scripts, schedules, and tag groups. Additionally, you can also perform a search to find a text string, or search for Dynamo objects. Once you select which type of search you would like to perform and define additional search options, the Cross Reference Tool creates a report that details the objects, properties, and property values that are related to that tag or text string.
You can create five types of searches using the Cross Reference Tool:

- All Tags
- One Tag
- Text
- Dynamo Objects in Pictures
- Pictures Containing Dynamo Objects

For detailed information regarding the report results of each search, refer to Viewing the Report Results.

For information on displaying the results of a search that includes VBA scripts or that resolves tag substitutions with Tag Group files, refer to the Viewing a Search that Includes VBA Scripts and Viewing a Search that Resolves Tags Using All Tag Group Files sections.
Searching for All Tags

The *All Tags* search type returns a list of all the tags in the selected object, picture, schedule, or User Global. This search returns a list that displays the name of the object that references the tag (Object column), the property of that tag (Property column), and the tag itself (Current Value column), as shown in the following figure.

```
<table>
<thead>
<tr>
<th></th>
<th>Object</th>
<th>Property</th>
<th>Current Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>OneOfEachObject.DataLink1.Format1</td>
<td>Source</td>
<td>Fix32.TISNODE.AA1.F.CV</td>
</tr>
<tr>
<td>2</td>
<td>OneOfEachObject.Text2</td>
<td>Caption</td>
<td>System.CurrentTime</td>
</tr>
<tr>
<td>3</td>
<td>OneOfEachObject.Text3</td>
<td>Caption</td>
<td>System.CurrentDate</td>
</tr>
<tr>
<td>4</td>
<td>OneOfEachObject.TestEvent</td>
<td>Source</td>
<td>Fix32.TISNODE.AA1.F.CV = 1</td>
</tr>
<tr>
<td>5</td>
<td>OneOfEachObject.Chart1.Pen1</td>
<td>Source</td>
<td>Fix32.NODE.TAG.F.CV</td>
</tr>
</tbody>
</table>
```

*Report Results of a Search for All Tags*

Searching for One Tag

The *One Tag* search type searches for a specific tag in the selected object, picture, schedule, or User Global, and all tag group files. You can enter a string in the Tag field or click the Browse (...) button to open the Expression Editor.
**TIP:** You can also search using a partial tag name. For example, entering AI would find AI1 and TANKAI.

The One Tag search also allows you to perform a find on an object in an object to object connection. Using the Cross Reference Tool report results, you could then determine which object required modification and make the change manually.

This search returns the name of the object that references the tag (Object column), the property type (Property column), and the tag name (Current Value column). For example, the following figure displays a One Tag search on the partial tag name ACTIVESTATUS.

<table>
<thead>
<tr>
<th></th>
<th>Object</th>
<th>Property</th>
<th>Current Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>NetworkStatusDisplay.Group1.AnimatedForegroundColor</td>
<td>Source</td>
<td>32.TTHISNODE NSDF.ACTIVESTATUS_1</td>
</tr>
<tr>
<td>2</td>
<td>NetworkStatusDisplay.Group2.AnimatedForegroundColor1</td>
<td>Source</td>
<td>32.TTHISNODE NSDF.ACTIVESTATUS_2</td>
</tr>
<tr>
<td>3</td>
<td>NetworkStatusDisplay.Group3.AnimatedForegroundColor2</td>
<td>Source</td>
<td>32.TTHISNODE NSDF.ACTIVESTATUS_3</td>
</tr>
<tr>
<td>4</td>
<td>NetworkStatusDisplay.Group4.AnimatedForegroundColor3</td>
<td>Source</td>
<td>32.TTHISNODE NSDF.ACTIVESTATUS_4</td>
</tr>
<tr>
<td>5</td>
<td>NetworkStatusDisplay.Group5.AnimatedForegroundColor4</td>
<td>Source</td>
<td>32.TTHISNODE NSDF.ACTIVESTATUS_5</td>
</tr>
<tr>
<td>6</td>
<td>NetworkStatusDisplay.Group6.AnimatedForegroundColor5</td>
<td>Source</td>
<td>32.TTHISNODE NSDF.ACTIVESTATUS_6</td>
</tr>
<tr>
<td>7</td>
<td>NetworkStatusDisplay.Group7.AnimatedForegroundColor6</td>
<td>Source</td>
<td>32.TTHISNODE NSDF.ACTIVESTATUS_7</td>
</tr>
<tr>
<td>8</td>
<td>NetworkStatusDisplay.Group8.AnimatedForegroundColor7</td>
<td>Source</td>
<td>32.TTHISNODE NSDF.ACTIVESTATUS_8</td>
</tr>
</tbody>
</table>

Report Results for a One Tag Search
Searching for Text

The *Text* search type searches for a text string in the object names, property names, and property values of selected object, picture, schedule, or User Global.

Leave *<ALL>* in the Text field to display all object names, property names, and property values. To search for a specific text string, enter text that would appear in the either the object name, property, or property value.

*NOTE:* Do not use a * wildcard in this field. Entering a wildcard returns a Search completed with no output error.

The Text search returns the object name, property, and property value in the Report Results section. If the Cross Reference Tool finds the text string in the object name, all of the object properties are listed in the Property column. For example, the following figure displays a Text search on the Text string FOREGROUNDCOLOR:
Searching for Dynamo Objects in Pictures

The *Dynamos in Pictures* search type searches for Dynamo objects in selected pictures.

To search for all Dynamo objects in a single picture, you can use either the Quick Report or the Report Wizard. To search for all Dynamos in more than one picture, use the Report Wizard to select multiple pictures from the Picture Files tab.

*NOTE:* At least one picture must be selected in the Picture Files tab, and at least one Dynamo Set must be selected in the Dynamo Sets tab, before you can conduct a search.
The Dynamos in Pictures search returns the name, revision number, and description of Master Dynamos and Dynamo Instances in the selected picture(s), as well as the Dynamo Sets to which the Dynamo objects belong.

If the Cross Reference Tool finds a Dynamo Instance and Master Dynamo whose revision numbers are different, the search result is listed in red, as shown below:

![Report Results of a Dynamos in Pictures Search](image)

*NOTE:* The Dynamo Updater is only available when a search reveals at least one revision mismatch between a Dynamo Instance and a Master Dynamo.
For more information on updating Dynamos, refer to Updating Dynamos in Pictures.

**Searching for Pictures Containing Dynamo Objects**

The *Pictures Containing Dynamos* search type searches for pictures that contain the selected Dynamo objects.

To search for all pictures that contain a single Dynamo object, you can use either the Quick Report or the Report Wizard. To search for all pictures that contain more than one Dynamo object, use the Report Wizard to select multiple Dynamos from the Dynamo Sets tab.

**NOTE:** At least one picture must be selected in the Picture Files tab, and at least one Dynamo Set must be selected in the Dynamo Sets tab, before you can conduct a search.

The Pictures Containing Dynamos search returns the names of the pictures in which the selected Dynamo objects exist, along with each Master Dynamo or Dynamo Instance's name, revision number, and description.
If the Cross Reference Tool does not find the selected Dynamo object(s) in any pictures, the search result is listed in red, as shown below:

Report Results of a Pictures Containing Dynamos Search

You can use the Dynamo Updater, available via a button on the toolbar, to update mismatched Dynamos. When you launch the Dynamo Updater, it pre-selects the Dynamos that were identified in the Cross Reference Tool's search results and displays them in its Select Dynamos tab.

**NOTE:** The Dynamo Updater is only available when a search reveals at least one revision mismatch between a Dynamo Instance and a Master Dynamo.

For more information on updating Dynamos, refer to Updating Dynamos in Pictures.
Using the Report Wizard or the Quick Report

The Cross Reference Tool offers two utilities to create a report: the Quick Report dialog box and the Cross Reference Report Wizard. The Quick Report dialog box allows you to select from the most common Cross Reference Tool search features on one picture, schedule, User Global, or object listed in the Object Tree.

The Cross Reference Report Wizard allows you to search on multiple files and configure automatic saving and printing options. Use the following feature lists to help you determine when to use each tool.

Quick Report Features

The Quick Report dialog box allows you to do the following:

- Search for all tags, one tag, or a text string in the selected picture, schedule, user global page, or object.
- Search for all pictures that contain a single Dynamo object, or all Dynamo objects in a single picture.
- Display the search results in the Report Results screen. Once the search completes, you can manually print out the results or choose to save the search results to a .CSV, .HTM, .XLS, or .TB2 file.
- Resolve tags during a search using all tag group files.
- Search through VBA scripts.
- Include a summary of the report at the end of the report.
- Automatically resize report columns.
- Append results to the Status Trail.

For more information, refer to Creating Quick Reports.
Cross Reference Report Wizard Features

The Cross Reference Report Wizard allows you to do the following:

- Search for all tags, one tag, or a text string in the selected picture, schedule, user global page, or object.
- Search for Dynamo objects in multiple pictures, or multiple pictures that contain several Dynamo objects.
- Select multiple files to search through and arrange them in a specific order.
- Resolve tags during a search using all tag group files.
- Search through VBA scripts.
- Configure report settings options, including:
  - Automatically save report to file.
  - Automatically save a status trail as a file.
  - Automatically print the report upon generation.
• Include a summary of the report at the end of the report.

• Automatically resize report columns.

For more information, refer to Creating Reports Using the Cross Reference Report Wizard.

Exploring the Cross Reference Tool Interface

To open the Cross Reference Tool, click the Cross Reference Tool button, shown in the following figure.

Cross Reference Tool Toolbar Button
The Cross Reference Tool interface includes the following sections:

**Object Tree** – Displays pictures, schedules, and User Globals that are currently opened in the Proficy iFIX WorkSpace. You can select a file or select an object within that file.

*NOTE:* If you have opened new files in the WorkSpace since opening the Cross Reference Tool, you will need to refresh the tree in order to see them displayed. To do this, click the Refresh button in the Cross Reference Tool Toolbar.

**Report Results Area** – Displays the results of the search. Refer to Viewing the Report Results for more information.

**Status Trail** – Displays the detailed status of the report, including error messages. Refer to Viewing the Status Trail for more information.
Using the Cross Reference Tool Toolbar

You can quickly access many of the Cross Reference Tool features in the Cross Reference Tool toolbar. The following table describes the functions of the Cross Reference Tool toolbar buttons.

<table>
<thead>
<tr>
<th>Cross Reference Tool Toolbar Buttons</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Use this button...</strong></td>
</tr>
<tr>
<td>[Image]</td>
</tr>
<tr>
<td>[Image]</td>
</tr>
<tr>
<td>Use this button...</td>
</tr>
<tr>
<td>-------------------</td>
</tr>
<tr>
<td><img src="image.png" alt="Computer icon" /></td>
</tr>
<tr>
<td>Cross Reference Tool Toolbar Buttons</td>
</tr>
<tr>
<td>--------------------------------------</td>
</tr>
<tr>
<td><strong>Use this button...</strong></td>
</tr>
<tr>
<td>![Print button]</td>
</tr>
<tr>
<td>![Refresh button]</td>
</tr>
<tr>
<td>Use this button...</td>
</tr>
<tr>
<td>-------------------</td>
</tr>
<tr>
<td>![FF]</td>
</tr>
<tr>
<td>![Dynamo Updater]</td>
</tr>
<tr>
<td>![Help]</td>
</tr>
</tbody>
</table>
Creating Quick Reports

The Quick Report Dialog Box appears when you open the Cross Reference Tool. In addition to allowing you to select a search type, the Quick Report dialog box also allows you to select the following search, report, and view options when you click the Options button:

Search Options

Resolve Tags using All Tag Group Files – If the selected file or object contains Tag Group symbols, this option resolves those symbols by attempting to match symbols with all Tag Group Definition files and finds all substitutions. This option is available for all search types.

Include VBA Scripts in Search – Allows the Cross Reference Tool to search through scripts within the selected file for the tag(s) or text.
Report Option

Include Summary – Adds a summary report to the end of the Cross Reference Report detailing the number of objects and tags searched.

View Options

Automatically Resize Report Columns – Automatically resizes the columns in the Report results to accommodate the text.

Append to Status Trail – If enabled, the status trail adds any new tracking information to the existing status trail. If disabled, each time the Report runs, all previous tracking information is overwritten by the new status trail.
To create a report using the Quick Report dialog box:

1. Select a file or object in the Object Tree.
   
   **NOTE:** If you want to run a Dynamos Quick Report to search for all pictures that contain Dynamo objects from a Dynamo Set, select the Dynamo Set in the Object Tree. If you want to run a Dynamos report that searches for all Dynamo objects in a picture, select the picture.


3. Select the desired search settings in the Quick Report dialog box.

4. Click the Search button.
   
   **NOTE:** You cannot access the Proficy iFIX WorkSpace while the Cross Reference Tool generates a report. Once the report completes, you will be able to access the Proficy iFIX WorkSpace again.
You can also double-click an object or file in the Object Tree to run a Quick Report. This runs the Quick Report using the default settings or the settings of your last report.

The results of the Quick Report display in the Report Results section of the Cross Reference Tool. You can save or print the report manually using the appropriate toolbar buttons.

---

Creating Reports Using the Cross Reference Report Wizard

The Cross Reference Report Wizard walks you through the process of creating a Cross Reference Report. The Cross Reference Report Wizard allows you to search through multiple files, and then configure the report to automatically print or save upon report completion.

To create a report using the Cross Reference Report Wizard:

1. Select what you want to search for and specify search options.
2. Choose which files the Cross Reference Tool searches and modify the search order.

3. Select whether the report results are automatically saved or printed and modify additional output options.

4. Review the wizard settings and run the report.

**Specifying Search Settings**

The Search Settings tab of the Cross Reference Report Wizard allows you to select the type of search that the report runs and specify the following search options:

**Resolve Tags using All Tag Group Files** – If the selected file or object contains Tag Group symbols, this option resolves those symbols by attempting to match symbols with all Tag Group Definition files and finding all substitutions. This option is available for all search types.
Include VBA Scripts in Search – Allows the Cross Reference Tool to search through scripts within the selected files for the tag(s).

Specifying Picture Files for the Report

The Picture Files tab of the Cross Reference Report Wizard allows you to select one or more pictures to search, and allows you to arrange them in a specific search order.

By default, the Select Files list displays all pictures in the C:\Program Files\Proficy\Proficy iFIX\PIC folder. If any of the selected pictures are not opened in the WorkSpace, the Cross Reference Tool opens them during report generation. Once the report finishes, these pictures are closed.

**NOTE:** Clicking the Select All button will select all pictures listed in the Picture Files tab except: ChartGroupDemo.grf, LocalAsBackup.grf, LocalAsPrimary.grf, NetworkStatusDisplay.grf, and NetworkStatusRedundancyDisplay.grf.
The Cross Reference Tool processes pictures from top to bottom in the list. You can re-arrange the order in which the pictures are processed by selecting a picture and clicking the up or down arrow button to move the selected picture up or down in the list.

**Specifying Schedule Files for the Report**

The Schedule Files tab of the Cross Reference Report Wizard allows you to select one or more schedules to search, and allows you to arrange them in a specific search order.

By default, the Select Files list displays all schedules in the C:\Program Files\Proficy\Proficy iFIX\PDB folder. If any of the selected schedules are not opened in the WorkSpace, the Cross Reference Tool opens them during report generation. Once the report finishes, these schedules are closed.
The Cross Reference Tool processes schedules from top to bottom in the list. You can rearrange the order in which the schedules are processed by selecting a schedule and clicking the up or down arrow button to move it up or down in the list.

**Specifying Dynamo Sets for the Report**

The Dynamo Sets tab of the Cross Reference Report Wizard allows you to select one or more Dynamo Sets to search, and allows you to arrange them in a specific search order.

By default, the Select Files list displays all Dynamo Sets in the C:\Program Files\Proficy\Proficy iFIX\PIC folder. If any of the selected Dynamo Sets are not opened in the WorkSpace, the Cross Reference Tool opens them during report generation. Once the report finishes, these Dynamo Sets are closed.
The Cross Reference Tool processes Dynamo Sets from top to bottom in the list. You can re-arrange the order in which the Dynamo Sets are processed by selecting a Dynamo Set and clicking the up or down arrow button to move it up or down in the list.

**Specifying Report Settings Options**

By default, the Cross Reference Tool displays the results of a search in the Report Results section of the Cross Reference Tool. The Report Settings tab of the Cross Reference Report Wizard allows you to specify the following output options in addition to the default display:

**Save Report to File** – Automatically saves the report when the report generation completes. You can save the report to the default file and location listed, enter one directly into the Save Report to File field, or click the Browse (...) button to locate a file or path.

Available file types include *.CSV, *.HTM, *.XLS, or *.TB2.
NOTE: Microsoft Excel enforces a maximum row limit of 65536. If you try to save a report that exceeds this row limitation in Excel, you will be prompted to continue or cancel. Please be aware that rows exceeding that limitation may be lost if you select either option.

**Save Status Trail** – Saves the status trail information when the report completes. You can save the report to the default file and location listed, enter one directly into the Save Status Trail field, or click the Browse (...) button to locate a file or path.

The available file type is *.TXT.*

**Print Report** – Automatically prints the report when complete. Click the Advanced button to modify the Print settings. Refer to Selecting Print Options and Printing a Report for more information.

Additionally, the Report Settings tab also allows you to set the following report and view options:
Include Summary – Adds a summary report to the end of the report that details the number of objects and tags searched.

Automatically Resize Report Columns –
Automatically resizes the columns in the Report Results section to accommodate the text.

Reviewing the Report Settings

The Apply and Go tab displays all of the settings you have selected in the Wizard.

Review your choices and if they are correct, click the OK button. If you need to modify any of the options, click the Back button to return to the appropriate tab.

NOTE: You cannot access the Proficy iFIX WorkSpace while the Cross Reference Tool generates a report. Once the report completes, you will be able to access the Proficy iFIX WorkSpace again.
Viewing the Report Results

Once you create a report using either the Quick Report or Cross Reference Report Wizard, the results display in the Report Results section of the Cross Reference Tool interface.

The information that appears in the Report Results columns depends upon which type of search you selected. The following table describes the search type and display results.
## Search Results

<table>
<thead>
<tr>
<th>Type of Search</th>
<th>Displays</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Tags</td>
<td>Returns a list that displays the name of the object that references the tag (Object column), the property of that tag (Property column), and the tag itself (Current Value column), as shown in the Report Results of a Search for All Tags figure.</td>
</tr>
<tr>
<td>One Tag</td>
<td>Returns the name of the object that references the tag (Object column), the property type (Property column), and the tag name (Current Value column). For example, the Report Results for a One Tag Search figure shows a One Tag search on the partial tag name ACTIVESTATUS.</td>
</tr>
<tr>
<td>---------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Text</td>
<td>Returns the object name, property, and property values. If the Cross Reference Tool finds the text string in the object name, all of the object properties are listed in the Property Column. For example, the Report Results of a Text Search figure shows a Text search on the string FOREGROUNDCOLOR.</td>
</tr>
</tbody>
</table>
Additionally, if you selected the Save Report to File or Print Report options in the Cross Reference Report Wizard, those are automatically completed when the results display. Once the Report Results display, you can also save or print the report manually using the appropriate toolbar buttons.

Viewing the Status Trail

The Status Trail, shown in the following figure, tracks the processing status of the report. This allows you to monitor the report progress and messages, and track errors encountered in the report.

<table>
<thead>
<tr>
<th>Date</th>
<th>Time</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>5/25/2002</td>
<td>2:12:26 PM</td>
<td>Search started on [HasTagGroups:KeyMacros:Scripts:Chart1:Pen1] was unresolved because there is no TGD file...</td>
</tr>
<tr>
<td>5/25/2002</td>
<td>2:12:29 PM</td>
<td>Source @tag1@ - [HasTagGroups:KeyMacros:Scripts:Chart1:Pen1:Source] was assumed as a DataSource, but it may not exist...</td>
</tr>
<tr>
<td>5/25/2002</td>
<td>2:12:42 PM</td>
<td>Source @tag2@ - [HasTagGroups:KeyMacros:Scripts:Chart1:Pen2] was unresolved because there is no TGD file...</td>
</tr>
<tr>
<td>5/25/2002</td>
<td>2:12:42 PM</td>
<td>Source @tag2@ - [HasTagGroups:KeyMacros:Scripts:Chart1:Pen2:Source] was assumed as a DataSource, but it may not exist...</td>
</tr>
<tr>
<td>5/25/2002</td>
<td>2:12:55 PM</td>
<td>Source @tag3@ - [HasTagGroups:KeyMacros:Scripts:Chart1:Pen3] was unresolved because there is no TGD file...</td>
</tr>
<tr>
<td>5/25/2002</td>
<td>2:12:55 PM</td>
<td>Source @tag3@ - [HasTagGroups:KeyMacros:Scripts:Chart1:Pen3:Source] was assumed as a DataSource, but it may not exist...</td>
</tr>
<tr>
<td>5/25/2002</td>
<td>2:13:09 PM</td>
<td>Source @tag4@ - [HasTagGroups:KeyMacros:Scripts:Chart1:Pen4] was unresolved because there is no TGD file...</td>
</tr>
<tr>
<td>5/25/2002</td>
<td>2:13:09 PM</td>
<td>Source @tag4@ - [HasTagGroups:KeyMacros:Scripts:Chart1:Pen4:Source] was assumed as a DataSource, but it may not exist...</td>
</tr>
</tbody>
</table>

Status Trail
To automatically save the Status Trail to a .TXT file when the report generates, select the Save Status Trail option in the Report Settings tab of the Cross Reference Report Wizard. You can also modify the name and default location of the Status Trail file in the Report Settings tab.

Viewing a Search that Resolves Tags Using All Tag Group Files

If you select the Resolve Tags Using All Tag Group Files option in either the Quick Report dialog box or the Cross Reference Report Wizard, the Cross Reference Tool attempts to resolve any tag substitutions found in the selected files with all Tag Group Files that you have on your computer during the All Tags, One Tag, or Text search.

The following figure displays the results of an All Tags search with the Resolve Tags using All Tag Group Files option.
### Search Results of Resolving Tags using All Tag Group Files

The Report Results section displays the object that references the tag, the property type of that tag, the tag substitution in the Current Value column, the resolved data source in the Resolved column, and the Tag Group File name that the substitution was found in.

The Cross Reference Tool attempts to resolve the substitution in all Tag Group files. Therefore, if the substitution does not exist in a Tag Group file, the Resolved column displays Unresolved, as shown in the previous figure.
Viewing a Search that Includes VBA Scripts

If you select the Include VBA Scripts in Search option in either the Quick Report or Cross Reference Report Wizard, the Cross Reference Tool searches through all scripts that are contained within the selected file(s) during an All tags, One Tag, or Text search.

The following figure displays the results of an All Tags search with the Include VBA Scripts in Search option.

![Search Results of Including VBA Scripts in Search](image)
If the Cross Reference Tool finds a tag in a script (or the tag or text string that you searched for), the Object column displays the object associated with that script, the Property column displays ScriptSource, and the Current Value column displays the line number and line text of the script that the tag appears in.

**NOTE:** If the scripts contained in the files that you are searching include variables and those variable names are either custom alarm areas or tag names, the Cross Reference Tool displays the variable as a source.

---

**Selecting Print Options and Printing a Report**

The Print dialog box allows you to specify the print settings for a report. When a report completes and displays in the Report Results section of the Cross Reference Tool, you can access this dialog box on the File menu by clicking the Print button. This prints the report as it appears. You can also access this dialog box in the Cross Reference Report Wizard, on the Report Settings tab, by clicking the Advanced button.
The Print option in the Report Settings tab allows you to set these options for automatic printing once the report generates.

▶To select print options and print a report:

1. Select a Print Range.

2. Click the Page Setup button to configure page settings. Refer to the Selecting Page Options for Printing section for more information.

3. Select any of the following Print Options:

   - **Column Headers** – Prints column headers at the top of each page.

   - **Row Headers** – Prints row headers on the left side of each page.

   - **Grid Lines** – Prints spreadsheet grid lines.

   - **Border** – Prints the spreadsheet border.
**Data Cells Only** – Does not print empty cells beyond the last column and row containing data.

**Color** – Prints colors in the spreadsheet as they appear on the screen.

**Shadows** – Prints the shadow effect in the column and row headers.

4. Click the Printer Setup button to modify the current printer and printer options.

5. Optionally, click the Print Preview button to view how the Report will appear when printed. Select Close from the Print Preview screen to return to the Print dialog box.

6. Click OK.

If you accessed the Print dialog box from the print toolbar button, clicking OK prints the report. If you accessed the Print dialog box from the Cross Reference Report Wizard, clicking OK returns you to the wizard.
Selecting Page Options for Printing

The Page Setup dialog box allows you to:

- Select page orientation
- Enter or modify page margins
- Create or modify headers and footers
- Specify the Preview zoom setting

Enter any desired changes to the Page Setup dialog box and click OK to return to the Print dialog box.

Customizing Header or Footer Text

The Change Header and Footer Attributes dialog box, shown in the following figure, allows you to create and modify headers and footers for your printed report. To access the Change Header and Footer Attributes dialog box, click the Change Header and Footer Attributes button on the Page Setup dialog box.
To add a header or footer to your printed report, select either the Header Text or Footer text option from the Apply to section and enter your text in the appropriate column. For example, if you want your text to be centered, enter the text in the Center column.

The Cross Reference Tool also provides some pre-configured common header and footer options, including:

- **<Default Header>** – Inserts the Report Title including the file name, date, and time.

- **<Time>** – Inserts a time stamp (date and time).

- **<Page Number>** – Inserts the current page number.

To select from these pre-configured strings, select a cell in the table and right-click it. The display toggles through the options.
Creating a Cross Reference Tool Report from the Command-Line

The Cross Reference Tool also allows you create reports or access the Cross Reference Tool Help while the Cross Reference Tool is closed. You can run the command-line options outlined in the following table from the Windows Run prompt.
<table>
<thead>
<tr>
<th>Option</th>
<th>Syntax</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>/r</td>
<td>crossreference.exe</td>
<td>Creates a report with the CrossReference.ini settings. This runs the CrossReference.ini settings which were automatically saved when you last closed the Cross Reference Tool. If no CrossReference.ini is found, the report runs with the defaults.</td>
</tr>
<tr>
<td></td>
<td>/r</td>
<td>NOTE: You must use the Cross Reference Report Wizard once before using the /r command. The Cross Reference Tool writes to the CrossReference.ini file when you create reports using the Cross Reference Report Wizard. Reports created using the Quick Report do not get written to the CrossReference.ini file. The /r parameter allows you to set up an entire search in the Cross Reference Report Wizard, navigate to the Apply and Go tab, and then click the Cancel button to cancel the search. After exiting the Cross Reference Tool, you could then run the crossreference.exe /r command at any point to generate the report with the settings you had entered.</td>
</tr>
</tbody>
</table>
Cross Reference Tool Dialog Boxes

The Cross Reference Tool includes the following dialog boxes (listed in alphabetical order):

- Change Header or Footer Attributes Dialog Box
- Cross Reference Report Wizard Dialog Box
- Page Setup Dialog Box
- Print Dialog Box
- Print Preview Screen
- Quick Report Dialog Box
- Quick Report Options Dialog Box
Change Header or Footer Attributes Dialog Box

The Change Header or Footer Attributes dialog box displays the following items:

**Header Text**

Select this option to insert or modify text in the header.

**Footer Text**

Select this option to insert or modify text in the footer.

**Text Reset Button**

Resets all header or footer information.

Cross Reference Report Wizard Dialog Box

The Cross Reference Report Wizard dialog box displays the following items:
## Search Settings Tab

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All Tags</td>
<td>Select this option to search for all tags contained in the selected picture, schedule, User Global, or object.</td>
</tr>
<tr>
<td>One Tag</td>
<td>Select this option to search for a specific tag, tag substitution, or symbol in the selected picture, schedule, User Global, or object and all Tag Group Definition files. Enter a specific tag, tag substitution, or symbol in the Tag field or click Browse to open the Expression Editor.</td>
</tr>
<tr>
<td>Item</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Tag (edit box)</td>
<td>Enter a specific tag, tag substitution, or symbol in the Tag field or click Browse to open the Expression Builder.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> Do not use a * wildcard in this field. Entering a wildcard returns a Search completed with no output error.</td>
</tr>
<tr>
<td>Text (button)</td>
<td>Select this option to search for text in object names, property names, and property values in the selected object.</td>
</tr>
<tr>
<td></td>
<td>Enter a text string that would appear in the Object, Property, Property Value, Resolved, or Tag Group File name columns in the Text field. To return a list of all objects, leave &lt;ALL&gt; in the Text field.</td>
</tr>
<tr>
<td>Item</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Text (edit box)           | Leave `<ALL>` or clear the field to return a list of all objects. To search for specific objects, enter a text string that would appear in the Object, Property, Property Value, Resolved, or Tag Group File name columns.  

**NOTE:** Do not use a * wildcard in this field. Entering a wildcard returns a Search completed with no output error. |
<p>| Dynamos in Pictures       | Select this option to search for Dynamo objects in selected pictures.                                                                                |
| Pictures Containing Dynamos | Select this option to search for pictures that contain the selected Dynamo objects.                                                               |</p>
<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Resolve Tags using All Tag Group Files</td>
<td>If the selected picture or object contains Tag Group symbols, this option resolves those symbols by attempting to match the symbols with all tag group files and find all substitutions. This option is available for all search types.</td>
</tr>
<tr>
<td>Include VBA Scripts in Search</td>
<td>Select this option to allow the Cross Reference Tool to search for the tag(s) through scripts within the selected file. Both the All Tag and One Tag searches return the tag, if found. The Text search returns all lines of script.</td>
</tr>
</tbody>
</table>
## Picture Files Tab

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>File Location Field</td>
<td>Click Browse to select another location to search for picture files. The iFIX PIC path is chosen by default: C:\Program Files\Proficy\Proficy iFIX\PIC.</td>
</tr>
<tr>
<td>Select All Button</td>
<td>Click this button to select all files listed in the Picture Files tab except: ChartGroupDemo.grf, LocalAsBackup.grf, LocalAsPrimary.grf, NetworkStatusDisplay.grf, and NetworkStatusRedundancyDisplay.grf.</td>
</tr>
<tr>
<td></td>
<td>You can select the Network status pictures manually, if needed.</td>
</tr>
<tr>
<td></td>
<td>During report generation, the Cross Reference Tool opens any of the selected files that were closed. When the Report finishes, those files are closed again.</td>
</tr>
<tr>
<td>Clear All Button</td>
<td>Click this button to clear any currently selected files.</td>
</tr>
<tr>
<td>------------------</td>
<td>----------------------------------------------------------</td>
</tr>
<tr>
<td>Up Arrow Button</td>
<td>Select this option to move the selected file up in the arranged search order.</td>
</tr>
<tr>
<td>Down Arrow Button</td>
<td>Select this option to move the selected file down in the arranged search order.</td>
</tr>
</tbody>
</table>

**Schedule Files Tab**

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>File Location Field</td>
<td>Click Browse to select another location to search for schedule files. The iFIX PDB path is chosen by default: C:\Program Files\Proficy\Proficy iFIX\PDB.</td>
</tr>
<tr>
<td>Feature</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Select All Button</td>
<td>Click this button to select all files listed in the Schedule Files tab.</td>
</tr>
<tr>
<td></td>
<td>During report generation, the Cross Reference Tool opens any of the selected files that were closed. When the Report finishes, those files are closed again.</td>
</tr>
<tr>
<td>Clear All Button</td>
<td>Click this button to clear any currently selected files.</td>
</tr>
<tr>
<td>Up Arrow Button</td>
<td>Select this option to move the selected file up in the arranged search order.</td>
</tr>
<tr>
<td>Down Arrow Button</td>
<td>Select this option to move the selected file down in the arranged search order.</td>
</tr>
</tbody>
</table>
# Dynamo Sets Tab

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>File Location Field</td>
<td>Click Browse to select another location to search for Dynamo files. The iFIX PIC path is chosen by default: C:\Program Files\Proficy\Proficy iFIX\PIC.</td>
</tr>
<tr>
<td>Select All Button</td>
<td>Click this button to select all files listed in the Dynamo Sets tab. During report generation, the Cross Reference Tool opens any of the selected files that were closed. When the Report finishes, those files are closed again.</td>
</tr>
<tr>
<td>Clear All Button</td>
<td>Click this button to clear any currently selected files.</td>
</tr>
<tr>
<td><strong>Up Arrow Button</strong></td>
<td>Select this option to move the selected file up in the arranged search order.</td>
</tr>
<tr>
<td>--------------------</td>
<td>--------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Down Arrow Button</strong></td>
<td>Select this option to move the selected file down in the arranged search order.</td>
</tr>
</tbody>
</table>
# Report Settings Tab

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save Report to File... (check box)</td>
<td>Select this option to automatically save the report when the report generation completes. Save the report to the default file and location listed, enter one directly into the Save Report to File field, or click Browse to locate a file or path.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> Microsoft Excel enforces a maximum row limit of 65536. If you try to save a report that exceeds this row limitation in Excel, Excel prompts you to continue or cancel. Be aware that rows exceeding that limitation may be lost if you select either option.</td>
</tr>
</tbody>
</table>
| Save Report to File... (edit box) | Displays the location of the saved report file. To modify the default settings, enter a new location or file name directly into this field, or click the Browse (…) button to locate one.

| Save Status Trail... (check box) | Select this option to save the status trail information when the report completes. Save the report to the default file and location listed, enter one directly into the Save Status Trail field, or click Browse to locate a file or path.

You can only save this file as a *.txt file. |
| **Save Status Trail... (edit box)** | Displays the location of the status trail file. To modify the default settings, enter a new location or file name directly into this field or click Browse to locate one.
You can only save this file as a *.txt file. |
| **Print Report** | Select this option to automatically print the report when complete. Click Advanced to modify the Print settings. |
| **Advanced Button** | Click this button to open the Print dialog box and modify the settings for your print report. |
| **Include Summary** | Select this option to add a summary report to the end of the Cross Reference Report detailing the number of objects and tags searched. This option is not available for a One Tag search. |
| Automatically Resize Report Columns | Select this option to automatically resize the Report Results columns to accommodate the text. |

**Apply and Go Tab**

Review your settings prior to generating a report.

**Left/Right Buttons**

Click the Left or Right button to scroll the row of tabs left or right.

**Back/Next Buttons**

Click the Back or Next button to navigate between tabs.

**OK**

Click the OK button to run the Cross Reference Report.
Page Setup Dialog Box

The Page Setup dialog box displays the following items:

**Portrait**

Prints a page that is taller than it is wide.

**Landscape**

Prints a page that is wider than it is tall.
### Page Margins

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Left</td>
<td>Enter the desired space between the left line of the page and the left line of the report.</td>
</tr>
<tr>
<td>Right</td>
<td>Enter the desired space between the right line of the page and the right line of the report with no indent.</td>
</tr>
<tr>
<td>Top</td>
<td>Enter the desired space between the top of the page and the first line of the report.</td>
</tr>
<tr>
<td>Bottom</td>
<td>Enter the desired space between the bottom line of the report and the bottom edge of the page.</td>
</tr>
</tbody>
</table>
Change Header and Footer Attributes

Click to open the Change Header and Footer dialog box, and configure headers and footers for your report. You can configure up to 9 lines of text for both the header and footer.

Range

Select the percent or number of pages that you would like to display in the Print Preview screen.

Print Dialog Box

The Print dialog box displays the following items:
# Print Range

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All</td>
<td>Prints the entire report. This is the only option available in Report Wizard configurations.</td>
</tr>
<tr>
<td>Selected Cells</td>
<td>Prints only the cells that you highlighted in the Cross Reference Tool screen.</td>
</tr>
<tr>
<td>Current Page</td>
<td>Prints only the current page of your report.</td>
</tr>
<tr>
<td>Pages</td>
<td>Prints a specific page range. Enter the desired start and end page ranges in the Pages fields.</td>
</tr>
</tbody>
</table>
# Print Options

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Column Headers</td>
<td>Prints the column headers at the top of each page.</td>
</tr>
<tr>
<td>Row Headers</td>
<td>Prints the row headers on the left side of each page.</td>
</tr>
<tr>
<td>Grid Lines</td>
<td>Prints the spreadsheet grid lines.</td>
</tr>
<tr>
<td>Border</td>
<td>Prints the spreadsheet border.</td>
</tr>
<tr>
<td>Data Cells Only</td>
<td>Select this option to ensure that the printer does not print empty cells beyond the last column and row containing data.</td>
</tr>
<tr>
<td>Screen Image Color</td>
<td>Prints the colors in the spreadsheet as they appear on the screen.</td>
</tr>
<tr>
<td>--------------------</td>
<td>---------------------------------------------------------------</td>
</tr>
<tr>
<td>Shadows</td>
<td>Prints the shadow effect within the column and row headers.</td>
</tr>
</tbody>
</table>

**Print Preview Screen**

The Print Preview screen displays the following items:

**Next**

Allows you to browse through multiple report pages in the Print Preview dialog box.

**Previous**

Allows you to browse through multiple report pages in the Print Preview dialog box.
Zoom

Click to zoom in and out on the displayed report. You configure the zoom percentage in the Page Setup dialog box.

Print

Click to print the previewed report directly from the Print Preview dialog box.

Setup

Click to open the Page Setup dialog box and modify any Page Orientation, Page Margins, Header and Footer Display, or Preview Zoom options.

Close

Closes the Print Preview screen and returns you to the Print dialog box.
Quick Report Dialog Box

The Quick Report dialog box displays the following items:

**All Tags**

Select this option to search for all tags contained in the selected picture, schedule, User Global, or object.

**One Tag (Button)**

Select this option to search for a specific tag, tag substitution, or symbol in the selected picture, schedule, User Global, or object and all Tag Group Definition files.

Enter a specific tag, tag substitution, or symbol in the Tag field or click the Browse (…) button to open the Expression Editor.
**Tag (Edit Box)**

Enter a specific tag, tag substitution, or symbol in the Tag field or click the Browse (...) button to open the Expression Builder.

**NOTE:** Do not use a * wildcard in this field. Entering a wildcard returns a Search completed with no output error.

**Text (Button)**

Select this option to search for text in object names, property names, and property values in the selected object.

Enter a text string that would appear in the Object, Property, Property Value, Resolved, or Tag Group File name columns in the Text field. To return a list of all objects, leave <ALL> in the Text field.
Text (Edit Box)

Leave <ALL> or clear the field to return a list of all objects. To search for specific objects, enter a text string that would appear in the Object, Property, Property Value, Resolved, or Tag Group File name columns.

**NOTE**: Do not use a * wildcard in this field. Entering a wildcard returns a Search completed with no output error.

Dynamos

Select this option to search for Dynamo objects in a selected picture, or pictures containing Dynamo objects from a selected Dynamo Set. The type of object you select in the Object Tree determines which search is conducted.

Search

Generates the Quick Report based on the settings and selections you have chosen.

**NOTE**: You can also generate the Quick Report by double-clicking an object in the Object Tree.
Options
Opens the Quick Report Options dialog box.

Quick Report Options Dialog Box
The Quick Report Options dialog box displays the following items:

Resolve Tags Using All Tag Groups
If the selected picture or object contains Tag Group symbols, this option resolves those symbols by attempting to match the symbols with all tag group files and find all substitutions. This option is available for all search types.

Include VBA Scripts in Search
Select this option to allow the Cross Reference Tool to search for the tag(s) through scripts within the selected file. Both the All Tag and One Tag searches return the tag, if found. The Text search returns all lines of script.
Include Summary

Select this option to add a summary report to the end of the Cross Reference Report detailing the number of objects and tags searched. This option is not available for a One Tag search.

Automatically Resize Report Columns

Select this option to automatically resize the Report Results columns to accommodate the text.

Append to Status Trail

Select this option to add any new tracking information to the existing status trail, if enabled. If disabled, each time a search runs, all previous tracking information is overwritten by the new status trail.
How Do I...

Click the appropriate link below for information about Cross Reference Tool's step-by-step procedures:

- Generating a Report Using the Quick Report Dialog Box
- Generating a Report Using the Report Wizard
- Resolving Tags During a Search using Tag Group Files
- Searching through VBA Scripts
- Configuring Report Output Settings
Generating a Cross Reference Report Using the Quick Report Dialog Box

To generate a Cross Reference Report using the Quick Report dialog box:

1. In Classic view, from the WorkSpace toolbar, click the Cross Reference Tool button.
   -Or-
   In Ribbon view, on the Applications tab, in the Utilities group, click Utilities, and then click Cross Reference Tool.

   By default, the Quick Report dialog box also appears when you open the Cross Reference Tool.

3. From the Object Tree, select a picture or object. To search through multiple pictures or objects, use the Report Wizard.
4. Choose to search for All Tags, One Tag, Text, or Dynamos in the selected object.

5. Click the Options button and select from the following search options from the Quick Report Options dialog box, if applicable:

- **Resolve Tags using All Tag Group Files** – If the selected picture or object contains Tag Group symbols, this option resolves those symbols by attempting to match symbols with the Tag Group Definition file and find all substitutions. This option is available for all Search types.

- **Include VBA Scripts in Search** – Allows the Cross Reference Tool to search through scripts within the selected file for the tag(s).

• **Automatically Resize Report Columns** – Automatically resizes the columns in the Report Results section to accommodate the text.

• **Append to Status Trail** – If enabled, the status trail adds any new tracking information to the existing status trail. If disabled, each time the report runs, all previous tracking information is overwritten by the new status trail.

6. Click OK to close the Quick Report Options dialog box.
7. Click Search to generate the report.

*NOTE:* You cannot access the Proficy iFIX WorkSpace while the Cross Reference Tool generates a report. Once the report completes, you will be able to access the Proficy iFIX WorkSpace again.

Generating a Cross Reference Report Using the Report Wizard

To generate a Cross Reference Report using the Report Wizard:

1. In Classic view, from the WorkSpace toolbar, click the Cross Reference Tool button.
   -Or-
   In Ribbon view, on the Applications tab, in the Utilities group, click Utilities, and then click Cross Reference Tool.

3. On the Search Settings tab, select what you would like to search for: All Tags, One Tag, Text, Dynamos in Pictures, or Pictures Containing Dynamos.

4. Select any of the Search Options, if appropriate.

5. Click Next to proceed to the Pictures Files Tab. This tab allows you to select multiple picture files to search through when the report generates. You can change the order of the search hierarchy by selecting the appropriate file and clicking the up and down arrow buttons.

   *NOTE: The Cross Reference Tool opens any closed files that are selected for report generation. When the report finishes, these files are closed again.*

6. Click Next to proceed to the Schedule Files Tab. This tab allows you to select multiple schedule files to search through when the report generates. You can change the order of the search hierarchy by selecting the appropriate file and clicking the up and down arrow buttons.
7. Click Next to proceed to the Dynamo Sets Tab. This tab allows you to select multiple Dynamo files to search through when the report generates. You can change the order of the search hierarchy by selecting the appropriate file and clicking the up and down arrow buttons.

8. Click Next to proceed to the Report Settings tab. This tab allows you to select any appropriate Report Output options.

9. Optionally, select the Include Summary option. This option adds a summary report to the end of the report that details the number of objects and tags searched.

10. Optionally, select the Automatically Resize Report Columns option. Enabling this option automatically resizes the columns in the Report Results display and printed report to accommodate the text.
11. Click Next to proceed to the Apply and Go tab. This tab allows you to review all the settings you have configured throughout the wizard.

*TIP: If you need to make any changes, click the Back button to return to the appropriate tab.*

12. Click OK to generate the Report. You cannot access the Proficy iFIX WorkSpace while the Cross Reference Tool generates a report. Once the report completes, you will be able to access the Proficy iFIX WorkSpace again.

*TIP: If the progress bar stops during report generation, an error message may have appeared in the background. Click in the Cross Reference Tool to move the Cross Reference Tool error dialog box to the foreground and acknowledge the error.*
The output from the report displays in the Cross Reference Tool screen. If you configured Save Report to File or Print Report, those automatically occur. Once the results from the Report appear, you can also save or print the report manually from the toolbar buttons in the Cross Reference screen.

Resolving Tags During a Search Using All Tag Group Files

To resolve tags during a search using all Tag Group Files:

1. In Classic view, from the WorkSpace toolbar, click the Cross Reference Tool button.

   -Or-

   In Ribbon view, on the Applications tab, in the Utilities group, click Utilities, and then click Cross Reference Tool.
2. From the File menu, select Quick Report.

-Or-

From the Tool menu, select Report Wizard.

3. In the Quick Report Options dialog or Search Options section, select the Resolve Tags using All Tag Group Files option.

If the selected picture or object contains Tag Group symbols, this option resolves those symbols by attempting to match symbols with the Tag Group Definition file and find all substitutions. The Resolve Tags using All Tag Group Files option is available for all Search types.
Searching Through VBA Scripts

To search through VBA scripts:

1. In Classic view, from the WorkSpace toolbar, click the Cross Reference Tool button.
   -Or-
   In Ribbon view, on the Applications tab, in the Utilities group, click Utilities, and then click Cross Reference Tool.

2. From the File menu, select Quick Report.
   -Or-
   From the Tool menu, select Report Wizard.

3. In the Quick Report Options dialog or Search Options section, select the Include VBA Scripts in Search option. This option allows the Cross Reference Tool to search through scripts within the selected picture for the tag(s).
Configuring Report Output Settings

To configure report output settings:

1. In Classic view, from the WorkSpace toolbar, click the Cross Reference Tool button.
   -Or-
   In Ribbon view, on the Applications tab, in the Utilities group, click Utilities, and then click Cross Reference Tool.

2. From the Tool menu, select the Report Wizard.

3. The Report Settings tab of the Cross Reference Report Wizard allows you to configure the following settings:
### Report Output Settings

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save Report to File</td>
<td>Automatically saves the report when the report generation completes. Save the report to the default file and location listed, enter one directly into the Save Report to File field, or click the Browse (…) button to locate a file or path. Available file types are *.csv, *.htm, *.xls, or *.tb2.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Save Status Trail</td>
<td>Saves the status trail information when the report completes. Save the report to the default file and location listed, enter one directly into the Save Status Trail field, or click the Browse (...) button to locate a file or path. The available file type for this file is *.txt.</td>
</tr>
<tr>
<td>Print Report</td>
<td>Automatically prints the report when complete. Click the Advanced button to modify Print settings.</td>
</tr>
</tbody>
</table>
### Report Option

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Include Summary</td>
<td>Adds a summary report to the end of the report that details the number of objects, number of tags, and VBA project reference information.</td>
</tr>
</tbody>
</table>

### View Option

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automatically Resize Report Column</td>
<td>Automatically resizes the columns in the Report results to accommodate the text.</td>
</tr>
</tbody>
</table>
Modifying Print Options

Click the appropriate link below for information on modifying print options:

- Selecting Print Options and Printing a Report
- Selecting Page Options for Printing
- Customizing Your Header or Footer Text

Selecting Print Options and Printing a Report

To select print options and print a report:

1. In Classic view, from the WorkSpace toolbar, click the Cross Reference Tool button.
   -Or-
   In Ribbon view, on the Applications tab, in the Utilities group, click Utilities, and then click Cross Reference Tool.
2. Perform one of the following sets of steps:
   - In the Object Tree pane, select an object with a report that you want to print.
   - On the File menu, click Print.
   - Or -
   - From the Tool menu, select Report Wizard.
   - From the Report Settings tab, select the Print Report option, and click the Advanced button.

2. Select a Print Range.

3. Click Page Setup.

4. Configure the page settings and click OK to return to the Print dialog box.
5. Optionally, select any of the following Print Options:

- **Column Headers** – Prints column headers at the top of each page.
- **Row Headers** – Prints row headers on the left side of each page.
- **Grid Lines** – Prints spreadsheet grid lines.
- **Border** – Prints the spreadsheet border.
- **Data Cells Only** – Does not print empty cells beyond the last column and row containing data.
- **Screen Image Color** – Prints colors in the spreadsheet as they appear on the screen.
- **Shadows** – Prints the shadow effect in the column and row headers.
5. Optionally, click the Printer Setup button to modify the current printer and printer options.

6. Click the Print Preview button to view how the Report will appear when printed.

7. Click the Close button to return to the Print dialog box.

8. Click OK.

   If you accessed the Print dialog box from the Cross Reference Report Wizard, clicking OK returns you to the wizard. If you accessed the Print dialog box on File menu by clicking the Print option, clicking OK prints the report.
Selecting Page Options for Printing

To select page options for printing:

1. In Classic view, from the WorkSpace toolbar, click the Cross Reference Tool button.
   -Or-
   In Ribbon view, on the Applications tab, in the Utilities group, click Utilities, and then click Cross Reference Tool.

2. Perform one of the following sets of steps:
   - In the Object Tree pane, select an object with a report that you want to print.
   - On the File menu, click Print.
-Or-

- From the Tool menu, select Report Wizard.
- From the Report Settings tab, select the Print Report option, and click the Advanced button.

3. Click the Page Setup button.

_TIP:_ You can also access the Page Setup dialog box by clicking the Setup button in the Print Preview screen.

4. Select either Portrait or Landscape for the Page Orientation.

5. Modify the Page Margins, if necessary.

6. Optionally, you can modify the Header and Footer text and display. To do this:

   - Click the Change Header and Footer Attributes button.
   - Modify the Header and Footer text and display attributes you would like to change.
• Click OK to save the changes and return to the Page Setup dialog box.

7. From the Preview Display Range drop-down menu, select a display setting. This setting determines the percentage of or number of pages displayed in the Print Preview screen.

8. Click OK to save changes and exit the Page Setup dialog box.

Customizing Header or Footer Text

To customize header or footer text:

1. In Classic view, from the WorkSpace toolbar, click the Cross Reference Tool button.

   -Or-

   In Ribbon view, on the Applications tab, in the Utilities group, click Utilities, and then click Cross Reference Tool.
2. Perform one of the following sets of steps:

- In the Object Tree pane, select an object with a report that you want to print.
- On the File menu, click Print.

-Or-

- From the Tool menu, select Report Wizard.
- From the Report Settings tab, select the Print Report option, and click the Advanced button.

3. Click the Page Setup button.

_TIP: You can also access the Page Setup dialog box by clicking the Setup button in the Print Preview screen._

4. Click the Change Header and Footer Attributes button.

5. In the Apply to area, select the Header Text or Footer Text option.

6. Enter text in the appropriate column.
For example, if you want text to be centered in the header, enter that text in the Center column.

To select from some pre-configured common Header or Footer options, select a cell in the table and right-click it. The display toggles through a list of options including:

- **<Default Header>** – Inserts the Report Title including the picture name, date, and time.
- **<Time>** – Inserts a time stamp (date and time).
- **<Page Number>** – Inserts the current page number.

7. Optionally, click the Browse (…) button to modify the Font characteristics.

8. Click OK to save your changes.
Creating Picture-specific Help Files

Picture-specific Help files are an efficient means of bringing more information to operators electronically without taking up valuable display space. This section describes how to add your own context-sensitive Help files to iFIX pictures. It includes the following sections:

- Why Create Picture-specific Help Files?
- What's This? Help
- Adding Help to an iFIX Picture
- Creating the Help File
- Example: Creating a Picture-specific Help File
Why Create Picture-specific Help Files?

There are several reasons why you might want to create a picture-specific Help file. For example, you may want to provide operators with concise answers to the following questions:

- What piece of equipment does this object represent?
- Where is this equipment located?
- What does this equipment control?
- Who is the manufacturer of this equipment?
- What are the Standard Operating Procedures (SOPs) for this picture?
In general, if you develop pictures that need to provide operators with equipment-specific information or sets of instructions, you should consider creating picture-specific Help files. For example, you are developing a picture that contains a pump. You can design the picture so that when operators click the pump and press SHIFT+F1, they receive a pop-up with information about the pump's manufacturer, voltage, amp rating, and horsepower.

Similarly, you can use picture-specific Help to develop training screens for new operators. If you were developing a training screen for the pump picture in the previous example, you could display Help pop-up windows containing such basic information as how to know when the pump is on or off, and when it is operating properly.
What's This? Help

Context-sensitive Help within a picture is in the form of What's This? Help. What's This? Help is a simple but highly useful form of Help that is designed to allow operators to quickly access Help information and return to their work. To get What's This Help on an object within an iFIX picture in run mode, an operator presses SHIFT+F1, points and clicks on the object, and a brief explanation appears.

Example

In the following example, an operator has pressed SHIFT+F1 in a picture while in run mode. The mouse cursor changes to the What's This? Help pointer.
While in What's This? Help mode, operators can click any object in the picture (or even the picture itself) for a Help pop-up window on that object.
The iFIX WorkSpace supports What's This? Help in two different types of compiled formats: Winhelp (*.hlp) and HTML Help (*.chm). A Winhelp .hlp file consists of the following source files: a project file, a topic file, and a map file. An HTML Help .chm file consists of the following source files: a project file, a topic file, a map file, and an alias file.
IMPORTANT: Be aware that Microsoft® Windows® Vista™ and Microsoft Windows® Server 2008 do not support Winhelp .hlp files. If you want to use What's This? Help in the iFIX WorkSpace in Windows® Vista™ or Windows® Server 2008, you must use HTML Help.

The Help project file contains the Help file's project options, such as the source files to include and compile, the name of the Help file, and so forth. The topic file contains the content that you want to display in the pop-up window when you invoke What's This? Help. The map file is a header file that creates an association between the object that you want to provide Help for and the topic within the Help file. In HTML Help, the alias file works in tandem with the map file to associate the object name with a specific HTML file name (you can map one or more objects to the same file name). In Winhelp, the alias file is an optional tool to help you map the same topic content to multiple objects.

What's This? Help files are not difficult to create, since you only have to specify a couple of Help project options in order to build a useful context-sensitive Help file.
The following table provides an overview of the minimum file types you need to create a What's This? Help project for use with iFIX.

<table>
<thead>
<tr>
<th>Help Component</th>
<th>Winhelp</th>
<th>HTML Help</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project File</td>
<td>*.hpj</td>
<td>*.hhp</td>
</tr>
<tr>
<td>Content File</td>
<td>*.rtf</td>
<td>*.htm</td>
</tr>
<tr>
<td>Map File</td>
<td>*.h</td>
<td>*.h</td>
</tr>
<tr>
<td>Alias File</td>
<td>*.h</td>
<td>*.h</td>
</tr>
<tr>
<td>(optional for Winhelp)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Adding Help to an iFIX Picture

First, specify the Help file name in the HelpFile property of your picture.

To specify the Help file name:

1. Right-click a blank space within the picture and select Properties from the pop-up menu. The Properties dialog box appears with the name of the CFixPicture object as the active object.

2. In the HelpFile property cell, specify the name of the Help file that contains your context-sensitive topics. If you copied this file to a path other than the default path (for example: C:\Program Files\Proficy\Proficy iFIX, or C:\Program Files\Proficy\Proficy iFIX\PIC), you need to include the path to the help file as well.

Refer to the Creating Picture-specific Help Files section for examples on how to create the Help file.

3. Save the picture.
Next, assign a unique number, called a Help context ID, to each object in your picture that you want the operator to be able to get Help on.

To assign a Help context ID:

1. Right-click each object in your picture (including the picture itself) for which you want to write a Help topic and select the Property Window command. The Properties window appears with the name of the selected object as the active object.

2. Set the ContextID property to the desired number. Remember that all context IDs within the same Help file must be unique. These values are used by the Help (Winhelp or HTML Help) application to correctly display the Help topic that is associated with the control. If two controls have the same context ID, the Help compiler displays an error message.
Finally, you need to make any object that you want an operator to be able to get Help on selectable.

To make the object selectable so that the operator can view the help:

1. Right-click each object in your picture (including the picture itself) for which you want to write a Help topic and select the Property Window command. The Properties window appears with the name of the selected object as the active object.

2. Set the IsSelectable property to True.

Creating the Help File

This chapter discusses how to create the source files that comprise a picture-specific Help file, and also provides all of the steps required to successfully implement What's This? Help into iFIX pictures.
It includes the following sections:

- Requirements
- Creating a Topic File
- Creating a Map and Alias File
- Creating and Compiling a Project File
- Testing Your Help File

Requirements

The requirements for creating a picture-specific What's This? Help files in iFIX are different for Winhelp and HTML Help. The sections below describe what each type of Help project requires.

Winhelp

- Microsoft® Word 2000, version 9.0.4402 SR-1, or another other word processor that can save files in Rich Text Format (.RTF).
- A text editor such as Notepad (to create or modify .h files).
• Microsoft® Help Workshop, version 4.03.0002. If you do not have Microsoft Help Workshop, you can obtain a copy from Microsoft at this location:

**IMPORTANT:** Microsoft® Windows® Vista™ and Microsoft Windows Server 2008 do not support Winhelp .hlp files.

**HTML Help**

• A text editor such as Notepad (to create or modify .htm and .h files).

• Microsoft® HTML Help Workshop, version 1.31 or higher. If you do not have Microsoft HTML Help Workshop, you can obtain the latest version from Microsoft at this location:
Creating a Topic File

When creating What's This? Help topic files, keep in mind that each topic must contain a unique topic ID number. The Help application needs a unique ID to display topics correctly. The steps below describe how to create a new topic whether you are using Winhelp or HTML Help.

To create a simple Winhelp topic file (.rtf) in Microsoft Word:

1. Open Microsoft® Word.
2. Create a new document.
3. From the Insert menu, click Footnote. The Footnotes and End Note dialog box appears.
4. Select the Custom Mark option button, enter a pound sign (#) in the adjacent field, and click OK. The document window displays a footnote area.
5. In the footnote area, enter a unique context string to the right of the pound sign. Do not include spaces in the context string. One common method is to use underscores for more descriptive context strings, such as:

water_pump_onoff_btn

6. Click the Close button on the footnote pane to close the footnote area and return to a full-screen document window. (To view the footnote text again, double-click the footnote symbol at the top of the topic.)

7. To the right of the footnote symbol, on the main page, enter the information that you want to appear in the Help pop-up window.

NOTE: If you want to create more topics, repeat steps 2-5 for each topic. Additionally, add a manual page break between the topics. Each topic must appear on a separate page in the .RTF file. (In Microsoft Word, select Ctrl+Enter to create a manual page break between Help topics.)

8. Save the document as an .RTF file.
To create a simple HTML Help topic file (.htm) in a text editor:

1. Open a text editor, such as Notepad.

   **NOTE:** Optionally, you can use an HTML Editor such as Macromedia® HomeSite® or Microsoft® FrontPage®. This allows you to add more formatting to your HTML page, without requiring a lot of knowledge of how to use HTML tags.

2. Copy (CTRL+C) the following text to the Windows clipboard, and paste (CTRL+V) it into your text editor:

   ```html
   <HTML>
   <HEAD>
   <TITLE>Title 1</TITLE>
   </HEAD>
   <body>
   <H1><font face="Arial">Title 1</font></H1>
   <P><font face="Arial">Paragraph 1</font></P>
   ```
3. Enter a title (heading) in the two "Title 1" sections, shown bolded above.

4. Replace "Paragraph 1" (shown bolded above) with the rest of the information that you want to appear in the Help pop-up window.

5. Save the file.

Creating a Map and Alias File

In order for the Help application to display the correct Help pop-up window when you select SHIFT+F1 on a particular object, you must associate each unique topic ID name with its corresponding Help context ID number (defined in the property page of an object). This association, or mapping, is done in the MAP section of a Help project file. The easiest way to map these values is to create a header file (.h) in a text editor and include that header in the MAP section.
Additionally, in HTML Help only, the next step is to create an alias (.h) file to map the ID number to an .htm file name. This file name is included in the ALIAS section of the Help project.

**NOTE:** The alias file is optional in Winhelp. It's not an integral component for the context-sensitive Winhelp, like it is for HTML Help. If you use Robohelp to create your HTML Help files, your aliases are stored in a .ali file instead of the default .h file that Microsoft Help WorkShop uses.

To create a header file with the context IDs (for both Winhelp & HTML Help):

1. Create a new text file in a text editor, such as Notepad.

2. In the text file, associate each topic ID name with an object's context ID number using the following format:

   ```
   #define <topic ID name> <context ID number>
   ```
For example, in the iFIX WorkSpace, if you defined the HelpContextID property of the pump in the previous example as 1000, it would appear in the header file as:

```c
#define water_pump_onoff_btn 1000
```

3. Continue to add these define statements, one per line, until all of your Context IDs have been added to the header file.

4. Save the file as a text-only file and provide it with an .h file name extension.

To create an alias file with additional ID mapping (for HTML Help only):

1. Create a new text file in a text editor, such as Notepad.

2. In the text file, associate each topic ID name with an object's HTML file name using the following format:

```plaintext
<topic ID name>=<HTML File Name>
```
For example, if the HTML file name of the pump in the previous example is `water_pump_onoff_btn.htm`, it would appear in the alias file as:

```
water_pump_onoff_btn = water_pump_onoff_btn.htm
```

3. Continue to add these statements, one per line, until all of your topics IDs have an associated HTML file name.

4. Save the file as a text-only file and provide it with a .h file name extension.

**Creating and Compiling a Project File**

The final step is to create a Help project file that allows you to compile the map file(s) and topic files into one binary Help file.
At a minimum, the steps you need to perform include:

- For **Winhelp**, you need to create a .hpj project file, add your .rtf file with the content, add the .h file with the ID numbers, and then save and compile the help project. Microsoft Windows Vista and Microsoft Windows Server 2008 do not support Winhelp. (In this case, use HTML Help instead.)

- For **HTML Help**, you need to create a .hhp project file, add your .htm files with the content, add the .h file with the ID numbers, add your .h file with the aliases, define a default window type, and then save and compile the help project.
Creating and Compiling a Simple Help Project

To create and compile the project file in Winhelp:

1. In Microsoft Help Workshop, from the File menu, click New. The New dialog box appears.

2. Select Help Project and click OK. The Project Name dialog box appears.

3. Type or browse for a path location, and enter a file name. Remember to use the same Help file name that you specified in the picture's Properties dialog box.

4. Click Save.

5. Click the Options button. The Options dialog box appears.

6. Select the General tab, and then, in the Help Title field, enter the name you want to appear in the title bar of your Help system.

7. Select the Files tab and click Change. The Topic Files dialog box appears.
8. Click the Add button and browse for the .rtf file that includes your Help topics. Click OK when you are complete.

9. From the Options dialog box, click OK.

10. Click the Map button. The Map dialog box appears.

11. Click Include. The Include File dialog box appears.

12. Browse and select the header file that includes all of your map statements. Click OK to exit the Include File dialog box, and click OK again to save your changes to the Map dialog box.

13. When you are ready to compile, click the Save and Compile button.
To create and compile the project file in HTML Help:

1. In the Microsoft HTML Help Workshop, from the File menu, click New. The New dialog box appears.

2. In the list box, select Project and click OK. The New Project wizard appears.

3. Leave the Convert Winhelp Project check box cleared, and click Next. The New Project - Destination screen appears in the wizard.

4. In the edit box, enter the location and name that you want your Help project to use. Remember to use the same Help file name that you specified in the picture's Properties dialog box.

5. Click Next. The New Project - Existing Files screen appears in the wizard.

6. Select the HTML Files (.htm) check box, and click Next. The New Project - HTML Files screen appears in the wizard.
7. Click Add. The Open dialog box appears.

8. Browse to and select the HTML file(s) that you want to add to your project and click Open to return to the New Project - HTML Files screen.


10. Click Finish.

11. Click the HTML Help API Information button (the fourth button down, on the Project tab). The HTML Help API Information dialog box appears.

12. From the Map tab, click the Header File button. The Include File dialog box appears.

13. Enter or browse to select the path and file name of your .h file.

14. Click OK.

15. Click the Alias tab, and then click the Include button. The Include File dialog box appears.
16. Enter or browse to select the path and file name of your .ali file.

17. Click OK, and then click OK again to close and save the information in the HTML Help API Information dialog box. After you do that, you will notice two new sections in your help project: [ALIAS] and [MAP].

18. Click the Add/Modify Window Definitions button (the third button down, on the Project tab). The Add a New Window Type dialog box appears.

19. Enter a name for your default window. For example, you may want to create a window named main. After you do that, click OK. The Window Types dialog box appears.

20. Click the Position tab, and then click the Autosizer button. The Autosizer dialog box appears.

21. Drag the dialog box and its corners until the box appears where you want topics to display on your screen, by default, and click OK.
22. On the Window Types dialog box, click OK.

23. Click the Save All Files and Compile button (the bottom button on the Project tab).

**How to Compile from a Command Line**

As an alternative, you can also build and compile a Help system from the command line. If you are building more complex help systems, you may find the command line options helpful.

Use these steps if you already created a .hpj or .hhp file and just want to build and compile an updated version. From the DOS prompt or from within a batch file, use the following commands to build and compile your help:
To build and compile Winhelp from the command line:

- Type this command to build and compile a help file:

  hcrtf -xn
  "C:\MyFolder\ProjectName.hpj"

  In this example, replace C:\Myfolder with the path of your Help project and replace ProjectName.hpj with the name of your help project. The -xn option, in this example, builds the help file without displaying the Help Workshop window. Refer to the Microsoft Help Workshop online Help for detailed information on command-lines and options.
To build and compile HTML Help from the command line:

- Type this command to build and compile a help file:

  \texttt{hhc "C:\MyFolder\ProjectName.hhp"}

  In this example, replace \texttt{C:\Myfolder} with the path of your Help project and replace \texttt{ProjectName.hhp} with the name of your help project. Refer to the Microsoft HTML Help Workshop online Help for detailed information on command-lines and options.

Testing Your Help File

After you create the Help file, you should test it within your application.
➢ To test your Help file:

1. Copy your compiled Help file to the iFIX base path or PIC path. By default, this path is: C:\Program Files\Proficy\Proficy iFIX, or C:\Program Files\Proficy\Proficy iFIX\PIC.

2. Follow the steps in the Adding Help to an iFIX Picture section to create a picture with context-sensitive help information, if you have not already created one.

3. In the Proficy iFIX WorkSpace runtime environment, open your Help-enabled picture.

4. Press SHIFT+F1. The cursor changes to a question mark pointer, indicating that it is in What's This? Help mode.

5. Click an object to which you assigned a Help context ID. The Help topic that you assigned to the object displays in a pop-up window. To dismiss the Help pop-up window, click anywhere on the screen.
Example: Creating a Picture-specific Help File

This section serves as a mini-tutorial that walks you through the complete process of creating a sample Help file and assigning it to a picture. For clarity, this example assumes that iFIX is installed to the C:\Program Files\Proficy\Proficy iFIX path and that you are developing your Help file in a working directory entitled C:\Program Files\Proficy\Proficy iFIX\HELP TEST.

NOTE: If you want to perform this example on a Microsoft® Windows® Vista™ or a Microsoft® Windows® Server 2008 computer, do not use Winhelp .hlp files. Instead, you must use HTML Help. Refer to the HTML Help Example below.

Winhelp Example

To create the .RTF content in Microsoft Word:

1. Open Microsoft® Word.
2. Create a new document.
3. From the Insert menu, click Footnote. The Footnotes and End Note dialog box appears.

4. Select the Custom Mark option button, enter a pound sign (#) in the adjacent field, and click OK. The document window displays a footnote area.

5. In the footnote area, enter the following text directly to the right of the footnote symbol:

   my_square

6. Click the Close button on the footnote pane to close the footnote area and return to a full-screen document window. (To view the footnote text again, double-click the footnote symbol at the top of the topic.)

7. To the right of the footnote symbol, on the main page, type the following text directly to the right of the footnote symbol:

   This is the Help topic for my square.
8. Save the document as SQUARE.RTF in the C:\Program Files\Proficy\Proficy iFIX\HELP TEST folder.

To assign the Winhelp file, context ID, and set the IsSelectable property:

1. In the iFIX WorkSpace configure mode, open a new iFIX picture.

2. Right-click the picture and select the Property Window command.

3. In the HelpFile property field, enter the following text:
   
   square.hlp

4. Click the Rectangle button on the Toolbox and draw a rectangle.

5. Right-click the rectangle and select the Property Window command.

6. In the ContextID property field, enter the following number:
   
   1000

7. Set the IsSelectable property field to True.
8. Save the picture with the name HELPTEST. By default, iFIX saves the picture to this folder: C:\Program Files\Proficy\Proficy iFIX\PIC.

To create a map file for Winhelp:

1. Create a new text file in a text editor, such as Notepad.

2. In the text file, enter the following information:

   ```
   #define square 1000
   ```

3. Save the file as SQUARE.h in the C:\Program Files\Proficy\Proficy iFIX\HELP TEST folder.

To create and build the Winhelp project file:

1. In Microsoft Help Workshop, from the File menu, click New. The New dialog box appears.

2. Select Help Project and click OK. The Project Name dialog box appears.
3. Enter C:\Program Files\Proficy\Proficy iFIX\HELP TEST\SQUARE.HPJ, and click Save.

4. Click the Options button. The Options dialog box appears.

5. Select the General tab and, in the Help Title field, enter *My Square* as the name you want to appear in the title bar of your Help system.

6. Select the Files tab and click Change. The Topic Files dialog box appears.

7. Click the Add button and browse for the SQUARE.RTF file, in the C:\Program Files\Proficy\Proficy iFIX\HELP TEST folder, that includes your Help topics. Click OK.

8. On the Options dialog box, click OK.

9. Click the Map button. The Map dialog box appears.

10. Click Include. The Include File dialog box appears.

11. Click the Browse button to select the C:\Program Files\Proficy\Proficy iFIX\HELP TEST\SQUARE.h file.
12. Click OK, and then click OK again to close the Map dialog box.

13. Click the Save and Compile button.

**To test the Winhelp file:**

1. Copy the SQUARE.HLP Help file to the C:\Program Files\Proficy\Proficy iFIX directory.

2. In the Proficy iFIX WorkSpace, open the HELPTEST picture.

3. If you are not already in run mode, on the WorkSpace menu, select Switch to Run (Classic view) or on the Home tab, in the WorkSpace group, click Switch to Run (Ribbon view).

4. Press SHIFT+F1. The cursor changes to a question mark pointer, indicating that it is in What's This? Help mode.

5. Click the rectangle. A Help pop-up window with the following text appears:

   This is the Help topic for my square.
HTML Help Example

To create the HTML content in a text editor:

1. Open a text editor, such as Notepad.
2. Copy (CTRL+C) the following text to the Windows clipboard, and paste (CTRL+V) it into your text editor:

```html
<HTML>

<HEAD>

<TITLE>Title 1</TITLE>

</HEAD>

<body>

<H1><font face="Arial">Title 1</font> </H1>

<P><font face="Arial">Paragraph 1</font> </P>

</BODY>

</HTML>
```
3. For the two "Title 1" sections, shown bolded above, enter "My Square."

4. Replace "Paragraph 1" (shown bolded above) with the following:

   This is the Help topic for my square.

5. Save the file as SQUARE.htm in the C:\Program Files\Proficy\Proficy iFIX\HELP TEST folder.

   To assign the HTML Help file, context ID, and set the IsSelectable property:

   1. In the iFIX WorkSpace configure mode, open a new iFIX picture.

   2. Right-click the picture and select the Property Window command.

   3. In the HelpFile property field, enter the following text:

      square.chm

   4. Click the Rectangle button on the Toolbox and draw a rectangle.

   5. Right-click the rectangle and select the Property Window command.
6. In the ContextID property field, enter the following number:
   
   1000

7. Set the IsSelectable property field to True.

8. Save the picture with the name HELPTEST. By default, iFIX saves the picture to this folder: C:\Program Files\Proficy\Proficy iFIX\PIC.

▶ To create a map file and alias file for HTML Help:

1. Create a new text file in a text editor, such as Notepad.

2. In the text file, enter the following information:
   
   #define square 1000

3. Save the file as SQUARE.h in the C:\Program Files\Proficy\Proficy iFIX\HELP TEST folder.

4. Create another new text file in a text editor, such as Notepad.
5. In the text file, enter the following information:

    square = SQUARE.htm

6. Save the file as MYALIASES.h in the C:\Program Files\Proficy\Proficy iFIX\HELP TEST folder.

To create and build the HTML Help project file:

1. In the Microsoft HTML Help Workshop, from the File menu, click New. The New dialog box appears.

2. In the list box, select Project and click OK. The New Project wizard appears.

3. Leave the Convert Winhelp Project check box cleared, and click Next. The New Project - Destination screen appears in the wizard.

4. In the edit box, enter the location and name that you want your Help project to use: C:\Program Files\Proficy\Proficy iFIX\HELP TEST\SQAURE.HHP
5. Click Next. The New Project - Existing Files screen appears in the wizard.

6. Select the HTML Files (.htm) check box, and click Next. The New Project - HTML Files screen appears in the wizard.

7. Click Add. The Open dialog box appears.

8. Browse to and select the following file: C:\Program Files\Proficy\Proficy iFIX\HELP TEST\SQAURE.htm. Click Open to return to the New Project - HTML Files screen.


10. Click Finish.

11. Click the HTML Help API Information button (the fourth button down, on the Project tab). The HTML Help API Information dialog box appears.

12. From the Map tab, click the Header File button. The Include File dialog box appears.
13. Click Browse to select the SQUARE.h file in your C:\Program Files\Proficy\Proficy iFIX\HELP TEST folder.

14. Click OK.

15. Click the Alias tab, and then click the Include button. The Include File dialog box appears.

16. Click Browse to select the MYALIASES.h file in the C:\Program Files\Proficy\Proficy iFIX\HELP TEST folder.

17. Click OK, and then click OK again to close and save the information in the HTML Help API Information dialog box. After you do that, you will notice two new sections in your help project: [ALIAS] and [MAP].

18. Click the Add/Modify Window Definitions button (the third button down, on the Project tab). The Add a New Window Type dialog box appears.
19. Enter a name for your default window. For example, you may want to create a window named *main*. After you do that, click OK. The Window Types dialog box appears.

20. Click the Position tab, and then click the Autosizer button. The Autosizer dialog box appears.

21. Drag the dialog box and its corners until the box appears where you want topics to display on your screen, by default, and click OK.

22. From the Window Types dialog box, click OK.

23. Click the Save All Files and Compile button (the bottom button on the Project tab).
To test the HTML Help file:

1. Copy the SQUARE.CHM Help file to the C:\Program Files\Proficy\Proficy iFIX, or C:\Program Files\Proficy\Proficy iFIX\PIC directory.

2. In the Proficy iFIX WorkSpace, open the HELPTEST picture.

3. If you are not already in run mode, on the WorkSpace menu, select Switch to Run (Classic view) or on the Home tab, in the WorkSpace group, click Switch to Run (Ribbon view).

4. Press SHIFT+F1. The cursor changes to a question mark pointer, indicating that it is in What's This? Help mode.

5. Click the rectangle. A Help pop-up window with the following text appears:

   My Square

   This is the Help topic for my square.
Customizing the System Tree

**CAUTION:** The instructions in this section are strictly intended for users who are creating their own custom installation DVD. We strongly discourage customizing your system tree under any other circumstances. This information is meant for advanced users only.

The Proficy iFIX WorkSpace system tree is the main tool for locating files and launching applications. It also provides access to your files and applications during the development of your pictures and schedules.

Depending on your needs, you may want to remove certain applications or folders or add new ones. For example, you may want to add a custom application to the system tree. On the other hand, if you did not purchase FIX SCADA support, you may want to delete the Database Manager application and I/O Drivers folder.
You can customize the system tree by modifying the text file SystemTree.CSV. This file defines the folders, applications, and files that appear when you start the Proficy iFIX WorkSpace. The file resides in the Local path.

**CAUTION:** Any changes made to the SystemTree.CSV file are done so at your own risk. All changes made to the system tree are permanent. We recommend making a backup copy of the SystemTree.CSV file that, if necessary, can be used to reset the system tree to its default settings.

**NOTE:** We recommend using Microsoft Excel when editing the SystemTree.CSV file. When saving the file in Excel, be sure to save it with a .CSV extension. If prompted to save the file in Microsoft Excel Workbook format, select No. If the SystemTree.CSV file is saved incorrectly, the system may not be usable. When editing the file, you must use a comma (,) as the list separator. Other characters, such as the international list separator (;) cannot be used as the list separator in the SystemTree.CSV file. To view or modify the list separator setting on your system, double-click the Regional Settings icon in the Control Panel and click the Number tab.
The SystemTree.CSV file is divided into two sections. The top section defines the folders in the system tree and the bottom section defines the files. Within each of these sections are attributes that determine how a folder or file appears in the system tree. For example, the Key field contains the name of the file or folder as it appears in the system tree, and the Key Type field defines whether it is a folder or file. The remaining attributes have Entry and Value fields. The Entry field holds the name of the attribute and the Value field defines the corresponding attribute value. The attributes for folders and files are defined in the Folder Attributes and File Attributes tables.

**NOTE:** Although not all of the attributes in this file need to be defined, it is important to note that if the Entry field is completed for an attribute, the corresponding Value field must also be completed.

When you are ready to customize the SystemTree.CSV file, refer to the following figure for an overview of the required steps.
1. Open the SystemTree.CSV file. This file resides in the Local path.

2. Delete any files or folders you do not want to include.

3. Add any files and folders you want to include.

4. Save the file in the Local path with a .CSV extension.

5. Close the Proficy iFIX WorkSpace.

6. Select Run from the Windows Start menu and enter the command: `WorkSpace /unregserver`

7. Restart the Proficy iFIX WorkSpace.

**System Tree Customization Overview**
Adding Folders to the System Tree

You can add folders to the system tree by editing the top section of the SystemTree.CSV file. Use the Folder Attributes table as a guide to editing the file.

To add a folder to the system tree:

1. Open the SystemTree.CSV file located in the Local path.
2. Insert a row within the Define GE Intelligent Platforms Folder section.
3. Enter the information for the folder in the attribute fields. For example, to add a folder named Events that contains event files enter the following (leave unused fields blank):
<table>
<thead>
<tr>
<th>For the attribute...</th>
<th>Enter...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Events</td>
</tr>
<tr>
<td>Folders</td>
<td>Folder</td>
</tr>
<tr>
<td>Extension Entry</td>
<td>Extension</td>
</tr>
<tr>
<td>Extension of the files for this folder</td>
<td>Evt</td>
</tr>
<tr>
<td>AutoFind Entry</td>
<td>AutoFind</td>
</tr>
<tr>
<td>Used to find, create, and populate this folder on startup</td>
<td>TRUE</td>
</tr>
<tr>
<td>Fix Path Entry</td>
<td>Fix Path</td>
</tr>
<tr>
<td>Default path for files in this folder</td>
<td>ALM_PATH</td>
</tr>
</tbody>
</table>
4. Save the file in the Local path with a .CSV extension.

5. Close the Proficy iFIX WorkSpace.

6. Click the Start button, and then click Run. In the Open field, type WorkSpace /unregserver.

7. Click OK.

8. Restart the Proficy iFIX WorkSpace.

Folder definitions include the attributes in the following table.
<table>
<thead>
<tr>
<th>The attribute...</th>
<th>Defines...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>The names of the folders in the system tree. By adding a new name, you add a new folder to the system tree. If you want the folder to appear inside another folder enter the complete path. For example, to add a folder called Drawings to the Pictures folder you would enter: Pictures\Drawings</td>
</tr>
<tr>
<td>Folders</td>
<td>Each entry as a folder and always has the value FOLDER.</td>
</tr>
<tr>
<td>The attribute</td>
<td>Defines</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------------------------------------------------------------</td>
</tr>
<tr>
<td>AppKey</td>
<td>An entry that is reserved for future use and should be left blank.</td>
</tr>
<tr>
<td>Vendor of Folder</td>
<td>A company name. When you add a folder, enter the name of your company. Completing this attribute is optional.</td>
</tr>
<tr>
<td>ProgID of files in this folder</td>
<td>The program identification from the registry of the ActiveX documents residing in the folder. If the folder does not contain ActiveX documents, leave the ProgID blank.</td>
</tr>
<tr>
<td>The attribute...</td>
<td>Defines...</td>
</tr>
<tr>
<td>------------------</td>
<td>------------</td>
</tr>
<tr>
<td>Extension of the files for this folder</td>
<td>The file extension you want to associate with the folder. Completing this attribute is optional. If Used to find create and populate this folder on startup is set to TRUE, this attribute must be completed.</td>
</tr>
</tbody>
</table>
## Folder Attributes

<table>
<thead>
<tr>
<th>The attribute...</th>
<th>Defines...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Used to find create and populate this folder on startup</td>
<td>Whether the Proficy iFIX WorkSpace automatically displays the files with the specified extension. Setting Used to find create and populate this folder on startup to TRUE displays the files; entering FALSE or leaving the extension undefined creates an empty folder. Typically, this attribute is set to TRUE. If set to TRUE, the Extension attribute must be completed.</td>
</tr>
<tr>
<td>The attribute...</td>
<td>Defines...</td>
</tr>
<tr>
<td>-----------------</td>
<td>------------</td>
</tr>
<tr>
<td>Fix Path Entry</td>
<td>The path to each folder. When you add a folder, enter the complete path to it. This must be a FIX path.</td>
</tr>
<tr>
<td>Disable New Entry</td>
<td>Whether the New command on the folder's right mouse menu is grayed out or enabled. Entering TRUE grays out the command; setting the attribute to FALSE or leaving it undefined enables the command. Typically, this attribute is set to FALSE.</td>
</tr>
</tbody>
</table>
## Folder Attributes

<table>
<thead>
<tr>
<th>The attribute...</th>
<th>Defines...</th>
</tr>
</thead>
<tbody>
<tr>
<td>OpenExclusive</td>
<td>How the documents in the folder are opened. Entering TRUE opens the files exclusively for use in the Proficy iFIX WorkSpace; no other applications can read or write to these files. Setting the attribute to FALSE opens documents in a non-exclusive manner so that other applications can read or write the file. Typically, this attribute is set to FALSE.</td>
</tr>
</tbody>
</table>
Adding Files to the System Tree

You can add files to the system tree by editing the bottom section of the SystemTree.CSV file. Use the File Attributes table as a guide to editing the file.

To add a file to the system tree:

1. Open the SystemTree.CSV file located in the Local path.
2. Add a folder named Event as described in the Adding Folders to the System Tree section.
3. Insert a row within the Define GE Intelligent Platforms Files section of the file.
4. Enter the information for the file in the attribute fields. For example, to add a text file called Text File within the Events folder enter the following (leave unused fields blank):
<table>
<thead>
<tr>
<th>For the attribute...</th>
<th>Enter...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Events\Text File</td>
</tr>
<tr>
<td>Files</td>
<td>File</td>
</tr>
<tr>
<td>Fix Path Entry</td>
<td>Fix Path</td>
</tr>
<tr>
<td>Path of this file</td>
<td>ALM_PATH\Test.txt</td>
</tr>
<tr>
<td>AutoLoad Entry</td>
<td>AutoLoad</td>
</tr>
<tr>
<td>Used to determine if this file should be opened on startup by the WorkSpace</td>
<td>FALSE</td>
</tr>
</tbody>
</table>

5. Save the file in the Local path with a .CSV extension.
6. Using Notepad, create a text file named Test.txt and save it in your 
C:\Program Files\Proficy\Proficy 
iFIX\Alm folder.

7. Close the Proficy iFIX WorkSpace.

8. On the Start menu, click Run. In the 
Open field, type WorkSpace 
/unregserver.

9. Click OK.

10. Restart the Proficy iFIX WorkSpace.

Folder definitions include the attributes in the following table.
<table>
<thead>
<tr>
<th>The attribute...</th>
<th>Defines...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>The names of the files that appear directly off the system tree root. By adding a new name, you add a new file to the system tree. If you want the file to appear inside a folder, enter the complete path. For example, to add a globals file called OEMGlobals to the Globals folder you would enter: Globals\OEMGlobals</td>
</tr>
<tr>
<td>Files</td>
<td>Each entry as a file and always has the value FILE.</td>
</tr>
<tr>
<td>AppKey</td>
<td>An entry that is reserved for future use and can be left blank.</td>
</tr>
<tr>
<td>The attribute…</td>
<td>Defines…</td>
</tr>
<tr>
<td>----------------</td>
<td>----------</td>
</tr>
<tr>
<td>Vendor of File</td>
<td>A company name. When you add a file, enter the name of your company. Completing this attribute is optional.</td>
</tr>
<tr>
<td>Path of this File</td>
<td>The complete path to each file. This must be a FIX path and the file name. If the file resides in an iFIX path, you can specify the path with a predefined alias, such as PDB_PATH or BASE_PATH. For example, if you are adding a globals file, enter PIC_PATH since all global files reside in the iFIX Picture path.</td>
</tr>
<tr>
<td>The attribute...</td>
<td>Defines...</td>
</tr>
<tr>
<td>------------------</td>
<td>------------</td>
</tr>
<tr>
<td>Used to determine if this file should be opened on startup by the WorkSpace</td>
<td>Whether the Proficy iFIX WorkSpace automatically opens the file on start-up. This attribute is set to TRUE for globals files only. Typically, this attribute is set to FALSE.</td>
</tr>
<tr>
<td>Hidden In Tree Entry</td>
<td>Whether the file is visible or hidden in the system tree. In general, you only want to set this attribute to TRUE for any non-modifiable globals file you add to the system tree. Typically, this attribute is set to FALSE.</td>
</tr>
<tr>
<td>The attribute...</td>
<td>Defines...</td>
</tr>
<tr>
<td>-----------------</td>
<td>------------</td>
</tr>
<tr>
<td>Not In Collection Entry</td>
<td>Whether the file should be included in a collection. A <em>collection</em> is one or more open ActiveX documents. Typically, you want to include all files except non-modifiable (system) globals files in collections. Consequently, you enter TRUE for system globals files and FALSE for any other file. Typically, this attribute is set to FALSE.</td>
</tr>
<tr>
<td>Disable Close Entry</td>
<td>Whether the Close command on the file's right mouse menu is grayed out or enabled. Entering TRUE grays out the command; entering FALSE or leaving it undefined enables the command. Typically, this attribute is set to FALSE.</td>
</tr>
<tr>
<td>The attribute...</td>
<td>Defines...</td>
</tr>
<tr>
<td>------------------</td>
<td>------------</td>
</tr>
<tr>
<td>Disable Show Entry</td>
<td>Whether the Show command on the file's right mouse menu is grayed out or enabled. Entering TRUE grays out the command; entering FALSE or leaving it undefined enables the command. Typically, this attribute is set to FALSE.</td>
</tr>
<tr>
<td>Disable Save Entry</td>
<td>Whether the Save command on the file's right mouse menu is grayed out or enabled. Entering TRUE grays out the command; entering FALSE or leaving it undefined enables the command. Typically, this attribute is set to FALSE.</td>
</tr>
<tr>
<td>The attribute...</td>
<td>Defines...</td>
</tr>
<tr>
<td>------------------</td>
<td>------------</td>
</tr>
<tr>
<td>Type of file we are creating</td>
<td>Whether the file is a globals file. If it is not a globals file, enter DEFAULT. If it is, enter USER for user-defined globals files or SYSTEM for non-modifiable globals files. Typically, you supply system globals to prevent these value from being changed.</td>
</tr>
<tr>
<td>ProgID of this file</td>
<td>The program identification for your system and user globals files. This attribute is left blank or set to FIXGLOBALSSSERVER.FIXG LOBALSSSERVER.1</td>
</tr>
<tr>
<td>The attribute...</td>
<td>Defines...</td>
</tr>
<tr>
<td>------------------</td>
<td>------------</td>
</tr>
<tr>
<td>Determines if this file can be renamed and deleted</td>
<td>Whether the Rename and Delete commands on the file's right mouse menu is grayed out or enabled. Entering TRUE grays out the command; entering FALSE or leaving it undefined enables the command. This attribute is set according to user preference.</td>
</tr>
</tbody>
</table>

### Deleting Folders and Files from the System Tree

You can delete folders and files from the system tree by editing the SystemTree.CSV file.
To delete a folder or file from the system tree:

1. Open the SystemTree.CSV file located in the Local path.

2. Delete the row with the file or folder information you want to remove from the system tree.

3. Save the file in the Local path with a .CSV extension.

4. Close the Proficy iFIX WorkSpace.

5. On the Windows menu, click Run. In the Open field, type WorkSpace/unregserver.

6. Click OK.

7. Restart the Proficy iFIX WorkSpace.
Validating an Application

The Application Validator is a utility you use to verify the versions of an application's files, and to ensure that the files associated with the application have not changed. You can run the Application Validator with or without iFIX running.

To use the Application Validator, you first specify the Windows folders that you want to work with. After you specify the folders, you take an initial "snapshot" of the content. This "snapshot" is called a baseline. You can later compare this baseline snapshot to the same folder(s) at another date, or on a regular basis, to see if the contents of each folder have changed.

You will find the Application Validator utility most helpful, for instance, when you finish configuring your iFIX system. Once you configure iFIX, you can create a baseline of the iFIX folders and other ones associated with your process. You can monitor which files were changed since you created the baseline.
So, if you ever run into problems, or want to go back to an original configuration, you can determine which files were changed or added, and you can manually rollback to that configuration. You can view these changes, as a summary or detailed report, in online or printed format.

---

**Application Validator Basics**

There is certain basic information you should know before using the Application Validator. This section contains information on the following:

- Running the Application Validator
- Running With or Without iFIX
- Running in Demo Mode
- General Configuration for the Application Validator
- Working with Default Settings
- Using the Application Validator Toolbar and Quick Keys
Running the Application Validator

You can run the Application Validator from the Proficy iFIX WorkSpace, the Windows Explorer, or the command line. Refer to the following table for more information.

<table>
<thead>
<tr>
<th>Running the Application Validator</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>If you want to start the Application Validator from the...</strong></td>
</tr>
<tr>
<td>iFIX WorkSpace</td>
</tr>
<tr>
<td>Windows Explorer</td>
</tr>
</tbody>
</table>
Command Line | From the DOS prompt type the AppValidator command with the desired command line options. 
Refer to the Command Line Options for the Application Validator section for a full description of these options.

---

**Running With or Without iFIX**

You can use the Application Validator with or without iFIX. If you require that iFIX be running, open the AppValConfig.ini file in the folder where you installed iFIX and specify Yes for the RunningIFixIsRequired key in this file. If you require that iFIX is running, you can also specify whether iFIX Security is required by setting the EnabledSecurityIsRequired key to Yes in the AppValConfig.ini file.
For example, an AppValConfig.ini file with both options enabled appears as follows:

```
[Security]
RunningIFixIsRequired=Yes
EnabledSecurityIsRequired=Yes
```

If you use iFIX Security, you can modify your iFIX groups to allow the users in the designated groups to create baselines and/or have runtime access to the Application Validator. The iFIX application features name for these privileges are as follows:

- Application Validator - Creation of Baselines
- Application Validator - Run-time Access

For more information on iFIX security setup, refer to the Defining and Assigning Security Privileges in the Implementing Security manual.
Running in Demo Mode

When running the Application Validator in Demo mode (when iFIX starts with the Sample System), you can only work with the iFIX Sample System subdirectory. Demo mode in the Application Validator restricts how you:

- Select directories
- Load application settings
- Save application settings
- Save Detail Reports

If you do not have an iFIX software license, you can only use the Application Validator when iFIX runs in Demo mode. The command line mode for the Application Validator is not available while iFIX is in Demo mode.
General Configuration for the Application Validator

To change the default options for the Application Validator, select Options from the Tools menu to open the Options dialog box. From this dialog box you can:

- Identify specific files or file types to exclude from the comparison.
- Define an application to run if differences are found when running the Application Validator from the command line.
- Specify an automatic report naming convention when running the Application Validator from the command line.
Working with Default Settings

Every time you shutdown the Application Validator, it updates the Default.avs file. The .AVS (Application Validator Settings) file contains the settings that you define in the Application Validator Options dialog box and includes a list of the folders to display in the main window. Each time you restart the Application Validator, it displays the settings from when you last used the Application Validator.

You later can define your own settings, save them in another file, and load them when you want to run specific reports. You could also use these custom .AVS files when running the Application Validator from the command line.
Using the Application Validator Toolbar and Quick Keys

All of the commands found on the menu bar have corresponding toolbar buttons. For each action that you can perform from the toolbar and menu bar, there are also quick keys that you can enter from the keyboard. The following table summarizes the functions of the toolbar buttons and key combinations that you can use.

<table>
<thead>
<tr>
<th>Application Validator Toolbar Buttons</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use this...</td>
</tr>
<tr>
<td><img src="image.png" alt="Select directories" /></td>
</tr>
<tr>
<td><img src="image.png" alt="Load predefined settings" /></td>
</tr>
<tr>
<td><img src="image.png" alt="Open the Save As dialog box to save settings" /></td>
</tr>
<tr>
<td>Use this...</td>
</tr>
<tr>
<td>------------</td>
</tr>
<tr>
<td><img src="48x306.png" alt="Image" /></td>
</tr>
<tr>
<td><img src="48x262.png" alt="Image" /></td>
</tr>
<tr>
<td><img src="48x218.png" alt="Image" /></td>
</tr>
<tr>
<td><img src="48x174.png" alt="Image" /></td>
</tr>
<tr>
<td><img src="48x118.png" alt="Image" /></td>
</tr>
<tr>
<td><img src="48x61.png" alt="Image" /></td>
</tr>
<tr>
<td>Application Validator Toolbar Buttons</td>
</tr>
<tr>
<td>--------------------------------------</td>
</tr>
<tr>
<td><strong>Use this...</strong></td>
</tr>
<tr>
<td>![Graph icon]</td>
</tr>
<tr>
<td>![Report icon]</td>
</tr>
<tr>
<td>![Options icon]</td>
</tr>
<tr>
<td>![Log icon]</td>
</tr>
<tr>
<td>![Information icon]</td>
</tr>
<tr>
<td>Use this...</td>
</tr>
<tr>
<td>----------------</td>
</tr>
<tr>
<td>Ctrl+A</td>
</tr>
<tr>
<td>Ctrl+B</td>
</tr>
<tr>
<td>Ctrl+D</td>
</tr>
<tr>
<td>Ctrl+G</td>
</tr>
<tr>
<td>Use this...</td>
</tr>
<tr>
<td>------------</td>
</tr>
<tr>
<td>Ctrl+L</td>
</tr>
<tr>
<td>Ctrl+M</td>
</tr>
<tr>
<td>Ctrl+O</td>
</tr>
<tr>
<td>Ctrl+P</td>
</tr>
<tr>
<td>Ctrl+S</td>
</tr>
</tbody>
</table>
### Application Validator Toolbar Buttons

<table>
<thead>
<tr>
<th>Use this...</th>
<th>To...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl+T</td>
<td>Generate a detailed summary report. This information appears in another window.</td>
</tr>
<tr>
<td>Ctrl+U</td>
<td>Clear the check boxes for all folders selected in the main window.</td>
</tr>
</tbody>
</table>

### Types of Reports from the Application Validator

There are two types of reports that you can run from the Application Validator:

- Summary Report
- Comparison Detail Report

You can view both these reports in online or printed format.
Summary Report

When you run a Summary Report, it displays in the main window of the Application Validator. A status for each folder appears in the third column of the main window, indicating if differences were found or if the files in the folder were identical to the original baseline. For instance, the Compare Status field for the folder could be identified as Identical, Differences Found, or Missing a Baseline.

The following figure shows an example of a Summary Report as it appears in the main window of the Application Validator. Notice the Compare Status column of the far right of the window that includes the Summary Report information.
Comparison Detail Report

When you run a Comparison Detail Report, it displays in a new window. A Comparison Detail Report describes whether a file in any folder was modified, added, removed, or unchanged. Unlike the Summary Report that details the changes in complete folders, the Comparison Detail Report describes the changes for individual files.
The following figure shows an example of a Comparison Detail Report. Notice the Status column (the second column from the left) that displays whether the file is Identical, Different, Added to Current (New), or Deleted from the Current folder.

<table>
<thead>
<tr>
<th>File Path</th>
<th>Status</th>
<th>Baseline Size</th>
<th>Current Size</th>
<th>Baseline Modified Date</th>
<th>Current Modified Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>C:\Program Files\PolyGrade\FX\AppValidator.log</td>
<td>Added To Current</td>
<td>N/A</td>
<td>1117</td>
<td>N/A</td>
<td>9/23/2005 7:51:18 PM</td>
</tr>
<tr>
<td>C:\Program Files\PolyGrade\FX\Media</td>
<td>Different</td>
<td>33721</td>
<td>33721</td>
<td>9/23/2005 8:17:15 PM</td>
<td>9/23/2005 8:15:01 PM</td>
</tr>
<tr>
<td>C:\Program Files\PolyGrade\FX\Media\App\CustomUserDir</td>
<td>Different</td>
<td>5005</td>
<td>5190</td>
<td>9/23/2005 7:12:33 PM</td>
<td>9/23/2005 8:15:02 PM</td>
</tr>
<tr>
<td>C:\Program Files\PolyGrade\FX\Media\Config Files Backup</td>
<td>Different</td>
<td>14298</td>
<td>142036</td>
<td>5/23/2005 8:17:15 PM</td>
<td>9/23/2005 8:15:01 PM</td>
</tr>
<tr>
<td>C:\Program Files\PolyGrade\FX\Media\HTR</td>
<td>Different</td>
<td>68884</td>
<td>88684</td>
<td>5/23/2005 8:17:15 PM</td>
<td>9/23/2005 8:15:01 PM</td>
</tr>
<tr>
<td>C:\Program Files\PolyGrade\FX\Media\HTR\DATA</td>
<td>Different</td>
<td>677</td>
<td>815</td>
<td>5/23/2005 7:12:42 PM</td>
<td>9/23/2005 8:15:02 PM</td>
</tr>
<tr>
<td>C:\Program Files\PolyGrade\FX\Media\HTR\DATA\SCADA01</td>
<td>Different</td>
<td>9728</td>
<td>8704</td>
<td>9/23/2005 7:18:30 PM</td>
<td>9/23/2005 8:15:00 PM</td>
</tr>
<tr>
<td>C:\Program Files\PolyGrade\FX\PLEX3D</td>
<td>Different</td>
<td>3200</td>
<td>3200</td>
<td>9/23/2005 7:18:30 PM</td>
<td>9/23/2005 8:15:00 PM</td>
</tr>
<tr>
<td>C:\Program Files\PolyGrade\FX\PLEX3D\AppData</td>
<td>Different</td>
<td>4000</td>
<td>4000</td>
<td>9/23/2005 7:18:30 PM</td>
<td>9/23/2005 8:15:00 PM</td>
</tr>
</tbody>
</table>

**Example of Comparison Detail Report Window**
Viewing Only the Files that Changed

In the Comparison Detail Report, you can reduce the number of files included in the list by ignoring identical files. If you want to view only the files that changed, select the Differences Only option from the View menu in the Comparison Detail Report window.

Saving the Comparison Detail Report

In addition, you can save the Comparison Detail Report to a .CSV or .TXT file. Select Save from the File menu in the main window to open the Save dialog box, from which you can select a comma-delimited format (.CSV) or text format (.TXT) from the drop-down list.

General Overview of Steps for Using the Application Validator

Once you understand and configure the Application Validator Basics, you can begin to use Application Validator with your application. The steps are generally the same for each application.
To use the Application Validator:

1. Select the folders you want to work with.

2. Generate a baseline for the selected directory or directories.

   **NOTE:** The Application Validator cannot create a baseline for files that are open with exclusive rights. For instance, if you attempt to create a baseline of the root drive C:/, where the Pagefile.sys is open with exclusive rights from the operating system, the baseline will fail. The operating system has full control over that file, and no one else, not even the administrator nor the user creating the baseline, has rights to open it.

3. At a later time when you want to validate the files, run a report:
   - Summary Report.
   - Comparison Detail Report.
Command Line Options for the Application Validator

The syntax for the Application Validator command line is as follows:

```
AppValidator
    /ConfigFile:"C:\FullPath\Settings.avs"
    | /Directory:"single directory name"
    [/CreateBaseline | /CB]
    [/OverWrite]
    [/PrintSingleBaseline | /PSB]
    [/PrintComparisonSummary | /PCS]
    [/PrintComparisonDetail | /PCD]
    [/SaveComparisonDetail:"Full path of output file"]
    | /SCD:"Full path of output file"]
    [/CSV]
    [/DifferencesOnly | /DO]
    [/? | /Help]
```
Notes on the Syntax

- The brackets ( [ ] ) indicate that a parameter is optional. The brackets are not part of a command; if a bracketed option is desired, only type the text that is inside the brackets, and not the brackets themselves.

- The pipe bar ( | ) indicates separate items in a group that you can choose from. For instance you can use the /CreateBaseline or the /CB argument with the AppValidator command, and, in this case, both perform the same task.

- Italics are used to represent the information that the user must supply to run the command. The information in italics is not typed exactly as it appears. Instead, the user enters the information specific to the italicized expression.
The following table outlines the optional arguments. If an abbreviation is available, that is listed instead of the full argument name. For instance, the /CB argument is listed instead of the /CreateBaseline argument, but either could be used.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>/CB</td>
<td>Creates baseline files for the specified directories and folders.</td>
</tr>
<tr>
<td>/OverWrite</td>
<td>Overwrites any existing baseline files. (Used with the /CB argument only.)</td>
</tr>
<tr>
<td>/PSB</td>
<td>Prints the existing baseline for the specified folder.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>/PCS</td>
<td>Prints the Summary Report for the specified folders.</td>
</tr>
<tr>
<td>/PCD</td>
<td>Prints the Comparison Detail Report for the specified folders.</td>
</tr>
<tr>
<td>/SCD:&quot;Full Path Output File&quot;</td>
<td>Saves a copy of the Comparison Detail Report for the specified folders. If you do not use the /CSV argument, the file is saved as a .TXT file.</td>
</tr>
<tr>
<td>/CSV</td>
<td>Specifies that the Comparison Detail Report be saved in Comma Separated Value (CSV) format. (Used with the /SCD option only.)</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td>/DO</td>
<td>Specifies that you only want to display the files with changes in the Comparison Detail Report. (Used with the /SCD option only.)</td>
</tr>
<tr>
<td>/?</td>
<td>Displays the Help for the command line options.</td>
</tr>
</tbody>
</table>
Command Line Options You Can Define in the GUI

In addition to the options that you can specify on the command line, some options must be set from within the Application Validator user interface (non-command line version). These options include:

- Using an automatic report naming convention when running the Application Validator from the command line.

- Define an application to run if differences are found when running the Application Validator from the command line.

Command Line Errors

You may encounter errors caused when an invalid command line parameter is passed to the Application Validator. Errors are logged to the AppValidator.log file in the iFIX folder.
Understanding Auditing for the Application Validator

You can configure the Application Validator to audit all user actions. Once configured, each time you perform an action, such as create a baseline, run a baseline summary report, or run a comparison report, an audit message is sent to the iFIX alarm system. This message is then recorded as part of the standard iFIX audit trail.

To enable audited actions in the Application Validator:

1. Open the AppValConfig.ini file and enable both options in this .ini file by entering Yes for both settings:

   RunningIFixIsRequired=Yes

   EnabledSecurityIsRequired=Yes

2. Enable the Alarm ODBC Service and configure your relational database to store the audit messages in the ODBC alarm table.
For more information on the AppValConfig.ini, refer to the Understanding the AppValConfig.ini File and Auditing section in this chapter. For more information on enabling and configuring the Alarm ODBC Service, refer to Configuring the Alarm ODBC Service section in the Implementing Alarms and Messages manual.

Understanding the AppValConfig.ini File and Auditing

The AppValConfig.ini file specifies whether iFIX must be running in order to start the Application Validator and if iFIX security applies. This file is located in the iFIX folder (the folder where you installed iFIX). Both options must be enabled if you want to audit user actions in the Application Validator. With both options enabled, the Application Validator user and node can be tracked in the standard iFIX audit trail.
To configure the AppValConfig.ini file for auditing purposes:

1. Open the AppValConfig.ini in Notepad or another text editor.

2. Make that both settings in this file are set to Yes:

   [Security]

   RunningIFixIsRequired=Yes

   EnabledSecurityIsRequired=Yes

   **NOTE:** If you set
   EnabledSecurityIsRequired to Yes, then
   the Application Validator only runs
   when Security is Enabled within iFIX. If
   you set EnabledSecurityIsRequired to
   No, then iFIX Security does not have to
   be enabled in order to run the
   Application Validator.

3. Save the file into the iFIX folder (the same location where you installed iFIX).

4. Restart the Application Validator.
Viewing the Audited Messages

Use your database tools or VisiconX to view the iFIX audit trail. For information on Microsoft SQL Server or Oracle database tools, refer to your manufacturer's documentation. For more information on VisiconX, refer to the Using VisiconX manual. For information on using Crystal Reports, a third-party reporting application that supports ODBC queries, refer to the Reporting section in this manual.

iFIX alarm destinations such as the Alarm File and Alarm Printer also get these audit messages. For information on configuring these alarm locations, refer to the Configuring Alarms chapter in the Implementing Alarms and Messages manual.

**NOTE:** The Alarm History window only displays the most recent 500 messages; it is not a complete list of messages, and therefore, not an audit trail.
Sample Audit Message from the Application Validator

The following figure displays a sample of the audit message sent to the iFIX alarm system. Notice that the timestamp, iFIX node name, node name where the user was logged in, plus the name of iFIX operator who performed the action are all included with the audit message.

Format of Audit Message Sent to iFIX Alarm System
List of Audit Messages from the Application Validator

The following list describes the audit messages associated with the Application Validator. These messages describe the events that can occur (to the operator) when running the Application Validator:

- Application Validator – Baseline File has been tampered with!
- Application Validator – Command-line: Create Baseline
- Application Validator – Command-line: Print Comparison Detail
- Application Validator – Command-line: Print Comparison Summary
- Application Validator – Command-line: Print Single Baseline
- Application Validator – Command-line: Save Comparison Detail
- Application Validator – Create Baseline
- Application Validator – Error retrieving security user
• Application Validator – Error with Compare Directory: %s

• Application Validator – Error with Fill Baseline Detail: Checksum difference for baseline file: [%s]. %s

• Application Validator – Error with Fill Baseline Detail: Failed to read encrypted baseline file: [%s]. %s

• Application Validator – Failed to start Application: %s

• Application Validator – iFIX isn't running

• Application Validator – Insufficient Security Rights

• Application Validator – Invalid Security Feature

• Application Validator – Print Baseline Status/Comparison Summary

• Application Validator – Report Comparison Detail

• Application Validator – Report Comparison Summary

• Application Validator – Report Printed
- Application Validator – Report Saved
- Application Validator – Report Single Baseline
- Application Validator – Security not enabled
- Application Validator – User not logged in

**NOTE:** The %s in these messages is replaced with the actual directory name when the message appears.

---

**Activity Log in the Main Window**

The activity log displays informational messages on the actions performed in the Application Validator since you enabled logging. This log displays the most recent actions first in the list, at the top of the window. By scrolling down, you can review previous actions.

The activity log may be helpful when trying to diagnose problems using the Application Validator.
NOTE: The activity log is not saved when you stop the Application Validator or shut it down.

The following figure shows an example of the Application Validator main window with the Log window displayed.
Best Practices

Some best practices to keep in mind when using the Application Validator include the following:

- Specify that iFIX be running in order to start the Application Validator and that iFIX security be enabled in the AppValConfig.ini file, if you want to use auditing.

- If using iFIX security, limit the creation of baselines to a specified set of users. For each designated user in the Security Configuration tool, select the Application Validator - Creation of Baselines feature from the Application Feature Selection dialog box.

**NOTE:** Depending upon your security requirements, you probably can allow run-time access to the Application Validator (Application Validator - Run-time Access feature) more liberally.
For more information on iFIX security setup, refer to the Defining and Assigning Security Privileges in the Implementing Security manual.

---

**Application Validator Dialog Boxes**

The Application Validator includes the following dialog boxes:

- Application Validator Options Dialog Box
- Select Directories Dialog Box
Application Validator Options Dialog Box

The Application Validator Options Dialog Box consists of three tabs:

Exclusion List Tab

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exclusion List</td>
<td>Displays the files excluded when you compare the folders with the baseline.</td>
</tr>
</tbody>
</table>
| Excluded File Filter | Enter the file or file name mask that you want to exclude from the folder comparison. Click Add to add it to the file exclusion list.

For file name masks, you can use standard Windows wildcard characters. For instance, use the * symbol to represent multiple unknown characters in a file name. Use the ? symbol for a single unknown character in a file name.

For example, if you did not want to compare log files versions you would add *.log to the file exclusion list. |
| Exclusion List Text Box | Enter the file or file name mask that you want to exclude from the folder comparison. Click Add to add it to the file exclusion list.

For file name masks, you can use standard Windows wildcard characters. For instance, use the * symbol to represent multiple unknown characters in a file name. Use the ? symbol for a single unknown character in a file name.

For example, if you did not want to compare log files versions you would add *.log to the file exclusion list |
<p>| Add | Click to add the file or file name mask, entered in the field above, to the file exclusion list. |</p>
<table>
<thead>
<tr>
<th><strong>Remove</strong></th>
<th>Click to delete the selected file or file mask from the file exclusion list.</th>
</tr>
</thead>
</table>

**Application Execution Tab**

<table>
<thead>
<tr>
<th><strong>Field Name</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Application Execution</td>
<td>Select this check box if you want to run an executable file when differences are found between the baseline and the current folder versions, when running the Application Validator from the command line.</td>
</tr>
<tr>
<td>Application</td>
<td>Enter the name and location of the file that you want to run (when the Application Validator runs from the command line) and finds differences.</td>
</tr>
<tr>
<td><strong>Field Name</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>---------------</td>
<td>----------------</td>
</tr>
<tr>
<td>Browse</td>
<td>Click to browse for a file.</td>
</tr>
</tbody>
</table>

**Auto Report Naming Tab**

<table>
<thead>
<tr>
<th><strong>Field Name</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Auto Report Naming</td>
<td>Select this check box if you want to use a predefined name for all reports generated from the command line with the Application Validator.</td>
</tr>
<tr>
<td>Report Name</td>
<td>Enter the name for the auto-generated report file. If you select the Auto Increment option, a number is added to the end of this name each time a new report is run from the command line.</td>
</tr>
<tr>
<td>Directory</td>
<td>Enter the name and location of the folder to which you want to save the detailed summary reports generated when you run the Application Validator from the command line.</td>
</tr>
<tr>
<td>-----------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Browse (...)</td>
<td>Click to browse for a folder to which you want to save the report.</td>
</tr>
<tr>
<td>Prefix</td>
<td>Enter the name for the auto-generated report file. If you select the Auto Increment option, a number is added to the end of this name each time a new report is run from the command line.</td>
</tr>
</tbody>
</table>
Select Directories Dialog Box

The Select Directories dialog box displays the following items:

Folder List Box

Select the folders for which you want to create baselines. You can select up to 500 folders. Later, you can check for changes in these folders since you last created this baseline.

Selecting a top level folder selects all the folders included beneath this folder. Likewise, the same is true for deselecting folders. You can select any number of folders, as long as you do not exceed the 500 limit.

NOTE: The Application Validator does not
handle directories named with characters outside of the ASCII character set.

---

**How Do I...**

Refer to one of the following sections for steps on how to use the Application Validator:

- Configuring Settings
- Creating Baselines
- Working with Reports
- Working with the Command Line
- Working with iFIX

**Configuring Settings**

Use the following sections to configure settings in the Application Validator:

- Changing the Application Options
- Selecting Folders
- Selecting or Deselecting All Folders in the Main Window
Changing the Application Options

To change the options for the Application Validator:

1. In the iFIX WorkSpace, double-click Application Validator in the system tree. The Application Validator opens.

2. On the Tools menu, click Options. The Application Validator Options dialog box appears.

3. From the Exclusion List tab, enter the files that you want to exclude from the comparison. For each entry:
   a. In the edit box, enter the file name or file mask. For file name masks, you can use standard Windows wildcard characters. For instance, use the * symbol to represent multiple unknown characters in a file name. Use the ?
symbol for a single unknown character in a file name.

b. Click Add to add the file or file name mask to the file exclusion list.

c. For example, if you do not want to include log files in your comparison, you would add *.log to the file exclusion list.

**NOTE:** Do not include the path information with the file name. For example, c:＼*.log is not a valid entry in the exclusion list.

4. Select the Application Execution tab. To define an application to run if differences are found when running the Application Validator from the command line:

a. Select the Enable Application Execution check box.

b. In the Application edit box, enter the location and name
of the file. Optionally, click the Browse (…) button to search for a file.

5. Select the Auto Report Naming tab. To use an automatic report naming convention when running the Application Validator from the command line:

   a. Select the Enable Auto Report Naming check box.

   b. In the Directory field, enter the location where you want to save the automatically created report. Optionally, click the Browse (…) button to locate and select a folder.

   b. In the Prefix field, enter the name you want to use for the report file. If you select the Auto Increment option, a number is added to the end of this name each time a new report is run from the command line.
c. If you want to individually number each report file, instead of overwriting the original file each time you run a new report, select the Auto Increment check box.

6. Click OK.

Selecting Folders

To select the directories and folders to use in the Application Validator:

1. In the iFIX WorkSpace, double-click Application Validator in the system tree. The Application Validator opens.

2. On the File menu, click Select Directories. The Select Directories dialog box appears.

3. Select the directories and folders for which you want to create baseline files.
You can select up to 500 directories and folders. Selecting a top level folder also selects all the folders included beneath this folder. Likewise, the same is true for deselecting folders. You can select any number of folders, as long as you don’t exceed the 500 limit.

**NOTE:** The Application Validator does not handle directories named with characters outside of the ASCII character set.

Later, you can compare the changes in these folders since you last created this baseline.

4. Click OK.

**Selecting or Deselecting All Folders in the Main Window**

To select all folders in the main window:

1. In the iFIX WorkSpace, double-click Application Validator in the system tree. The Application Validator opens.
2. On the Edit menu, click Select All.
To deselect all folders in the main window:

1. From WorkSpace, click Application Validator from the file tree. The Application Validator opens.
2. On the Edit menu, click Unselect All.

Saving Settings

To save settings:

1. In Application Validator, on the File menu, click Save Settings. The Save As dialog box appears.
2. Enter a file name.
3. Click Save. The Application Validator saves the settings for the folders that display in the main window, along with the options you selected from the Application Validator Options dialog box.
Loading Predefined Settings

To load predefined settings:

1. In the iFIX WorkSpace, double-click Application Validator in the system tree. The Application Validator opens.
2. On the File menu, click Load Settings. The Open dialog box appears.
3. Select the .AVS file (containing the settings to use for the Application Validator Options dialog box and the number of folders displayed in the Application Validator main window).
4. Click Open. The Application Validator loads the settings.

Creating Baselines

Use the following sections to create baselines in the Application Validator:

- Generating Baseline Files
- Generating a Baseline for a Single Folder
Generating Baseline Files

To generate a baseline file for each folder selected in the main window:

1. In the iFIX WorkSpace, double-click Application Validator in the system tree. The Application Validator opens.

2. Make sure that you select the check box of each folder for which you want to create a baseline file. If you want to select all folders, on the Edit menu, click Select All.

3. On the Create menu, click Baseline. If no baseline files exist, the Application Validator begins creating baseline files. If you previously created baselines for any of the selected folders, a message box appears.

4. If a message box appears, click Yes to All to continue with the creation of baseline files. The new baseline overrides the previous version.
**NOTE:** Click the Cancel button in the bottom right corner of the screen if you want to stop the creation of baseline files. The baseline files creation stops after the Application Validator creates the baseline for the current row. The row number currently being processed is displayed in the status bar at the bottom left corner of the application.

### Generating Baseline for a Single Folder

To generate a single baseline file:

1. In the iFIX WorkSpace, double-click Application Validator in the system tree. The Application Validator opens.

2. Make sure that you selected the check box for only one folder in the main window.

   If you want to unselect all folders, on the Edit menu, click Unselect All. Select the folder for which you want to create the baseline.

After a few moments, a Baseline Detail Report window appears with a listing of the files from the specified folder that changed and those that did not.

**Working with Reports**

If you want to create reports in the Application Validator, refer to the following sections for more information:

- Excluding Specific Files From a Comparison Report
- Generating a Summary Report
- Generating a Comparison Detail Report
- Viewing Changes Only in the Comparison Detail Report
- Saving the Comparison Detail Report to a .CSV or .TXT File
- Printing the Comparison Detail Report
- Printing Columns Displayed in the Main Window
Excluding Specific Files from the Comparison Report

To exclude specific files from the comparison report:

1. In the iFIX WorkSpace, double-click Application Validator in the system tree. The Application Validator opens.

2. On the Tools menu, click Options. The Application Validator Options dialog box appears.

3. From the Exclusion List tab, enter the files that you want to exclude from the comparison. For each entry:
   a. In the edit box, enter the file or file name mask. For file name masks, you can use standard Windows wildcard characters. For instance, use the * symbol to represent multiple unknown characters in a file name. Use the ? symbol for a single unknown character in a file name.
b. Click Add to add the file to the file exclusion list.

For example, if you do not want to include log files in your comparison, you would add *.log to the file exclusion list.

**NOTE:** Do not include the path information with the file name. For example, c:\*.log is not a valid entry in the exclusion list.

4. Click OK.
Generating a Summary Report

To generate a Summary Report (in the main window):

1. In the iFIX WorkSpace, double-click Application Validator in the system tree. The Application Validator opens.

2. Make sure that you select the check box of each folder for which you want to check for changes.

   If you want to select all folders, on the Edit menu, click Select All.

3. On the Report menu, point to Comparison and then click Summary.

   After a few moments, a status for each folder appears in the third column of the main window, indicating if differences were found or if the files in the folder were identical to the original baseline.
Generating a Comparison Detail Report

To generate a Comparison Detail Report (in another window):

1. In the iFIX WorkSpace, double-click Application Validator in the system tree. The Application Validator opens.

2. Make sure that you select the check box of each folder you want to include in the Comparison Detail Report.

   If you want to select all folders, on the Edit menu, click Select All.

3. On the Report menu, point to Comparison, and then click Detail.

   After a few moments, a Comparison Detail Report window appears with the results.

4. Use the scroll bar to examine the list of specific files in each folder that changed.

   If you want to view a list of only changed files, on the View menu, click Differences Only.
Viewing Changes Only in the Comparison Detail Report

To view only the files that changed in the Comparison Detail Report:

1. In the iFIX WorkSpace, double-click Application Validator in the system tree. The Application Validator opens.

2. Select the Report menu item and choose Comparison. Select the Detail sub menu item. The Application Validator – Comparison Detail Report window opens.

3. In the Application Validator – Comparison Detail Report window, on the View menu, click Differences Only.

4. Watch as the rows in the report repopulate with only the changed files displaying in the list.
The next time you run a Comparison Detail Report and want to view only the changed files, you need to select the Differences Only option again. The Differences Only option only applies to the current session.

**NOTE:** To redisplay the full list of files in the Comparison Detail Report, on the view menu, click the Differences Only option again.
Saving the Comparison Detail Report to a .CSV or .TXT File

To save a Comparison Detail Report to a .CSV or .TXT file:

1. In the Application Validator window, select the folders you want to compare and generate a Comparison Detail Report.

2. In the Application Validator – Comparison Detail Report window, on the File menu, click Save. The Save As dialog box appears.

3. Browse to the folder to which you want to save the file.

4. In the File name field, enter a name.

5. From the Save as type drop-down list, select CSV Files or TXT Files.

6. Click Save.
Printing the Comparison Detail Report

To print the Comparison Detail Report:

1. In the Application Validator window, select the folders you want to compare and generate a Comparison Detail Report.

2. Select the Detail sub menu item. The Application Validator – Comparison Detail Report window opens.

3. In the Application Validator – Comparison Detail Report window, on the File menu, click Print. The Print dialog box appears.

4. Select a printer from the Name drop-down list, and click OK.
Printing Columns Displayed in the Main Window

To print the columns displayed in the main window:

1. In the iFIX WorkSpace, double-click Application Validator in the system tree. The Application Validator opens.
2. On the File menu, click Print. The Print dialog box appears.
3. Select a printer from the Name dropdown list, and click OK.

Working with the Command Line

If you want to use the Application Validator's command line options, the following sections provide detailed information:

- Overview of the Command Line Options
- Viewing the Command Line Help
- Defining an Application to Run if Differences are Found
• Using an Automatic Report Naming Convention

Overview of the Command Line Options

The syntax for the Application Validator command line option is as follows:

```
AppValidator
/ConfigFile:"C:\FullPath\ApplicationSettings.avs" |
/Directory:"single directory"
[/CreateBaseline | /CB]
[/OverWrite]
[/PrintSingleBaseline | /PSB]
[/PrintComparisonSummary | /PCS]
[/PrintComparisonDetail | /PCD]
[/SaveComparisonDetail:"Full path of output file" | /SCD:
"Full path of output file"]
[/CSV] [/DifferencesOnly | /DO]
[/? | /Help]
```

**NOTES:**
• The brackets ([ ]) indicate that a parameter is optional. The brackets are not part of a command; if a bracketed option is desired, only type the text that is inside the brackets, and not the brackets themselves.

• The pipe bar ( | ) indicates separate items in a group that you can choose from. For instance you can use the /CreateBaseline or the /CB argument with the AppValidator command, and, in this case, both perform the same task.

• Italicics are used to represent the information that the user must supply to run the command. The information in italics is not typed exactly as it appears. Instead, the user enters the information specific to the italicized expression.

Descriptions of Optional Arguments

The following table outlines the optional arguments. If an abbreviation is available, that is listed instead of the full argument name. For instance, the /CB argument is listed instead of the /CreateBaseline argument, but either could be used.
<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>/CB</td>
<td>Creates baseline files for the specified directories and folders.</td>
</tr>
<tr>
<td>/OverWrite</td>
<td>Overwrites any existing baseline files. (Used with the /CB argument only.)</td>
</tr>
<tr>
<td>/PSB</td>
<td>Prints the existing baseline for the specified folder.</td>
</tr>
<tr>
<td>/PCS</td>
<td>Prints the Summary Report for the specified folders.</td>
</tr>
<tr>
<td>/PCD</td>
<td>Prints the Comparison Detail Report for the specified folders.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>/SCD</td>
<td>&quot;Full Path Output File&quot; Saves a copy of the Comparison Detail Report for the specified folders. If you do not use the /CSV argument, the file is saved as a .TXT file.</td>
</tr>
<tr>
<td>/CSV</td>
<td>Specifies that the Comparison Detail Report be saved in Comma Separated Value (CSV) format. (Used with the /SCD option only.)</td>
</tr>
<tr>
<td>/DO</td>
<td>Specifies that you only want to display the files with changes in the Comparison Detail Report. (Used with the /SCD option only.)</td>
</tr>
<tr>
<td>/?</td>
<td>Opens the Help for the command line options.</td>
</tr>
</tbody>
</table>
Viewing the Command Line Help

To view the command line Help:

1. Open the Command Prompt window. (Click the Start button and then point to Programs, Accessories, and then Command Prompt.)

2. Change the directory path to the path that you installed iFIX to.

3. Enter appvalidator /? at the prompt and press Enter. The Application Validator Help dialog box appears, which describes all of the available command line options.
Defining an Application to Run if Differences Are Found

To define an application to run if differences are found when running the Application Validator from the command line:

1. In the iFIX WorkSpace, double-click Application Validator in the system tree. The Application Validator opens.

2. On the Tools menu, click Options. The Application Validator Options dialog box appears.

3. Select the Application Execution tab.

4. Select the Enable Application Execution check box.

5. In the Application edit box, enter the location and name of the file. Optionally, click the Browse (...) button to search for a file.

6. Click OK.
Using an Automatic Report Naming Convention

To use an automatic report naming convention when running the Application Validator from the command line:

1. In the iFIX WorkSpace, double-click Application Validator in the system tree. The Application Validator opens.
2. On the Tools menu, click Options. The Application Validator Options dialog box appears.
4. Select the Enable Auto Report Naming check box.
5. In the Directory field, enter the location where you want to save the automatically created report. Optionally, click the Browse (…) button to locate and select a folder.
6. In the Prefix field, enter the name you want to use for the report file. If you select the Auto Increment option, a number is added to the end of this name each time a new report is run from the command line.

7. If you want to individually number each report file, instead of overwriting the original file each time you run a new report, select the Auto Increment check box.

8. Click OK.

Working with iFIX

To use the Application Validator with iFIX, you should be aware of the following operations:

- Auditing the Actions Performed in the Application Validator.
- Requiring that iFIX to be Running in Order to Start the Application Validator.
Auditing the Actions Performed in the Application Validator

You can configure the Application Validator to audit all user actions. Each time you perform an action, such as create a baseline, run a baseline summary report, or run a comparison report, an audit message is sent to the iFIX alarm system. This message is then recorded as part of the standard iFIX audit trail.

In order to enable audited actions in the Application Validator, you must make sure that both options in the AppValConfig.ini file are enabled. In addition, you must enable the Alarm ODBC Service and configure your relational database to store the audit messages in the ODBC alarm table.

For more information on the AppValConfig.ini, refer to the Requiring that iFIX to be running in order to start the Application Validator topic. For more information on enabling and configuring the Alarm ODBC service in iFIX, refer to Configuring the Alarm ODBC Service section in the Implementing Alarms and Messages electronic book.
Requiring that iFIX be Running in Order to Start the Application Validator

To require that iFIX be running to start the Application Validator:

1. In Notepad or another text editor, open the AppValConfig.ini file.

2. Make sure that both options are set to Yes, as shown in the following example:

   [Security]

   RunningIFixIsRequired=Yes

   EnabledSecurityIsRequired=Yes

**NOTE:** You may want to change EnabledSecurityIsRequired to No. If you set EnabledSecurityIsRequired to Yes, then the Application Validator only runs when Security is Enabled within iFIX. If you set to EnabledSecurityIsRequired to No, then iFIX Security does not have to be enabled in order to run the Application Validator.
3. Save the file into the iFIX product folder (the location where you installed iFIX).

4. Restart iFIX. Make sure iFIX security is enabled.

5. Restart the Application Validator.

Troubleshooting

You can troubleshoot the Application Validator by:

- Viewing the Error Log
- Displaying Informational Log Messages for the Current Session
Displaying an Error Log for the Application Validator

To view the error log for the Application Validator:

1. Locate the AppValidator.log file in the folder where you installed iFIX. Typically, the location of this folder is: C:\Program Files\Proficy\Proficy iFIX.

   **NOTE:** The AppValidator.log file only exists if unexpected events occur. If you have not experienced any unexpected errors with the Application Validator, you will not find this log in the iFIX product folder.

2. In Notepad or another text editor, open the AppValidator.log file.

3. Scroll to the end of the file to view the most recent errors. The error messages appear in chronological order, beginning with the first message.
Displaying a Log for the Current Session in the Main Window

To display an activity log for the current session in the main window:

1. In the iFIX WorkSpace, double-click Application Validator in the system tree. The Application Validator opens.

2. On the View menu, click Show Log. A small window opens across the bottom of the Application Validator main window.

3. Scroll down to review the informational messages that display in this window. These messages pertain to the actions performed during the current session.

The most recent action displays first in the list, at the top of this window. By scrolling down, you can review previous actions.
Customizing the iFIX Installation

The following sections provide information for users who want to create a custom iFIX installation for use on either a DVD or over a network:

- Types of Users Who Create Custom Install Programs
- Creating a Custom iFIX Install for a DVD or Network
- Running a Quiet Install
- Modifying the Default Behavior of the iFIX Install
- Including Additional iFIX Project Files in the Install
- Installing Software Improvement Modules (SIMs) with iFIX
- Including Additional Third-Party Software in the Install
- Customizing the Install Splash Screen
• Rebranding Install Graphics
• Rebranding Install Text
• Rebranding the iFIX DVD Booklet and Tray Card
• Rebranding Other Parts of the iFIX Product
• Deploying the iFIX Install Setup.exe Command Line Options
• INI Files Used by the iFIX Install
• Language Codes Used by the iFIX Install Program

**IMPORTANT:** If you want to create and/or produce rebranded iFIX DVDs for use other than internal to your company, you must have license agreement and permission from GE Intelligent Platforms to do so. Contact GE Intelligent Platforms for more information.
Types of Users Who Create Custom Install Programs

With a customized iFIX install program, you can change the default install settings, modify the components included with the install, or change the appearance of the install. The following types of users may be interested in custom iFIX install programs:

- The Administrator (Admin)
- The System Integrator (SI)
- The Original Equipment Manufacturer (OEM)

Depending on the type of user you are, your requirements for creating a custom FIX install program will differ. The following sections describe the types of actions each type of user may want to do with their custom iFIX install program.
The Administrator

As an Administrator, you may want to create a custom iFIX install that includes:

- A quiet install of the iFIX product. For more information, refer to the Running a Quiet Install section.

- Modification of the default behavior of the install, such as a different install path for the iFIX product, or a different name for the PIC or PDB folders. For more information, refer to the Modifying the Default Behavior of the iFIX Install section.

**IMPORTANT:** If you want to create and/or produce custom iFIX DVDs for use other than internal to your company, you must have license agreement and permission from GE Intelligent Platforms to do so. Contact GE Intelligent Platforms for more information.
The System Integrator

As a system integrator, you may want to create a custom iFIX install that includes:

- A quiet install of the iFIX product. For more information, refer to the Running a Quiet Install section.
- Modification of the default behavior of the install, such as a different install path for the iFIX product, or a different name for the PIC or PDB folders. For more information, refer to the Modifying the Default Behavior of the iFIX Install section.
- Additional files, such as customized project, database, or alarming files. For more information, refer to the Including Additional iFIX Project Files in the Install section.
- Software Improvement Modules (SIMs) that have been released after the initial release of the iFIX product. You can also choose to install these SIMs quietly. For more information, refer to the Installing Software Improvement Modules (SIMs) with iFIX section.

- Additional third-party software, specific to your organization or site. For more information, refer to the Including Additional Third-Party Software in the Install section.

- A different initial graphic (splash screen) that displays when you first load the iFIX product install DVD. For more information, refer to the Customizing the Install Splash Screen section.

**IMPORTANT:** If you want to create and/or produce custom iFIX DVDs for use other than internal to your company, you must have license agreement and permission from GE Intelligent Platforms to do so. Contact GE Intelligent Platforms for more information.
The Original Equipment Manufacturer

As an Original Equipment Manufacturer (OEM), you may want to create a custom iFIX install that includes:

- A quiet install of the iFIX product. For more information, refer to the Running a Quiet Install section.

- Modification of the default behavior of the install, such as a different install path for the iFIX product, or a different name for the PIC or PDB folders. For more information, refer to the Modifying the Default Behavior of the iFIX Install section.

- Additional files, such as customized project, database, or alarming files. For more information, refer to the Including Additional iFIX Project Files in the Install section.
• Software Improvement Modules (SIMs) that have been released after the initial release of the iFIX product. You can also choose to install these SIMs quietly. For more information, refer to the Installing Software Improvement Modules (SIMs) with iFIX section.

• Additional third-party software, specific to your organization or site. For more information, refer to the Including Additional Third-Party Software in the Install section.

• A different initial graphic (splash screen) that displays when you first load the iFIX product install DVD. For more information, refer to the Customizing the Install Splash Screen section.

• Rebranded graphics that appear when the install program runs, after the splash screen. For more information, refer to the Rebranding Install Graphics section.
• Rebranded text that appears in the install. For more information, refer to the Rebranding Install Text section.

• Rebranded license agreement. For more information, refer to the Rebranding the License Agreement section.

• Rebranded DVD booklet and tray card. For more information, refer to the Rebranding the iFIX DVD Booklet and Tray Card section.

• Rebranded product items. For more information, refer to the Rebranding Other Parts of the iFIX Product section.
**IMPORTANT:** As an OEM, you must have license agreement and permission from GE Intelligent Platforms to create rebranded installations. Additionally, you will need a copy of the iFIX NLS Toolkit for the InstallShield Stand-Alone builder, which you need to recompress the install program if you choose to modify the graphics, text, or license in the actual installer. With the NLS Toolkit, you can also rebrand other parts of the iFIX application. Contact GE Intelligent Platforms for more information.

---

**Creating a Custom iFIX Install for a DVD or Network**

You can create a customized iFIX install (for use on a DVD or a network) for use at your site, assuming that a license is available for each individual install. The steps that follow describe how to produce a custom iFIX install program.
IMPORTANT: If you want to create and/or produce rebranded iFIX DVDs for use other than internal to your company, you must have license agreement and permission from GE Intelligent Platforms to do so. Contact GE Intelligent Platforms for more information.

To create a customized install program:

1. In Windows Explorer, create a folder on your local drive named `dvdimage`. For example: C:\dvdimage. You must have at least 400 MB of free space available.

2. Obtain an iFIX product DVD, for the version you want to install or upgrade.

3. Copy all of the files and folders from the iFIX DVD, and paste them to your `dvdimage` folder.

4. Perform the steps for the options you want to customize.
To create a customized product DVD:

1. After you finish your customizations, copy all of the files and folders from your `dvdimage` folder to a new DVD using your DVD writing software.

2. Test the new DVD. Make sure that iFIX installs properly, and that all your customizations appear correctly.

After all of your tests pass, you can use this DVD internally on other computers, or supply it to customers who use your rebranded, customized software (if you have a license from GE Intelligent Platforms to do so).
To create a customized network install in preparation for deployment:

1. After you finish your customizations, copy all of the files and folders from your *dvdimage* folder to a network drive that you want to run the install from.

2. Test the network install. Make sure that iFIX installs properly, and that all your customizations appear correctly.

   After all of your network install tests pass, you can use this network installation on other computers, or supply it to customers who use your rebranded, customized software (if you have a license from GE Intelligent Platforms to do so).
Running a Quiet Install

A quiet install is useful if you want to create an iFIX install that is non-interactive and uses a set of pre-defined installation options. With a non-interactive install, you can ensure that iFIX installs or upgrades to the latest release the same way on each computer you run the install on. If you are installing or upgrading iFIX on many systems and you want every system to install the same way, a quiet install program helps you save time.

A quiet install is similar to a silent install, except that with a quiet install the user knows when the product is installing. A silent install program installs the product without any online cues, so the user may not even be aware when the product is in the process of installing. A quiet install does display dialogs and messages on the user's computer during the install, but no user input is required.
When you use the quiet install capability, you can modify the installation defaults, such as the local paths and additional program features. For instance, you can customize the quiet install to include FIX Desktop along with iFIX. To customize a quiet install, modify the default answers to all of the desired install questions and options beforehand by editing the InstallConfig.ini file on the iFIX product DVD. The InstallConfig.ini supplies the setup program with all of the information that a user is prompted to enter during the install, as well as pre-configured information about items such as the install paths. For more information on modifying this file, refer to the Modifying the Default Behavior of the iFIX Install section.

**NOTES:**

- *Historian 3.1 does not support a quiet or silent install.*

- *Historian 3.5 on Windows Server 2008 does not support a quiet or silent install.*
To launch the iFIX install so it runs quietly (without making any configuration changes):

- Launch the install with the "/Quiet" install command line option:
  ```
  setup.exe /quiet /nomsg
  ```

To customize the iFIX install so that it always runs quietly:

1. Create a customized iFIX install program. For steps, refer to the Creating a Custom iFIX Install for a DVD or Network section.

2. Locate the InstallConfig.ini file in the dvdimage folder, and open it in a text editor such as Notepad.

3. In the [config] section, set Quiet=TRUE.

4. Save the file.
Modifying the Default Behavior of the iFIX Install

To modify the default behavior of the iFIX install program, edit the InstallConfig.ini file for the iFIX product install. The InstallConfig.ini supplies the setup program with all the information that a user is prompted to enter during the install, as well as pre-configured information. The information you can edit in the InstallConfig.ini file includes:

- Pre-configured path locations for the iFIX product during install.
- Enabled features such as FIX Desktop, the Sample System or the e-books.
- Behavior such as whether iFIX creates shortcuts for Launch.exe, the Sample System, or the e-books on the Windows Desktop.
- Default answers to prompted install questions, such as the node name, whether networking is enabled, or whether SCADA support is enabled.
• The option to run the iFIX install quietly (without user input).

For example, as a system administrator, system integrator, or an OEM, you may want to change the default paths that iFIX uses for pictures, alarm history files, recipes, and so on, so that the paths are specific to your environment. Be aware that if you change these paths, you may not be able to use iFIX with the Proficy Change Management product. Contact GE Intelligent Platforms for more information.

To modify the default behavior of the install program:

1. Create a customized iFIX install program. For steps, refer to the Creating a Custom iFIX Install for a DVD or Network section.

2. Locate the InstallConfig.ini in the dvdimage folder, and open it in a text editor such as Notepad.
3. If you want to change the default paths to which iFIX installs in your Program Files folder, you can do so by editing the bold text in the following snippet. Be aware that if you change these paths, you may affect iFIX's capability to work with other Proficy products, such as Change Management.
[PATHS]
ROOT=

BasePath=Proficy\Proficy_iFIX
PDBPath=PDB
NLSPATH=NLS
PICPath=PIC
APPPath=APP
HTRPath=HTR
HTRDATAPath=HTRDATA
LOCALPath=LOCAL
ALMPath=ALM
RCMPPath=RCM
RCCPath=RCC
AADPath=PDB
4. To specify the node name, enable or disable networking or SCADA support, or indicate whether to run a quiet install, edit the bold text in the following snippet. Quiet must be set to TRUE for the install to run quietly.

```plaintext
[config]

NODENAME=FIX

NETWORK=TRUE

SCADA=FALSE

quiet=FALSE
```
5. To specify whether features such as FIX Desktop, the Sample System, or the e-books are to be installed, or to specify whether iFIX should show these features in the Custom Install option, edit the bold text in the following snippet. TRUE indicates that the feature installs, and FALSE means that it does not.

```
[features]

PAV=TRUE
DESKTOP=TRUE
SAMPLESYSTEM=TRUE
EBOOKS=TRUE
MYTSOFT=TRUE
WEBSPACE=FALSE
SHOWDESKTOP=TRUE
SHOWSAMPLESYSTEM=TRUE
SHOWEBOOKS=TRUE
SHOWMYTSOFT=TRUE
SHOWWEBSPACE=TRUE
```
6. Create a customized DVD or a customized network install in preparation for deployment. For more information, refer to the Creating a Custom iFIX Install for a DVD or Network section.

---

**Including Additional iFIX Project Files in the Install**

Along with the iFIX product itself, you can install customized iFIX project files specific to your company or site. If you are a system integrator or OEM, this feature can significantly decrease your deployment time by allowing you to install your iFIX project files to all your computers without having to copy these files manually afterward.

To include additional iFIX project files, you create a custom batch or executable file that runs during the iFIX install (named Runtask.bat). The instructions you provide in this file will indicate a designated location to copy from and to.
The Runtask.bat File

The Runtask.bat file is a batch command file that you can run at the end of the iFIX product installation program. The iFIX product install is configured to automatically run this file if it exists.

This batch file copies picture files and customized help files from the MyProjects\pic folder you created in your dvdimage folder, to your local product install folder. It also copies Alarm Area Databases (.AAD files) and Process Databases (.PDB files) from the MyProjects\pdb folder in your dvdimage folder, to your local product install folder. The default install paths of C:\Program Files\Proficy\Proficy iFIX\PIC and C:\Program Files\Proficy\Proficy iFIX\PDB are used, as illustrated below in a sample Runtask.bat file:
REM Copy Picture Files

copy %2\MyProjects\pic\*.grf  
"%1\Program Files\Proficy\Proficy iFIX\PIC"

REM F1 Help Files for Picture

copy %2\MyProjects\pic\*.chm  
"%1\Program Files\Proficy\Proficy iFIX\PIC"

REM Copy Alarm Area Database Files

copy  
%2\MyProjects\pdb\AlarmAreas.AAD  
"%1\Program Files\Proficy\Proficy iFIX\PDB"

REM Copy Process Database Files

copy  
%2\MyProjects\pdb\MyDatabase.PDB  
"%1\Program Files\Proficy\Proficy iFIX\PDB"
As you can see in this example, there are two variable parameters: %1 and %2. To specify the directories that you want to work with, you need to modify these two parameters as follows:

- %1 is the target directory where iFIX installs.
- %2 is the iFIX install image folder (on a DVD or network).

To create a Runtask.bat file which copies additional files:

1. Open Notepad or another text editor.
2. Enter the instructions that you want to include.
3. Copy this file to the dvdimage folder that you created when you created a custom iFIX install program. For more information, refer to the Creating a Custom iFIX Install for a DVD or Network section.
Installing Software Improvement Modules (SIMs) with iFIX

If you want to install additional Proficy product SIMs along with iFIX, you can easily do so by adding them to the iFIX installation. Use this feature to save time if you need to install iFIX upgrades and multiple SIMs on several computers. You can customize the SIM install options so that they install quietly as well.

To add SIMs to your customized iFIX install:

1. Create a customized iFIX install program. For steps, refer to the Creating a Custom iFIX Install for a DVD or Network section.

2. Locate the Subinstall.ini file in the dvdimage folder, and open it in a text editor such as Notepad.
3. In the [post_install] section, add another sequential line that includes the name of your SIM. For instance, in this example we add install6 with the SIM name of iFIX_MySIM:

```plaintext
[post_install]
install0=WindowsInstaller-KB893803-v2-x86
install1=dotnet11
install2=dotnet20
install3=vcredist_x86
install4=plicense
install5=ilicense
install6=iFIX_MySIM
```

**NOTE:** The numbers that follow after the "install" text must be in sequential order. For instance: install0, install1, install2, install3, install4, and so on. If the numbers skip, or appear out of order, the install tasks may not run.
4. Scroll to the end of the Subinstall.ini file. Copy this entire snippet and paste it at the very end of your file:

```ini
[iFIX_MySIM]
display1031=Installing SIM
iFIX_MySIM
display1033=Installing SIM
iFIX_MySIM
display1036=Installing SIM
iFIX_MySIM
display1041=Installing SIM
iFIX_MySIM
display1042=Installing SIM
iFIX_MySIM
display1045=Installing SIM
iFIX_MySIM
display1049=Installing SIM
iFIX_MySIM
display2052=Installing SIM
iFIX_MySIM
```
required=1

execute=iFIX45SIMs\iFIX45_1135599586.exe

cmdline=/quiet /nomsg

**NOTES:**

- The /quiet /nomsg command line options allow the SIM to install quietly, without any messages prompting the user. These command line options are the preferred way to install SIMs along with the iFIX product install.

- If you want to run the SIM install command from the dvdimage folder, instead from a DVD, you need to include the dvdimage path. For example: execute=dvdimage\iFIX45SIMs\iFIX45_1135599586.exe

5. In the first line replace the bracketed text with the SIM name you entered in step 3. In the previous example, the SIM was named iFIX_MySIM, and the bracketed item is similarly named [iFIX_MySIM].
6. For the display lines 1031-2052, enter the text that you want to appear in localized product installs. The display code at the beginning of these lines represents the languages that iFIX installs on. If you are creating an English install, these text strings can be left at their default values, as shown in the previous example. If you are installing different language versions of iFIX, you can modify the bold text to display an informational message in the language corresponding to the language code at the beginning of each line. For a list of language codes, refer to the Language Codes Used by the iFIX Install Program section.

7. For the execute line, enter the file location and name of the SIM that you want to install.

8. Make sure that the cmdline contains the /quiet /nomsg options. This ensures that your SIM installs quietly.

9. Save the file.
10. Create a customized DVD or a customized network install in preparation for deployment. For more information, refer to the Creating a Custom iFIX Install for a DVD or Network section.

Including Additional Third-Party Software in the Install

Along with iFIX, you can install other software specific to your company or site. For instance, you might want to include tools you created to work with iFIX, or patches for other required software. Your custom install can include these as part of the standard iFIX install.

NOTE: If you install additional documentation, it currently cannot be accessed from the main iFIX e-book. You can only access it outside of the iFIX master e-book, or directly from iFIX picture files.
To add other software programs to your customized iFIX install:

1. Create a customized iFIX install program. For steps, refer to the Creating a Custom iFIX Install for a DVD or Network section.

2. Locate the Subinstall.ini file in the dvdimage folder, and open it in a text editor such as Notepad.
3. In the [post_install] section of the Subinstall.ini file, add another sequential line that includes the name of your software's executable installation file. For instance, in this example we add install6 with the name of MySpecialInstall:

```
[post_install]
install0=WindowsInstaller-KB893803-v2-x86
install1=dotnet11
install2=dotnet20
install3=vcredist_x86
install4=plicense
install5=ilicense
install6=MySpecialInstall
```

**NOTE:** The numbers that follow after the "install" text must be in sequential order. For instance: install0, install1, install2, install3, install4, and so on. If the numbers skip, or appear out of order, the install tasks may not run.
4. Scroll to the end of the Subinstall.ini file. Copy this entire snippet and paste it to the very end of your file:

```
[MySpecialInstall]

display1031=Installing MySpecialInstall

display1033=Installing MySpecialInstall

display1036=Installing MySpecialInstall

display1041=Installing MySpecialInstall

display1042=Installing MySpecialInstall

display1045=Installing MySpecialInstall

display1049=Installing MySpecialInstall

display2052=Installing MySpecialInstall

required=1

execute=Myfolder\MySpecialInstall.exe
```
cmdline=/MyCommand

**NOTE:** If you want to run the executable command from the dvdimage folder, instead from a DVD, you need to include the dvdimage path. For example:

execute=dvdimage\Myfolder\MySpecial Install.exe.

5. In the first line, replace the bracketed text with the name you entered in step 3. In the previous example, the executable installation file was named MySpecialInstall, and the bracketed item has the exact same name [MySpecialInstall].
6. For the display lines 1031-2052, enter the text that you want to appear in localized product installs. The display code at the beginning of these lines represents the languages that iFIX installs on. If you are creating an English install, these text strings can be left at their defaults as shown in the previous example. If you are installing different language versions of iFIX, you can modify the bold text to display an informational message in the language corresponding to the language code at the beginning of each line. For a list of language codes, refer to the Language Codes Used by the iFIX Install Program section.

7. For the execute line, enter the folder and executable installation file that you want to run. In this example, it's Myfolder\MySpecialInstall.exe.

8. If there are command lines that you want to include with your custom install add-on, add them to the cmdline section.

9. Save the file.
10. Repeat steps 3-9 for each additional software program that you want to add to the install.

11. Create a customized DVD or a customized network install in preparation for deployment. For more information, refer to the Creating a Custom iFIX Install for a DVD or Network section.

---

**Customizing the Install Splash Screen**

If you are an OEM that resells the iFIX product with your own customizations, or a system integrator that wants to brand your customized install program, you can modify the first screen that a user encounters when installing the product. This screen is called the install splash screen.
When you insert the rebranded iFIX DVD into the DVD drive, the install splash screen appears. You can rebrand the install splash screen so that it includes your company name or logo, for instance. Be aware that GE Intelligent Platforms requires special licensing to distribute rebranded DVDs. Contact GE Intelligent Platforms for more information.

**IMPORTANT:** If you want to create and/or produce rebranded iFIX DVDs for use other than internal to your company, you must have license agreement and permission from GE Intelligent Platforms to do so. Contact GE Intelligent Platforms for more information.

To replace the install splash screen for a customized install:

1. Create a customized iFIX install program. For steps, refer to the Creating a Custom iFIX Install for a DVD or Network section.

2. Locate the InstallFrontEnd.bmp in your dvdimage folder.
3. In an image editing software program (Microsoft Paint or Paint Shop Pro, for instance), modify the InstallFrontEnd.bmp. Be careful not to change the dimensions of the graphic.

4. Save the file over the existing image.

To customize the text that appears on this splash screen:

1. Locate the Installation.ini file in your dvdimage folder.

2. In Notepad or another text editor, modify the Installation.ini file. Use the comments in the file to guide you with your changes.

3. Save the file over the existing file.

4. Create a customized DVD or a customized network install in preparation for deployment. For more information, refer to the Creating a Custom iFIX Install for a DVD or Network section.
Rebranding Install Graphics

To include rebranded graphics that appear during the install (not just the initial graphic in the splash screen), you must also have a special agreement with GE Intelligent Platforms. Contact GE Intelligent Platforms for details.

The artwork includes a number of graphic files named: bbrd1.bmp, bbrd2.bmp, bbrd3.bmp, and so on. These graphics are also known as the billboard graphics that appear in the middle of the screen during the install. To rebrand these files, edit each .bmp file in an image editing program. Make sure that you do not change the dimensions or resolution of the graphics. If you want to add additional billboard graphic files, you can do so. However, you must make sure that their file name and numbering sequence fits with the existing files, and you must make sure that they are the same dimensions and resolution as the other billboard graphics.
To replace the install graphics that appear after the splash screen:

1. Obtain the `bbrd*.bmp` files from GE Intelligent Platforms.

2. Create a customized iFIX install program. For steps, refer to the Creating a Custom iFIX Install for a DVD or Network section.

3. In the `dvdimage` folder, create a folder named `OEM\1033` folder, where `1033` represents the English language code. For a list of language codes, refer to the Language Codes Used by the iFIX Install Program section. Copy the `bbrd*.bmp` files to this folder.

**NOTE:** Other language codes are supported as well. Contact GE Intelligent Platforms for more a list of language codes and information on licensing localized products.
4. Use any graphics editor to edit the bbrd*.bmp graphics, or create new bbrd*.bmp graphics.

**IMPORTANT:** Be sure that you do not change the height and width (dimensions or resolution) of the graphic. If you do, the graphic may not appear correctly in the install.

5. Save changed or new files with the same naming convention.

---

**Rebranding Install Text**

To provide rebranded text that appears *during* the install, you must also have a special agreement with GE Intelligent Platforms. Contact GE Intelligent Platforms for details. After an agreement is signed, GE Intelligent Platforms will provide the string table files that you need to modify the product's install program.
The string table files have an .ips file extension, such as StringTable-0009-English.ips, and an associated .ini file, such as stringtable_English.ini. String table files are included for the main install program. To rebrand a string table file, use a text editor such as Notepad and enter changes for each row you want to rebrand. You may need additional help from GE Intelligent Platforms with this process. Contact GE Intelligent Platforms for details and availability.

If you modify the text in an .ips file, you must recompress the install program using the InstallShield Stand-Alone Builder (SAB), version 11.5, that is available with the iFIX NLS Toolkit. For more information on the InstallShield SAB, refer to the Recompressing the iFIX Install with Rebranded Material section.
To translate the strings for the main install:

1. Obtain the *.ips and corresponding *.ini files for the main install from GE Intelligent Platforms.

2. Create a customized iFIX install program. For steps, refer to the Creating a Custom iFIX Install for a DVD or Network section.

3. In your dvdimage folder, create a new folder named Translate_iFix_Installer_Strings. Copy the *.ips and *.ini files obtained for this installer from GE Intelligent Platforms to this folder.

4. Open the .ips file corresponding to your language in a text editor such as Notepad. For example, for English that file is named StringTable-0009-English.ips.
5. Provide edits for each string you want to rebrand. The text that you can rebrand appears to the right of the equals (=) sign. For example, if you wanted to modify the text that appears when a user who is not an Administrator attempts to install iFIX, you would edit the bold portion shown here:

```
ERROR_NO_ADMIN_RIGHTS=Setup requires an user account with Administrator privileges.
```

6. Save the file.
To update additional text strings:

1. Locate the Setup.ini file in the dvdimage folder, and open it in a text editor such as Notepad.

2. In the [Startup] section of the Setup.ini file, provide updated information for the AppName, CompanyName, or CompanyURL fields:

   [Startup]

   AppName=Proficy HMI SCADA - iFIX

   ProductGUID=8E2D0FDB-EF39-4AE0-A9E8-619E7575A17E

   CompanyName=GE Intelligent Platforms

   CompanyURL=http://www.ge-ip.com

   ...

3. Save the file.
To update the install program with the rebranded string table files:

1. Recompress the install program using the InstallShield Stand-Alone Builder.

2. Create a customized DVD or a customized network install in preparation for deployment. For more information, refer to the Creating a Custom iFIX Install for a DVD or Network section.

Rebranding the License Agreement

To include a rebranded end-user license agreement (EULA) in your install program, you must also have a special agreement with GE Intelligent Platforms. Contact GE Intelligent Platforms for details. After an agreement is signed, GE Intelligent Platforms will provide the license file that you need to modify the product's install program. The license file is named license.rtf, and can be edited in Microsoft® Word.
To replace the install splash screen for a customized install:

1. Obtain the license.rtf file from GE Intelligent Platforms.

2. Create a customized iFIX install program. For steps, refer to the Creating a Custom iFIX Install for a DVD or Network section.

3. In the dvdimage folder, create a folder named OEM\1033 folder, where 1033 represents the English language code. For a list of language codes, refer to the Language Codes Used by the iFIX Install Program section. Copy the license.rtf file to this folder.

   **NOTE:** Other language codes are supported as well. Contact GE Intelligent Platforms for more a list of language codes and information on licensing localized products.

4. In Microsoft® Word, open the license.rtf file and make the rebranding edits.

5. Save the file (with the original license.rtf file name).
6. Copy the file to the dvdimage folder.

7. Validate the rebranded End User License Agreement with the appropriate legal counsels at your company and GE Intelligent Platforms before you ship the license.rtf with the product. If changes need to be made to the license.rtf file at any future date, copy the edited version to the OEM\1033 folder and overwrite the existing file. For a list of language codes, refer to the Language Codes Used by the iFIX Install Program section.
Recompressing the iFIX Install with Rebranded Material

To recompress an iFIX install program with your rebranded text, you need to use the InstallShield Stand-Alone Builder (SAB), version 11.5. A copy of this program is included as part of the iFIX NLS Toolkit. You must have a special agreement with GE Intelligent Platforms to obtain a copy of the NLS Toolkit CD with the InstallShield SAB installer. Steps on how to install the InstallShield SAB are described in the "Installing the InstallShield Standalone Builder" topic in the Translating iFIX with the NLS Toolkit e-book (NLSToolkit.chm).

To recompress the install, run the InstallShield SAB (ISCab.exe) from the command-line, with the required command line options (described in the steps below). This allows you to add files into the data1.cab cabinet file for the install program, and rebuild the installer.
To recompress the install with the InstallShield SAB:

1. For the main installer (if you modified an .IPS file for it), copy the updated .IPS string table file from the Translate_iFIX_Installer_Strings and the stringtable_<language>.ini file into the dvdimage folder.

2. Using a Command Prompt, from the dvdimage directory, run the following command:

   iscab.exe data1.cab -a -i"stringtable_<language>.ini"

3. In the dvdimage folder, remove the files you copied over in step 1.
Rebranding the iFIX DVD Booklet and Tray Card

Optionally, other artwork, such as the DVD Booklet and tray card, can also be rebranded. You must have a special agreement with GE Intelligent Platforms, to do so. Contact GE Intelligent Platforms for details. After an agreement is signed, GE Intelligent Platforms will provide the artwork for these items.

The artwork source is in QuarkXpress format, so that you can replicate these graphics as accurately as possible. You must have QuarkXpress to edit these files.

Rebranding Other Parts of the iFIX Product

As an OEM, you must have license agreement and permission from GE Intelligent Platforms to rebrand any parts of the iFIX product. To do this, you will need a copy of iFIX NLS Toolkit product. The NLS Toolkit allows you to rebrand parts of the iFIX user interface, as well as the install program.
Contact GE Intelligent Platforms for more information.

---

**Deploying the iFIX Install Setup.exe Command Line Options**

You can run the iFIX Setup.exe program from the command line using the options described in the following table. These command line options are particularly helpful if you want to deploy the iFIX install over a network using system management software, such as Microsoft Systems Management Server (SMS).

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>/targetdir=c:\Path</td>
<td>Sets the install folder, where c:\Path represents the path where you want iFIX to install to.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>/inifile=c:\Path\installconfig.ini</td>
<td>Redirects the install program to use the installconfig.ini in the specified folder, where c:\Path represents the path of the installconfig.ini file that you want to use.</td>
</tr>
<tr>
<td>/quiet</td>
<td>Installs iFIX in unattended mode. For more information, refer to the Running a Quiet Install section.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>/nomsg</td>
<td>Installs iFIX without prompts (even for critical message boxes), when used with the /quiet command.</td>
</tr>
</tbody>
</table>

**Example 1**

In this example, we install iFIX quietly using a custom installation file in the user's c:\myfolder directory:

```
Setup.exe 
/inifile=c:\myfolder\installconfig.ini 
/quiet /nomsg
```

**Example 2**

In this example, we install iFIX from the DVD without prompts:
Setup.exe /quiet /nomsg

Example 3

In this example, we change the default the iFIX install to the c:\Program Files\MyFolder directory:

Setup.exe /targetdir=c:\Program Files\MyFolder

NOTE: Instead of using the command line in Example 3, you can also modify the BasePath= option in the InstallConfig.ini file.

INI Files Used by the iFIX Install

The following initialization (.ini) files are associated with the iFIX install program. You can modify these .ini files to create a custom iFIX install:

- Installation.ini
- InstallConfig.ini
- Subinstall.ini
- Setup.ini
Installation.ini

The following is an example of the iFIX Installation.ini file. Use the Installation.ini file to modify the items displayed on the install splash screen graphic.
; The Settings section configures general properties as follows
;
; Key Name Description
; ----------------- -----------------------
; ShowTitle: If true, a caption bar displays at the top. Otherwise, it doesn't
; Title: The caption that shows up at the top of the installation screen.
; SplashScreen: The splash screen used if the color resolution is > 256 colors
; OnColor: The color value used to display the active option (RGB) - Format of BBGGRR (COLORREF)
; OffColor: The color value used to display inactive options (RGB) - Format of BBGGRR (COLORREF)
; ShadowColor: The color value used to provide a 3d effect to the text - Format of BBGGRR (COLORREF)
; FontName: Use to override the default font name used by the software.
; FontSize: Use to override the default font size used.
; FontBold: 1 for bold, 0 for no bold.
; FontItalic: 1 for italic, 0 for no italic
; Icon Specify the icon file (.ico) to use for an icon. The icon should have a 16x16 and 32x32 version.
;
; IMPORTANT
; =========
; The splash screen will get sized to match the size of the splash bitmap.
; the default label-button sizes and positions work well for a 640x480 bitmap.
; if you use a different size, you should use the XCoord and YCoord parameters (see below) to adjust the position of each label on the screen.
;
; if you remove the caption bar (ShowTitle=0) make sure one of your buttons includes the ExitButton=1 field. This command is used to exit the program. Otherwise users won't be able to exit the program at all.
;
; NOTE: All values except for FontSize, FontBold, FontItalic, and Icon are required.

[Settings]
ShowTitle=1
Title=iFIX installation program
SplashScreen=InstallFrontEnd.bmp
OnColor=0xFF0000
OffColor=0xA0A0A0
ShadowColor=0x000000
FontSize=0x00000D
FontItalic=0
FontBold=1
FontName=Arial
Icon=Fix.ico
Status=Installing Proficy iFIX

; Key Name Description
; ----------------- -----------------------
; ButtonX where X is a number (Button1).
; NOTE: Button names MUST be sequential!
; The values will be the section names of the buttons to be created.
; This allows for many buttons to be defined while only showing a subset of them.

[Buttons]
Button1=InstalliFIX
Button2=6XDriver
Button3=SupportWebsite
Button4=ReleaseNotes
Button5=Browse
Button6=Exit
Button7=Hist35

; Buttons
; This is made up of one or more sections. Each section describes 1 button.
; ButtonText, XCoord and YCoord are required or the button will not be created.
; Also either ExitButton Or Executable are required.
; All other fields are optional.
; Key Name Description
; ----------------- -----------------------
; ButtonText: The text to be shown
; Hint: The tool tip that shows up when that button is highlight.
; ConfirmationRequired: 0 for no confirmation, 1 for confirmation (default is 0)
; ConfirmationPrompt: The string you want to use as a confirmation prompt.
;
; XCoord: The coordinate (horizontal, left is 0) where you want the button to appear. Negative coordinates are not allowed.
; YCoord: The coordinate (vertical, top is 0) where you want the button to appear. Negative coordinates are not allowed.
; XIndent: Adjusts the x coordinate by the given value. Easy to display a hierarchy.
; OnColor: The color value used to display the active option (RGB) - Format of BBGGRR (COLORREF)
; OffColor: The color value used to display inactive options (RGB) - Format of BBGGRR (COLORREF)
; ShadowColor: The color value used to provide a 3d effect to the text - Format of
BBGGRR (COLORREF)
;  FontName: Use to override the default font name used by the software.
;  FontSize: Use to override the default font size used.
;  FontBold: 1 for bold, 0 for no bold.
;  FontItalic: 1 for italic, 0 for no italic
;  FontScale: An integer, used to scale the font relative to the established font size.
;                 (easy to make something slightly smaller or larger than default)
; It is not recommended that a button FontSize be defined if this field is defined.
;  LabelOnly: When set to 1, will not use the "on" color as the mouse goes over this label.
;                 (allows to create title labels)
; Setting this overrides all other functionality (ExitButton, Executable, 3D highlighting on mouse over, etc.)
;  Executable: The command line command. Can be a filename(setup.exe), a URL(http://something.com).
; May also include full or relative paths: (iFIXDriver\Setup.exe)
;  CmdLineParam: use if your executable requires a command line parameter.
;  DefaultDir: use if your executable needs a default directory specified.
;  CloseAfterLaunch: Set to 1 to make this
button run a command and also act as an exit button
; ExitButton: Set to 1 to make this button
exit the program without running any
commands
;
;
;[InstalliFIX]
ButtonText=Install iFIX 5.1
Hint=Selecting this option will launch the
iFIX installation program
ConfirmationRequired=1
ConfirmationPrompt=Selecting this option
will start the iFIX setup program. Do you
want to proceed?
CloseAfterLaunch=1
XCoord = 380
YCoord = 15
FontScale=10
Executable=Setup.exe
CmdLineParam=FXMANAGER=TRUE
[6XDriver]
ButtonText=Install an I/O driver version 6.x
Hint=Selecting this option will launch the
setup a 6.x driver installation program.
Executable=Setup\Proficy\iFIXDriver\SETUP.EXE
XCoord = 380
YCoord = 70
;[M1Licensing]
;ButtonText=Install M1 Licensing Software
; Hint=Selecting this option will launch the M1 licensing installation program.
; ConfirmationRequired=0
; ConfirmationPrompt=Selecting this option will start the Licensing setup program. Do you want to proceed?
; CloseAfterLaunch=1
; Executable=Proficy\License\M1Licensing.exe
; XCoord = 380
; YCoord = 110

[M4Licensing]
; ButtonText=Install M4 Licensing Software
; Hint=Selecting this option will launch the proficy license installation program.
; ConfirmationPrompt=Selecting this option will start the Licensing setup program. Do you want to proceed?
; Executable=Proficy\License\ProficyClientInstallerlite.exe
; XCoord = 380
; YCoord = 150

[SupportWebsite]
ButtonText=Support Web Site
Hint=Go to the GE Intelligent Platforms Website
Executable=http://www.ge-ip.com/support
XCoord = 380
YCoord = 105

[ReleaseNotes]
ButtonText=View iFIX release notes
Hint=View the iFIX release notes
Executable=hh.exe
CmdLineParam=releasenotes/ipiifix.chm
XCoord = 380
YCoord = 140
[Browse]
ButtonText=Browse the DVD
Hint=Explore the DVD
XCoord = 380
YCoord = 175
Executable=explorer.exe
CmdLineParam=.

[Hist35]
ButtonText=Install Historian 3.5
Hint=Install Historian 3.5
XCoord = 380
YCoord = 210
Executable=Setup\Proficy\Historian35\FullInstaller\setup.exe

[Exit]
ButtonText=Exit
Hint=Exit
XCoord=560
YCoord =310
FontScale=10
ExitButton=1
;FontName=MS Sans Serif
InstallConfig.ini

The following is an example of the iFIX InstallConfig.ini file. Use the InstallConfig.ini to modify the default install settings, or to indicate whether iFIX installs quietly.

[PATHS]
ROOT=
BasePath=Proficy\Proficy iFIX
PDBPath=PDB
NLSPath=NLS
PICPath=PIC
APPPath=APP
HTRPath=HTR
HTRDATAPath=HTRDATA
LOCALPath=LOCAL
ALMPath=ALM
RCMPath=RCM
RCCPath=RCC
AADPath=PDB
[config]
NODENAME=FIX
NETWORK=TRUE
SCADA=FALSE
quiet=FALSE
[features]
PAV=TRUE
DESKTOP=TRUE
SAMPLESYSTEM=TRUE
EBOOKS=TRUE
The following is an example of the iFIX SubInstall.ini file. Use the Subinstall.ini to include additional third-party software, or Software Improvement Modules (SIMs) with your iFIX install.

```
[requisite]
install0=WindowsInstaller-KB893803-v2-x86
install1=vcredist_x86
[pre_install]
```

Subinstall.ini

The following is an example of the iFIX SubInstall.ini file. Use the Subinstall.ini to include additional third-party software, or Software Improvement Modules (SIMs) with your iFIX install.
install0=dotnet35
install1=plicense
[post_install]
install0=ChangeManagementClient
install1=opcclient
install2=discovery
install3=AlarmViewer
install4=ikbf
install5=plantappsdynamos
[WindowsInstaller-KB893803-v2-x86]
display1031=Installing Microsoft Windows Installer 3.1
display1033=Installing Microsoft Windows Installer 3.1
display1036=Installing Microsoft Windows Installer 3.1
display1041=Installing Microsoft Windows Installer 3.1
display1042=Installing Microsoft Windows Installer 3.1
display1045=Installing Microsoft Windows Installer 3.1
display1049=Installing Microsoft Windows Installer 3.1
display2052=Installing Microsoft Windows Installer 3.1
required=1
execute=Microsoft\DotNet35SP1\WindowsInstaller-KB893803-v2-x86.exe
cmdline=/quiet
checkregistry=SOFTWARE\Microsoft\Windows\CurrentVersion\Uninstall\KB893803v2
[dotnet35]
display1031=Installing Microsoft .NET framework v3.5 SP1
display1033=Installing Microsoft .NET framework v3.5 SP1
display1036=Installing Microsoft .NET framework v3.5 SP1
display1041=Installing Microsoft .NET framework v3.5 SP1
display1042=Installing Microsoft .NET framework v3.5 SP1
display1045=Installing Microsoft .NET framework v3.5 SP1
display1049=Installing Microsoft .NET framework v3.5 SP1
display2052=Installing Microsoft .NET framework v3.5 SP1
required=0
execute=Microsoft\DotNet35SP1\dotnetfx35.exe
cmdline=/q /norestart
checkregistry=SOFTWARE\Microsoft\NET Framework Setup\NDP\v3.5
[vcredist_x86]
display1031=Installing Microsoft Visual C++ Runtime Libraries (x86)
display1033=Installing Microsoft Visual C++ Runtime Libraries (x86)
display1036=Installing Microsoft Visual C++ Runtime Libraries (x86)
display1041=Installing Microsoft Visual C++ Runtime Libraries (x86)
display1042=Installing Microsoft Visual C++
Runtime Libraries (x86)
display1045=Installing Microsoft Visual C++
Runtime Libraries (x86)
display1049=Installing Microsoft Visual C++
Runtime Libraries (x86)
display2052=Installing Microsoft Visual C++
required=1
execute=Microsoft\vcpp2008\vcredist_x86.exe
cmdline=/q /r:n
checkregistry=SOFTWARE\Microsoft\Windows\CurrentVersion\Uninstall\{1F1C2DFC-2D24-3E06-BCB8-725134ADF989}

[ikbf]
display1031=Installing Keyboard Driver
display1033=Installing Keyboard Driver
display1036=Installing Keyboard Driver
display1041=Installing Keyboard Driver
display1042=Installing Keyboard Driver
display1045=Installing Keyboard Driver
display1049=Installing Keyboard Driver
display2052=Installing Keyboard Driver
required=1
execute=Proficy\ikbf5\setupikbf5.exe
cmdline=/SILENT

[plicense]
display1031=Installing Proficy Common Licensing
display1033=Installing Proficy Common Licensing
display1036=Installing Proficy Common Licensing
display1041=Installing Proficy Common Licensing
display1042=Installing Proficy Common Licensing
display1045=Installing Proficy Common Licensing
display1049=Installing Proficy Common Licensing
display2052=Installing Proficy Common Licensing
required=0
execute=Proficy\license\ProficyClientInstallerLite.exe
cmdline=/quiet /nomsg
[opcclient]
display1031=Installing OPC Client Driver
display1033=Installing OPC Client Driver
display1036=Installing OPC Client Driver
display1041=Installing OPC Client Driver
display1042=Installing OPC Client Driver
display1045=Installing OPC Client Driver
display1049=Installing OPC Client Driver
display2052=Installing OPC Client Driver
required=0
execute=Proficy\OPCClientSetup\setup.exe
cmdline=1
[discovery]
display1031=Installing Discovery and Auto-Assembly
display1033=Installing Discovery and Auto-Assembly
display1036=Installing Discovery and Auto-
Assembly
display1041=Installing Discovery and Auto-Assembly
display1042=Installing Discovery and Auto-Assembly
display1045=Installing Discovery and Auto-Assembly
display1049=Installing Discovery and Auto-Assembly
display2052=Installing Discovery and Auto-Assembly
required=0
execute=Proficy\discovery\discovery.exe
cmdline=/quiet /nomsg

[ChangeManagementClient]
display1031=Installing Change Management Client
display1033=Installing Change Management Client
display1036=Installing Change Management Client
display1041=Installing Change Management Client
display1042=Installing Change Management Client
display1045=Installing Change Management Client
display1049=Installing Change Management Client
display2052=Installing Change Management Client
required=1
execute=Proficy\ChangeManagementAPI\setup.exe
cmdline=/s /v"/qn"

[AlarmViewer]
display1031=Installing Proficy Alarm Viewer 2.0
display1033=Installing Proficy Alarm Viewer 2.0
display1036=Installing Proficy Alarm Viewer 2.0
display1041=Installing Proficy Alarm Viewer 2.0
display1042=Installing Proficy Alarm Viewer 2.0
display1045=Installing Proficy Alarm Viewer 2.0
display1049=Installing Proficy Alarm Viewer 2.0
required=0
execute=Proficy\AlarmViewer\setup.exe
cmdline=/s /v"/qn ALLUSERS=[ALLUSERS] REBOOT=ReallySuppress"

[plantappsdynamos]
display1031=Installing PlantApps Dynamos
display1033=Installing PlantApps Dynamos
display1036=Installing PlantApps Dynamos
display1041=Installing PlantApps Dynamos
display1042=Installing PlantApps Dynamos
display1045=Installing PlantApps Dynamos
display1049=Installing PlantApps Dynamos
display2052=Installing PlantApps Dynamos
required=1
execute=Proficy\PADynamos\iFIX51_SV10_PlantApps.exe
cmdline=/quiet /nomsg

Setup.ini

The following is an example of the iFIX Setup.ini file. Use the Setup.ini to modify text that appears in the actual install program. It is recommended that you do not modify this file, unless you obtain permission from GE Intelligent Platforms. Do not to modify the ProductGUID item, or you may experience unexpected errors.

[Startup]
AppName=Proficy HMI SCADA - iFIX
ProductGUID=8E2D0FDB-EF39-4AE0-A9E8-619E7575A17E
CompanyName=GE Intelligent Platforms
CompanyURL=http://www.ge-ip.com
ErrorReportURL=http://www.installshield.com/isetup/ProErrorCentral.asp?ErrorCode=%d : 0x%x&ErrorInfo=%s
MediaFormat=1
LogMode=1
Resource=_Setup.dll
SmallProgress=N
SplashTime=5
CheckMD5=Y
CmdLine=
ShowPasswordDialog=N
EngineVersion=11.0.0.28844
EngineBinding=1
[Languages]
Default=0x0009
count=32
key0=0x0009
key1=0x0804
key2=0x0404
key3=0x040c
key4=0x0007
key5=0x0010
key6=0x0011
key7=0x0012
key8=0x0015
key9=0x0416
key10=0x0816
key11=0x0019
key12=0x000a
key13=0x001d
key14=0x0006
key15=0x0013
key16=0x002d
key17=0x0002
key18=0x0003
key19=0x001a
key20=0x0005
key21=0x000b
key22=0xc0c
Language Codes Used by the iFIX Install Program

The following table displays a list of language codes you can use when creating a customized iFIX install.

<table>
<thead>
<tr>
<th>Language</th>
<th>Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Catalan</td>
<td>1027</td>
</tr>
<tr>
<td>Czech</td>
<td>1029</td>
</tr>
<tr>
<td>Danish</td>
<td>1030</td>
</tr>
<tr>
<td>Language</td>
<td>Code</td>
</tr>
<tr>
<td>--------------------------</td>
<td>------</td>
</tr>
<tr>
<td>English</td>
<td>1033</td>
</tr>
<tr>
<td>German</td>
<td>1031</td>
</tr>
<tr>
<td>Greek</td>
<td>1032</td>
</tr>
<tr>
<td>Japanese</td>
<td>1041</td>
</tr>
<tr>
<td>Swedish</td>
<td>1053</td>
</tr>
<tr>
<td>Basque</td>
<td>1069</td>
</tr>
<tr>
<td>Brazilian Portuguese</td>
<td>1046</td>
</tr>
<tr>
<td>Chinese - Taiwan</td>
<td>1028</td>
</tr>
<tr>
<td>Chinese PRC</td>
<td>2052</td>
</tr>
<tr>
<td>Croatian</td>
<td>1050</td>
</tr>
<tr>
<td>Language</td>
<td>Code</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-------</td>
</tr>
<tr>
<td>Cyrillic</td>
<td>3098</td>
</tr>
<tr>
<td>Dutch</td>
<td>1043</td>
</tr>
<tr>
<td>Finnish</td>
<td>1035</td>
</tr>
<tr>
<td>French</td>
<td>1036</td>
</tr>
<tr>
<td>French Canadian</td>
<td>3084</td>
</tr>
<tr>
<td>Hungarian</td>
<td>1038</td>
</tr>
<tr>
<td>Indonesian</td>
<td>1057</td>
</tr>
<tr>
<td>Italian</td>
<td>1040</td>
</tr>
<tr>
<td>Korean</td>
<td>1042</td>
</tr>
<tr>
<td>Norwegian</td>
<td>1044</td>
</tr>
<tr>
<td>Language</td>
<td>Code</td>
</tr>
<tr>
<td>-------------</td>
<td>------</td>
</tr>
<tr>
<td>Polish</td>
<td>1045</td>
</tr>
<tr>
<td>Portuguese</td>
<td>2070</td>
</tr>
<tr>
<td>Russian</td>
<td>1049</td>
</tr>
<tr>
<td>Slovak</td>
<td>1051</td>
</tr>
<tr>
<td>Slovenian</td>
<td>1060</td>
</tr>
<tr>
<td>Spanish</td>
<td>1034</td>
</tr>
<tr>
<td>Thai</td>
<td>1054</td>
</tr>
<tr>
<td>Turkish</td>
<td>1055</td>
</tr>
</tbody>
</table>
Index

A

Activity Log

main window 323

Administrator ... 370

All Tags

search in the
Cross Reference Tool......... 131

Application Validator

audit messages321

auditing ..........316

 basics ..........292

 command line options........310
general configuration 297

overview steps ..... 308

report types ...304

running.........293
toolbar.........299

Application Validator .......291

Apply and Go tab157

AppValConfig.ini
arguments, Application Validator command line
assigning schedules to a security area.
attributes header and footer
audit messages list sample format
viewing auditing AppValConfig.ini file

understanding

Automatically Resize Report Columns

B background

background schedules

background task startup list

baselines

basics, Application Validator

best practices

Application Validator

billboard graphics
buttons

toolbar buttons
for the
Application
Validator ... 299

toolbar buttons
for the Cross
Reference
Tool............ 143

C

changes only in
Compare Detail
Report.......... 306

changing default
options .......... 335

command line

automatic report
naming ...... 360

differences
found.......... 359

color

effects

effects

help ............... 358

options ........... 354

color

effects

effects

command line
(Application
Validator)

options .......... 310

command line
options .......... 310

command line
options .......... 420

command-line
(Cross
Reference Tool)170

Comparison
Detail Report

overview ........ 306

printing.......... 352

saving.......... 306
viewing changes only 349
Comparison Detail Report 348
compiling a project file .... 242
configuration for the Application Validator ...... 297
continuous .......... 89
continuous entry . 25
copy .................... 95
creating
a map file ...... 239
a project file .. 242
a report ........... 203
picture-specific help files ... 223
reports ........... 200
the help file ... 233
topic file ........ 236
creating ............ 76
creating an audit trail ........ 362
creating entries . 104
Creating Reports Using the Cross Reference Report Wizard 138
Cross Reference Report .......... 200
Cross Reference Report Wizard 203
Cross Reference Tool
All Tags search 131
Apply and Go tab.............157

automatically saving the report file..155

button ............141

creating Quick Reports ......147

customizing header and footers ......168

including the summary report ........147

introduction ..129

introduction to127

Object Tree...141

One Tag search131

opening ..........141

Page Setup dialog box..168

printing a report165

printing report automatically155

Quick Report and Report Wizard.......138

refreshing ......143

Report Results141

Report Settings tab..............155

Report Wizard138

resizing columns .....147

resolving tags 147

running from
command-line ............... 170

open in the
WorkSpace 141

search settings 151

viewing results 158

search types .. 129

viewing searches
through scripts ....... 164

searching for
text ............... 133

viewing searches
through scripts ........ 164

searching through
scripts ........... 147

viewing status
trail ............ 161

Crystal Reports

custom iFIX installation .... 367

toolbars ....... 143

custom scripts

types of
searches..... 129

writing for Scheduler..... 38

viewing files

custom scripts ... 104
customized iFIX install .......... 376
customizing the system tree .... 267
daily ..................... 90
daily entry ............ 25
debugging VBA scripts in a schedule .......... 19
defaults ............... 335
defining Application Validator command line options (GUI) 310
Demo Mode, Application Validator .... 296
deployment ........ 420
descriptions
optional arguments in Application Validator command line 310
descriptions .... 310
deselecting all folders ........ 339
Detail Report, Comparison .... 306
differences found 359
directory selection 338
displaying the search results of a report .... 141
displaying error messages......365
daily ..................25
diagnostics ......37
displaying informational log messages. 366 editing ...............34
drag and drop .....95 event-based .....23
DVD Booklet and tray card ........ 419 monthly ............25
E one-shot ...........25
time-based.......25
EULA ...............414

editing ...............102 entries ..................97
end-user license agreement .....414 error log messages365
entering text into
the header or footer ............220 errors, command line
(Application Validator)......310
entries continuous ......25
creating ...............34
EUL A ...............414
event ...................84
event types .......... 23

event-based ........ 84

event-based entries .......... 23

excluding files from comparison ... 345

executing ........ 101

Experts

Script Authoring .... 30

Experts .......... 103

F

file attributes

SystemTree.CS

V file .......... 280

file attributes .... 280

files

adding to the system tree. 280

deleting from the system tree .......... 289

excluding from comparison 345

selecting multiple .... 152

Files tab .......... 152

files that changed 306

finding
tags in files .... 138

finding tags

in the Cross Reference Tool .......... 147
firing .................. 101
FixBackgroundServer task
  as a Windows service ....... 20
folder attributes
  SystemTree.CS V file ....... 271
folder attributes 271
folder selection 338
folders
  adding to the system tree 271
deleting from the system tree .......... 289
deselecting .... 339
selecting ........ 339
footers ............... 220
foreground ........... 79
foreground schedules .......... 6
g
  general configuration for the Application Validator .... 297
generating
  baselines .......... 342
detailed report 348
  single baseline 343
summary report 347
generating ............. 348
  generating a report .......... 200
GUI, Application Validator
command line options ........... 310

H
headers .............. 220

Headers and Footers
customizing .. 168

help
adding to an iFIX picture 231
creating the file 233
designing
What's This ? 228
understanding
What's This ? 226

I
iFIX .................. 363
iFIX, running with or without (Application Validator) ...... 294
Include Summary 155
Include VBA Scripts in
Search .............. 147
informational log messages ...... 366
Installation.ini ... 424
InstallConfig.ini 380, 383, 43
InstallFrontEnd.bmp ................. 404
InstallShield ...... 417
InstallShield
Standalone Builder .......... 417
ips ..................... 409
L
language codes . 443
license agreement419
list
audit messages from the Application Validator ... 321
load a predefined profile ........... 298
loading settings 341
local node alias
enabling ........ 108
examples....... 109
overview ...... 107
THISNODE ..108
using............ 108
Log window from the Application Validator ...... 323
logging
error messages365
informational messages.... 366
M
main window,
Activity Log.. 323
map file
creating ........ 239
margins........... 218
messages from the
Application Validator

auditing.........319

Microsoft Systems Management Server ..........420

mode, Demo.....296

modifying.........94

monthly ...........92

monthly entry.....25

move.................96

multiple files

searching through......152

N

network install..376

new ......................76

notes on the syntax (Application Validator)......310

O

Object Tree

Cross Reference Tool...........141

refreshing......143

OEM ....................373

one shot ..............87

One Tag

searching for in Cross Reference Tool...........131

one-shot entry.....25
opening

Cross Reference Tool ........... 141

optional arguments, Application Validator command line 310

options .............. 335

Original Equipment Manufacturer 373

overview

Application Validator steps for using .......... 308

P

paste .................... 95

picture-specific help files creating ........... 223

predefined profile, loading ............ 298

ranges ............ 214

setup .............. 214

setup options .... 220

page .................. 214

page margins .... 218

page options ...... 218

page setup

header and footers ...... 220

page setup ........ 218
predefined settings .......... 341

print Crystal Report ....... 118

Print Crystal Report Expert 121

print options .... 214

printing

Comparison Detail Report 352

main window contents ..... 353

reports .......... 165

reports automatically 155

printing .......... 218

printing a report

automatically 210

profile

loading .......... 298

saving .......... 298

project file

creating and compiling .. 242

properties ....... 102

Q

Quick Report

All Tags ....... 131
differences between Report Wizard and 138

feature list ..... 138

One Tag ....... 131

Quick Report .... 200
Quick Reports
   creating ........ 147
quiet install ....... 380

R
rebranded install
   graphics ........ 407
rebranded install
   text ............. 409
recompress an
   iFIX install .... 417
refresh
   Object Tree ... 143
Report
   creating one
      with multiple
         files .......... 203
displaying
   search results 141
   including a
      summary .... 147
   printing and
      saving
         automatically 210
   reviewing
      settings .... 157
   saving to a file 155
   specifying
      output
         options .... 155
   viewing report
      results ....... 158
   viewing search
      results that
         resolve tags 162
Report Experts
   Print Crystal
      Report ....... 118
Print Crystal Report Expert121 using ............... 117

report naming (automatically)360

report output options .......... 210

Report Results

Cross Reference Tool ........... 141

Report Results .. 158

Report Settings tab

automatically print report 155

Save Status Trail ............. 155

Report Wizard

All Tags ........ 131

automatically saving status trail ............. 155

creating reports150
differences between
Quick Report and ............. 138

feature list ..... 138

One Tag ........ 131

output options155

resolving tags 151

search settings 151

searching through scripts ........ 151

selecting
multiple files\textsuperscript{152}

Report Wizard\textsuperscript{203}

reports

automatically
printing\textsuperscript{155}

Comparison
Detail \textsuperscript{348}

creating \textsuperscript{147}

displaying
status trail\textsuperscript{141}

overview \textsuperscript{304}

printing \textsuperscript{165}

quick reports \textsuperscript{200}

resizing
columns \textsuperscript{147}

saving \textsuperscript{306}

searching

through VBA
scripts \textsuperscript{209}

selecting page
options \textsuperscript{168}

Summary \textsuperscript{305}

Summary
Report \textsuperscript{347}

viewing search
through script
results \textsuperscript{164}

requiring iFIX to
run \textsuperscript{363}

resetting \textsuperscript{100}

resizing columns \textsuperscript{147}

resolve \textsuperscript{81}

Resolve Tags

using All Tag
Group Files \textsuperscript{147}
Resolve Tags
  using All Tag
  Group Files
  viewing results 162
resolving
  schedules ....... 12
resolving tags
  using all Tag
  Group Files 207
  using the Cross
  Reference
  Tool ............ 147
  using the Report
  Wizard ...... 151
results
  of tag search.. 158
  of text search 158
running
Application
  Validator.... 293
Demo Mode .. 296
  with or without
  iFIX .......... 294
running ............ 76
running an
  application
  when
  differences
  found .......... 359
  Runtask.bat ...... 389
  run-time .......... 98
S
  SAB ............... 417
sample
  audit message
  from the
Application Validator ... 320
Save Status Trail155 saving automatically 210
Scheduler introduction ...... 2 overview .......... 3
running as a background task ............... 8 running as a foreground task ............... 8
script execution.8 using the VBE...6 using with iFIX.6
schedules adding to background task startup list.................21
ddebugging VBA scripts .......... 19 designing...........23 resolving .......... 12
running in the background..13 running in the foreground...13
securing.......... 11 sorting.......... 36
schedules ............ 82
Script Authoring
Experts .......... 30
scripts
searching
through ...... 147
viewing reports 164
scripts ............ 106
Search Settings
tab ................. 151
searching
for tags .......... 127
for text .......... 129
for text strings 133
resolving tags
while ............ 207
through scripts 151
through VBA
scripts ......... 209
types of
searches for
tags ............. 129
using the Quick
Report ......... 200
searching for
one tag .......... 131
searching for tags
resolving tags 151
securing schedules 11
security areas ...... 82
selecting all
folders ............ 339
selecting folders 338
selecting print
options ........ 165
settings
loading .......... 341
saving .......... 340
working with 298
Setup.exe .......... 420
Setup.ini ... 409, 441
SIMs ................. 393
SIMs single baselines 343
SMS ................. 420
Software Improvement Modules .... 393
sorting ............... 97
sorting a schedule 36
splash screen .... 404
starting ............ 363
statistics ............ 100
Status Trail
automatically saving ....... 155
Cross Reference Tool ......... 141
viewing ............. 161
steps
using the Application Validator .... 308
stopping ............ 99
Subinstall.ini 393, 398, 434
summary report 147
syntax,
Application Validator
command line 310
system integrator

system tree

adding files ... 280

adding folders 271

customizing .. 267

deleting folders and files..... 289

SystemTree.CS V file ........... 267

Systems Management Server ........... 420

SystemTree.CSV file............... 267

T

tag name

searching for a partial name131

tags

searching for all tags ............. 129

searching for one tag ....... 129

Text

finding in files 133

Text search ...... 133

THISNODE ...... 108

time......................... 89

time-based ............ 89

time-based entries 25

toolbar,

Application Validator ...... 299

toolbars

Cross Reference
Tool ........... 143

V

validating an application .... 291

VBA scripts

searching through ...... 209
to access the Proficy iFIX WorkSpace .. 32

writing custom scripts for Scheduler ..... 38

VBE

using with Scheduler ...... 6

viewing

audited messages (Application

/*
 */

U

understanding

auditing for the Application Validator ... 316

using

Application Validator ... 308

Application Validator toolbar ....... 299

topic file

creating ........ 236
troubleshooting 106

types of reports (Application Validator) ..... 304

Tool ........... 143

V

validating an application .... 291

VBA scripts

searching through ...... 209
to access the Proficy iFIX WorkSpace .. 32

writing custom scripts for Scheduler ..... 38

VBE

using with Scheduler ...... 6

viewing

audited messages (Application

/*
 */
Validator) . . 319
changed files . . 306
viewing ............. 102
viewing audit trail362
viewing changes349

W
What's This ? help
designing ...... 228
overview ....... 226
Wizard

Cross Reference203
wizards
feature list for
Cross
Reference
Tool ............ 138
Report Wizard138
working
with settings .. 298

Z
zoom rate ........ 218